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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each 
instrument it manufactures to be free from defects in material and workmanship impairing its usefulness under 
normal use and service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any 
instrument or defective parts when returned prepaid to us and which our examination discloses to have been 
defective. The purchaser is responsible for all transportation charges involving the shipment of materials for war-
ranty repairs. Failure of any instrument or product due to operator error, improper installation, unauthorized 
repair or alteration, failure of utilities, or environmental contamination will not constitute a warranty claim. The 
materials of construction used in MICROMERITICS instruments and other products were chosen after extensive 
testing and experience for their reliability and durability. However, these materials cannot be totally guaranteed 
against wear and/or decomposition by chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of 
shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and 
authorization to return the instrument or product. All repairs or replacements are made subject to factory inspec-
tion of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications 
are made by persons other than its own authorized service personnel unless such work is authorized in writing by 
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their 
respective brand names or trade names. We, therefore, make no express or implied warranty as to such prod-
ucts. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. 
Service charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our 
entire liability in respect to such products, except as an authorized person of MICROMERITICS may other-
wise agree to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check 
valves, seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and 
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. 
Such items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be 
free of manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against 
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manu-
factures a special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of 
its products other than the liability stated above. This warranty is in lieu of all other warranties, express or 
implied, including, but not limited to, the implied warranties of merchantability or fitness for use.

4356 Communications Drive         Norcross, GA 30093-2901   Fax (770) 662-3696

Domestic Sales - (770) 662-3636                                            Domestic Repair Service - (770) 662-3666
International Sales - (770) 662-3660                                               Customer Service - (770) 662-3636
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Organization of the Manual Elzone II 5390
1.  GENERAL INFORMATION

This manual describes how to operate the Elzone II 5390 analyzer. To help you operate 
the Elzone more efficiently:

• read Chapter 2, User Interface, before operating the analyzer and its software

• use the step-by-step instructions located in Chapter 3 when performing common 
operations (dialogs used in these procedures are explained in Chapters 5, 6, 7, and 8)

Organization of the Manual

The Elzone operator’s manual is organized as follows:

Chapter 1  GENERAL INFORMATION

Provides a general description of the Elzone 5390 system, its fea-
tures, and specifications.

Chapter 2 USER INTERFACE

Provides basic software and hardware interface. It is recom-
mended that you read this chapter to familiarize yourself with the 
instrument and its software before you begin operation.

Chapter 3 OPERATING PROCEDURES

Provides brief step-by-step procedures for the operations you can 
perform with the analysis program.

Chapter 4 SOFTWARE AND SETUP MODIFICATIONS

Provides instructions for installing software updates and for 
modifying analyzer setup configurations.

Chapter 5 FILE MENU

Provides a description of the commands available on the File 
menu.

Chapter 6 UNIT MENU

Provides a description of the commands available on the Unit 
menu.
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Chapter 7 REPORTS MENU

Provides a description of the commands available on the Reports 
menu.

Chapter 8 OPTIONS MENU

Provides a description of the commands available on the Options 
menu.

Chapter 9 TROUBLESHOOTING AND MAINTENANCE

Provides information for troubleshooting and for performing rou-
tine maintenance procedures.

Chapter 10 ORDERING INFORMATION

Provides ordering information and part numbers for system 
components.

Appendix A ERROR MESSAGES

Provides a listing of error messages that may be displayed by the 
analysis program, as well as causes and actions for each.

Appendix B DATA REDUCTION

Contains the calculations used by the software to produce 
reports.

Appendix C FORMAT OF EXPORTED DATA

Provides the format for exported data.

Appendix D ELECTROLYTES

Provides information on electrolytes and their preparation for 
analysis.

Appendix E THEORY OF OPERATION

Provides a discussion on the operation theory of the Elzone 
analyzer.

Appendix F CONCENTRATION ANALYSES

Provides information on performing concentration analyses.
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Conventions

This manual uses the symbols shown below to identify notes of importance, warnings, 
and cautions:

Appendix G CAMERA OPTION

Provides installation and basic operating instructions for the 
camera.

Appendix H OPTIMUM PERFORMANCE FOR STRAY PARTICLE 
COUNT AND NOISE

Provides a discussion on methods for obtaining optimum perfor-
mance for noise-sensitive applications.

Index INDEX

Provides quick access to a subject matter.

Notes contain important information pertinent to the subject matter.

Warnings contain information that help you prevent actions that may cause 
personal injury.

Cautions contain information that help you prevent actions that may damage the 
analyzer.
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Internet Access

Visit www.micromeritics.com to learn more about Micromeritics, our products, and 
applications. Our site is user-friendly, easy to navigate, and informative. Its content is 
summarized below.

Be sure to browse our site to see the many ways in which we can assist you.

About Micromeritics A brief history of Micromeritics, office locations, awards/cer-
tifications, career opportunities, and a virtual tour of its 
headquarters

Products Product information and printable brochures

Applications Application Notes, Product Bulletins, Tech Tips, Technical 
Articles/papers, and important application links

Online Catalog  Catalog of instruments and accessories, allowing you to place 
your order online

News and Press Press releases, Events calendar, microReports, and latest 
Micromeritics news updates

Lab Service Provides laboratory tips and access to the Micromeritics Ana-
lytical Services web site

Customer Support Customer support contacts, product registration, instrument 
training information, Material Safety Data Sheets, and account 
registration

Grant Program Details of the Grant Program established for non-profit orga-
nizations and universities

Contact Us Contact information, office locations, maps and driving direc-
tions to the Micromeritics facility, and registration for the 
microReport newsletter
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System Description

The Elzone 5390 Particle Size analyzer uses the electrical sensing method for measuring 
particles. It is capable of measuring particles (organic and inorganic) ranging from 0.4 to 
240 m in diameter. The Elzone’s ability to measure low-concentration samples allows it 
to produce accurate data where other techniques are limited.

Operation

The Elzone’s operation is based on a simple, yet efficient process. The sample, dispersed 
at a low concentration in an electrolyte solution, is placed in a sample beaker and onto the 
sample stand of the analyzer. When the sample stand is raised, a tube containing a pre-
cision-drilled orifice becomes submerged in the sample beaker. An electrode in the tube 
provides a current which passes through the orifice by way of the electrolyte to a second 
electrode in the sample beaker. The dispersed sample is pulled through the orifice. As 
each particle passes through, it displaces a volume of electrolyte equal to its own volume. 
This disturbs the electrical field between the two electrodes, producing an electrical pulse 
for each particle. The Elzone counts and sizes these pulses and reports the data. 
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Orifice Tubes 

A wide range of orifice tubes is available to accommodate many sample sizes. The orifice 
is drilled in a synthetic jewel which is permanently sealed into the wall of the tube. Each 
tube is carefully tested, using standard samples of monodispersed polymer spheres, to 
verify it produces distortion-free measurements. The effective range of particle sizes a 
typical orifice can measure is from 2% to 60% of its orifice diameter. You can blend 
(merge) data obtained from multiple orifice tubes to report a continuous distribution for 
overlapping segments of a broad range of particle sizes.

Analysis Program

The Elzone analysis program is operated in a Windows environment, and includes wiz-
ards and intuitive screens enabling you to perform system operations quickly and 
efficiently. 

Also included is a report system which allows you to manipulate and customize reports. 
You can zoom in on portions of the graphs or shift the axes to examine fine details. Scal-
able graphs can be copied to the clipboard and pasted into other applications. Reports can 
be customized with your choice of fonts and a company logo added to the report header 
for an impressive presentation. Refer to Onscreen Reports, page 7-22 for available 
options.

Camera

An optional camera is offered for capturing and displaying pictures of the orifice jewel on 
the computer screen. This feature enables you to:

• view particle activity in the orifice
• detect blockages in the orifice
• check the orifice jewel for cracking
• check the orifice for particle build-up

Refer to Ordering Information on page 10-1 for ordering information. Installation and 
operating instructions are located in Appendix H.
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ElectroPrep 

The ElectroPrep is designed to recirculate electrolyte through a filter cartridge that retains 
particles greater than 0.1 to 0.2 micrometers in diameter. The electrolyte is contained in a 
reservoir, providing a supply of clean electrolyte at all times. 

For electrolytes in which sample particles readily disperse (e.g., alumina in saline water) 
without having to add a dispersing agent, the waste liquid can simply be poured back into 
the reservoir and used again and again. In typical usage under this circumstance, one prep-
aration of electrolyte will last several months before the filter cartridge has to be replaced. 
This is also true with saturated electrolytes.

Waste liquid cannot be recycled when the sample material requires a special dispersing 
agent because placing it back into the electrolyte would change the electrolyte composi-
tion. The ElectroPrep is still useful in these situations by affording a ready source of clean 
electrolyte to fill instrument sample beakers and supply containers. The ElectroPrep can 
be employed with either aqueous or organic electrolytes by selecting the appropriate car-
tridge. Refer to Ordering Information, page 10-1 for information on ordering the 
ElectroPrep, or contact your local sales representative

Volumetric Pump

Also available is a volumetric pump which enables you to measure the concentration of 
particles.

Refer to Ordering Information on page 10-1 for information on placing your order. 
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Specifications

The Elzone 5390 analyzer has been designed and tested to meet the specifications listed 
below.

       

Characteristic Specification

Analysis

 Electrolyte: Aqueous- or organic-based liquids

 Concentration: From 1 to 1000 ppm (0.1%) by volume

 Sensing rate: From 1 to over 5,000 particles per second

 Size range: 0.4 to 240 m 

 Analysis time: Typically 10 to 100 seconds

Performance

 Repeatability: ± 1% (10 measurements from same sample)

 Reproducibility: ± 1.5% (instrument to instrument)

Electrical

 Voltage: 100/120/230/240 VAC

 Fuse type: 2.0 A, 3 AG, Slow-Blow (100/120 VAC)
1.0 A, 5 x 20 mm Slow-Blow (230/240 VAC)

 Power: 150 VA

 Frequency: 50/60

Environment

 Temperature: 10 to 45 ºC operating; -10 to 55 ºC storing or shipping

 Humidity: 20 to 80% relative, noncondensing

Physical 

 Width: 38 cm (15 in.)

 Height: 54.5 cm (21.5 in.)

 Depth: 40.5 cm (16 in.)

 Weight: 28 kg (61 lbs)
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Characteristic Specification

Computer

Minimum requirements: • 1 GHz or faster 32 bit (x86) or 64 bit (x64) 
processor

• 2 GB RAM
• 40 GB minimum hard drive (formatted in NTFS) 

(one partition)
• Video Adapter capable of 1024 × 768 minimum 

resolution
• One 10 BaseT Ethernet port (can be 10/100)
• CD-ROM drive
•  Windows 7 Professional is recommended for the

  best user experience.
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Controls, Indicators, and Connectors Elzone II 5390
2.  USER INTERFACE

This chapter contains information to familiarize you with the hardware and software of the 
Elzone system. It is recommended that you read this chapter before attempting to operate 
the Elzone II 5390 analyzer.

Controls, Indicators, and Connectors

This section contains a description of the controls, indicators, and connectors located on 
the front, side, and rear panels of the analyzer.

Front Panel

Power Indicator  
(upper left side of 
front panel)

Camera assembly

Orifice light connector

Sample Stand

Stirrer assembly 
(shows rotary stirrer installed)

Electrode (external) 
connector

 

Sample port

Exit Tube

This door contains a reflector (used to 
diffuse the orifice light when the 
camera is installed).

Compartment doors The sample compartment contains two sliding doors. 
These doors should always be closed during an analysis. 
The door on the right side contains a reflector which 
serves to diffuse the orifice light when the camera option 
is installed. 
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Power Indicator Illuminates when the analyzer is turned on. 

Electrode connector For connecting the external electrode.

Camera assembly (optional) Enables you to view and capture pictures of 
the orifice jewel and display them on the computer 
screen.

Orifice light connector For connecting the orifice light (included with the camera 
option). Provides a backlight for the orifice when 
capturing pictures. Also illuminates the sample beaker, 
providing a clear view of particle suspension.

Sample port For installing the orifice tube.

Exit tube This tube is used to remove liquid from the sample 
beaker to the waste container.  

Stirrer assembly Enables you to maintain dispersion of the sample. Two 
types of stirrers are available:

• Propeller; maintains dispersion by means of a glass 
propeller. The propeller stirrer is included with the 
Elzone analyzer.

• Hydropulser (optional); maintains dispersion using a 
pulsing motion. The hydropulser may be desirable for 
more fragile samples and when using small volumes 
of analysis liquids.  
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Sample stand For raising the sample beaker up and around the orifice 
tube for analysis.

To raise the stand: Pull out the knob and slowly raise 
the stand to the desired position; release the knob to lock 
it into place. Slots are evenly spaced along the sample 
stand track for this purpose.

To lower the stand: Pull out the knob and slowly lower 
the stand to its lowest position; release the knob to lock 
it into place.

Slots are evenly spaced 
along the track to lock 
the sample stand into 
position.
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Side Panel

Supply inlet 
port

Waste vacuum port

Waste liquid outlet port Waste container sensor

Waste liquid outlet port For connecting the tubing to the waste container

Waste vacuum port For connecting the vacuum tubing to the waste container

Waste sensor connector For connecting the overflow sensor cable to the waste 
container. This sensor senses when the bottle becomes 
full and automatically cancels any operation in progress; 
an error message is also displayed. You must empty the 
waste container before you can proceed.

If the waste sensor cable is not securely plugged in and, 
therefore, does not detect the full container, a second 
sensor activates. If the second sensor activates, the 
internal tubing is filled with liquid and may have spilled 
into the internal component area. Call your Micromeritics 
service representative if this occurs. Refer to Sensors, 
page 6-41 for additional information.

Supply inlet port For connecting the tubing from the supply container 
(analysis liquid)
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Rear Panel

Power connector

On/Off switch

Voltage selector 
card

Ethernet connector

Camera USB 
connector

RS232 ports 
(unused)

Air Filter

Test Points
(for service 
personnel only)

Test points For use by Micromeritics service personnel only

Camera USB port For connecting the camera 

Air Filter Helps to minimize buildup of dust within the analyzer

On/Off switch For turning the analyzer on and off

Ethernet connector For connecting the ethernet cable, allowing 
communication between the analyzer and the computer

Power connector For connecting the power cord

Voltage selector card Enables you to specify the proper operating voltage

Spare 1 and 2 RS-232
 ports

Unused
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 Using the Software

The Elzone analysis program operates in the Windows environment and requires famil-
iarity with standard Windows operations such as using the mouse, menus, and dialog 
boxes. This manual provides brief instructions for standard operations; however, you may 
need to refer to your Windows documentation or the Windows help system to clarify 
functions which are specific to Windows.  

Shortcut Menus

Shortcut menus (sometimes referred to as context-sensitive menus or pop-up menus) are 
available for onscreen graphs, tabular reports, and some components on the instrument 
schematic. These menus are accessed by right-clicking in the graph or table area, or on a 
component on the instrument schematic. For example, right-click in the graph area of an 
onscreen report and the following menu is displayed.

Shortcut Keys

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combi-
nations (if assigned) are listed to the right of the menu item. Instead of opening the menu 
and choosing the command, simply press the key combination. For example, to open a 
sample information file, press F2; the Open Sample Information dialog is displayed.

You can also use shortcut keys to access a menu or any function that contains an under-
lined letter by pressing Alt plus the underlined letter in the command. For example, to 
access the File menu, press Alt, then F.

Table 2-1 lists the shortcut key(s) available for operating the Elzone program. 
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Table 2-1. Shortcut Keys

Key(s) Function

F1 Access online operator’s manual 

F2 Open a sample information file (main menu bar)

Clear the field of existing date (Select Dates dialog)

F3 Open an analysis conditions file  (main menu bar)

Insert the current date  (Select Dates dialog)

F4 Open a material properties file  (main menu bar)

Display a calendar from which to choose a date (Select Dates dialog)

F5 Open a report options file

F6 Tile windows

F7 Cascade windows

F8 Start a report

F9 Close all open reports

Alt + F4 Exit the Elzone program

Shift + F2 List sample information files

Shift + F3 List analysis conditions files

Shift + F4 List material properties files

Shift + F5 List report options files

Shift + F9 Displays the shortcut menu for onscreen reports and for selected 
components on the instrument schematic
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Dialog Boxes and Subdialog Boxes

Dialog boxes are displayed when an item followed by an ellipsis (...) is selected. Subdi-
alog boxes are displayed when a push button on a dialog box is selected. Both types of 
dialogs may contain one or more of the following:

If an item is shown in gray instead of black, the item is currently unavailable.

Data entry field These fields are used to enter text; either numeric 
(numbers only) or alphanumeric (numbers, letters, or 
printable characters). 

If an invalid entry is made, an error message is dis-
played; for example, if you attempt to enter an alpha 
character in a numeric field, or a number outside of the 
specified range.

Push button Typically, a push button is used to display subdialog 
boxes in which to edit, enter, or specify additional infor-
mation about the subject matter. Some push buttons, 
however, are used to invoke an action; for example, 
Save saves entries in the current dialog. 

Radio button Radio buttons allow you to choose one option from a 
group of two or more. When you select a radio button, 
any previously selected radio button becomes deselected. 

Radio button

Drop-down list

Information bar; displays 
range for selected field

Push button; 
this type 
displays a 
subdialog

Data entry 
fields

Check box

Push button; this type  
causes an action
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Selecting Files

Sample information is stored in files and saved under file names. Certain dialog boxes 
contain a Files list box which displays a list of files available for that particular operation. 
One example is the Open Sample Information dialog:

When opening sample information files, the next automatically sequenced file number 
appears in the File name field. For parameter files, a wildcard character with the default 
extension for the type of file you are opening appears in the File name field. Simply 
select the desired file displayed in the Files list box, then click OK to open the file. Alter-
natively, you can double-click on the desired file.

Check Boxes Check boxes also are used to select options. However, 
with check boxes, you may select as many items as you 
wish.

Drop-down lists A drop-down list is indicated by a down arrow to the 
right of the field. Drop-down lists contain a list of 
options from which you may choose one.

Information Bar Some dialog boxes contain information pertinent to the 
selected field in an information bar across the bottom of 
the dialog. For example, a range is shown for fields in 
which numeric entries are required.

Displays all files of 
the type in the 
Status field.

The Status drop-
down list does not 
appear on the Open 
dialogs for 
parameter files.

Displays the 
current 
directory.
539-42820-01 (Rev A) - Sep 2017                                                 2-9 



Elzone II 5390 Using the Software
You may limit the list of files displayed in the Files list box by choosing one (or more) of 
the following:

• Use wildcard characters in the path name you enter in the File name field. Wildcard 
characters such as * and ? can be used to filter file names. For example, you could 
filter a list to display files beginning with F by entering F*.smp (or other appropriate 
extension) in the File name field.

• Enter a range of dates. Click Date Range; the Select Dates dialog is displayed.

Select the Show Date Range radio button. This enables the From and To fields so 
that you may enter a beginning and ending date. Alternatively, you may double-
click in each field to display a calendar from which to choose a date. The range of 
dates remains the default until you change the dates or select Show All Dates.
 

For convenience, the following shortcut keys are available when the Select Dates 
dialog is displayed:

F2 Clears the field
F3 Inserts the current date
F4 Displays a calendar from which you may select a date

Selects the year

Selects the month

Click the desired date

You may change the date format by using the Date and Time function on the 
Windows Control Panel.
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• Select a file status from the Status drop-down list (displays only for sample files). 

Table 2-2. File Status and Description

• Navigate to a different directory. The current directory is displayed just above the 
Directories list box. You can change directories by double-clicking a directory in 
the Directories list box, double-clicking [...] to move up one level, or by entering the 
desired directory in the File Name field. For example, enter 
C:\5390files\sample\*.smp to display sample files in the 5390files\sample directory 
on your local drive.

Status Description

All All sample information files in the specified directory and within 
the specified range of dates

Analyzing Sample information files that are currently being used in an analysis

Background Sample information files that contain background data

Complete Sample information files that were used in an analysis that has been 
completed

Entered Sample information files that contain manually entered data

No Analysis Sample information files that have not been used in an analysis

Double-click to move 
up one level.

Double-click to open 
the listed directory.

Displays the current 
directory.
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Selecting Reports

Reports are selected from the Report Options dialog. Simply select (highlight) the report 
and then double-click, or press the spacebar. A report is selected when it is preceded with 
a check mark. Reports are deselected in the same manner. 

Indicates a report 
is selected.
2-12                                                    539-42820-01 (Rev A) - Sep 2017



Using the Software Elzone II 5390
File Name Conventions

For sample information and parameter files, a wildcard character (*) and a default exten-
sion display. 

The following table shows the file name extensions for the Elzone program.

Table 2-3. Default File Name Extensions

File Type Extension

Sample Information SMP

Analysis Conditions ANC

Material Properties MTP

Report Options RPO

Export to disk (ASCII) EXP

Report to disk RPT

List to disk LST


The following types are available for reports saved from the Report window:

Report REP

Spreadsheet XLS

ASCII TXT
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Menu Structure

All functions for the Elzone program are located on menus which are accessed from the 
Menu bar. Each menu contains commands, and in some cases a submenu. A submenu is 
indicated when the command is followed by an arrow. 

Brief descriptions of each menu are provided below; refer to the chapter given in paren-
theses for a detailed description of the commands contained on that menu.

File The options on the File menu enable you to create and manage sam-
ple and parameter files. (Chapter 5, FILE MENU)

Unit [n] Enables you to perform analyses and other instrument operations. If 
you have two analyzers connected to your computer, a unit menu is 
shown for both. (Chapter 6, UNIT MENU)

Reports Enables you to generate, close, and open reports; also provides 
examples of some of the reports available with the Elzone program. 
(Chapter 7, REPORTS MENU)

Options Allows you to choose sample editing mode, specify sample defaults, 
select data presentation formats, and specify a location for predefined 
parameter files. (Chapter 8, OPTIONS MENU)

Windows Enables you to arrange the windows and icons on your screen. This 
menu also displays the names of all open windows. (this chapter, 
page 2-15)

Help Displays information about the Elzone program. Also provides 
access to the online operator’s manual. (this chapter, page 2-15)

Submenu

Command

Menu Bar

Menu Name
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Windows Menu

Help Menu

Tile Resizes all open windows and arranges them side by 
side. 

Cascade Resizes all open windows and arranges them in a stacked 
fashion. The active window is positioned on top of the 
stack. Each window’s title remains visible, making it 
easy to select other windows.

Arrange icons Arranges all minimized dialogs in an orderly manner. 

Open Files Displays all currently open files. The active file is pre-
ceded with a check mark.

Operator’s Manual Launches Adobe Acrobat, providing a copy of the oper-
ator’s manual. Refer to Specifications, page 1-8 for tips 
on using the online manual.

About Elzone II Displays information about the Elzone program
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3.  OPERATING PROCEDURES

This chapter contains brief, step-by-step instructions on how to:

• specify defaults for sample and parameter files, beginning on this page 
• create a parameter file, page 3-6
• create a sample file, page 3-13
• perform a background, page 3-17
• calibrate an orifice tube, page 3-20
• prepare your sample for an analysis, page 3-28
• optimize instrument settings, page 3-33
• perform an analysis, page 3-38
• print contents of a parameter or sample file, page 3-40
• list file statistics, page 3-41
• convert a file used with a previous version of the Elzone to be compatible with 

Elzone II, page 3-43
• export a sample file, page 3-42
• generate overlays, page 3-45

This chapter does not contain detailed descriptions of the dialogs used to perform these 
procedures. Refer to Chapters 5 through 8 for dialog descriptions. Use the table of 
contents or index to assist you in locating the appropriate dialog.

Specifying Sample Defaults

Sample information files include the information required to perform analyses and collect 
data. The Elzone analysis program automatically generates sample information file names 
and assigns default values. The program is shipped with default values, however, they 
may not be suitable for your type of material. The Sample Defaults command on the 
Options menu enables you to specify default values more appropriate for your type of 
analysis. You can always edit the values when the sample file is created.

The sample information file can be presented in three different formats: basic, advanced 
and restricted. Sample defaults can be specified in the basic and advanced formats only; 
you cannot specify sample defaults using the restricted format. The sample defaults you 
specify for the basic format display for the restricted format. Parameter file defaults are 
specified using the Advanced format.

If desired, you can define parameter files before entering sample defaults (refer to 
Defining Parameter Files, page 3-6).
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Advanced Format

You can move from one set of parameters to another by clicking the parameter tab or by 
using Next and Prev. The values you specify in the parameter portions of the sample file 
(Analysis Conditions, Material Properties, and Report Options) are saved as the defaults 
for newly created parameter files.

For example, after specifying defaults for a sample file in the Advanced format:

• Select File > Open > Sample Information, then click Yes to create the file, and 
the defaults you specify display for all parameters.

• Select File > Open > Analysis Conditions, enter a file name; then click OK, and 
the defaults you specify in the Analysis Conditions portion of the Advanced 
Sample Defaults dialog display in the fields.

1. Select Options > Sample Defaults; the Sample Defaults dialog is displayed. 

2. In the Sequence Number field, specify a default string. This is the number that is 
incrementally sequenced and displays in the File name field when you select File > 
Open > Sample information.

Refer to Sample Defaults, Advanced, page 8-6 if you need clarification of the fields 
on the dialog used in this procedure.
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3. In the field on the right of the Sample line, enter a format for the identification. Be 
sure to include the $ symbol if you wish to have the sample file number included as 
part of the identification.

4. Edit the Operator and Submitter lines as desired. Or, you can select Omit to have 
either (or both) of these limes omitted from the sample file dialog. 

5. The Bar Code line is for entering bar codes. If you are not using bar codes, you can 
edit the label and use this line for additional information on the sample. Or, like the 
previous lines, you can select Omit to remove the line from the sample file editor.

6. In the Dilution Factor field, enter a value to represent the dilution factor; this value 
can be edited when creating the sample file if required.

The ranges for the numeric fields are shown in the information bar across the lower 
section of the dialog.

7. In the Mass Concentration field, enter a value to represent the amount of sample 
you typically use in your analysis. This value can be edited when you create your file, 
as well as after the analysis.

8. If you plan to report statistical process control (SPC) information, enter appropriate 
information. These are user-definable parameters that can be entered and tracked 
along with other statistical process control data; refer to Sample Defaults, page 8-8 
for additional information on these parameters. Click the Analysis Conditions tab 
and enter appropriate information for your most commonly analyzed sample 
material. Remember, you can always edit this information in the sample file when it 
is created. 

9. Click the Materials Properties tab and enter appropriate information for your most 
commonly analyzed sample material. Remember, you can always edit this 
information in the sample file when it is created.

10. Click the Report Options tab and choose the desired reports. Again, this selection 
can be edited in the sample file when it is created.

11. Click Save, then Close.

You can also edit the word Sample that displays for the prompt in the sample file. 
For example, you may prefer to use Test or Material to display as the prompt.

The default values you specify for Analysis conditions, Material properties, and 
Report options display as the defaults for newly created parameter files.
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Basic Format

The defaults you specify for this format also display as the defaults for sample files 
created using the Restricted format.

1. Select Options > Sample Defaults; the Sample Defaults dialog is displayed.

2. In the Sequence Number field, specify a default string. This is the number that is 
incrementally sequenced and displays in the File name field when you select File > 
Open > Sample information.

3. In the field on the right of the Sample line, enter a format for the identification. Be 
sure to include the $ symbol if you wish to have the sample file number included as 
part of the identification.

Refer to Sample Defaults, Basic, page 8-9 if you need clarification of the fields on 
the dialog used in this procedure.

You can also edit the word Sample that displays for the prompt in the sample file. 
For example, you may prefer to use Test or Material to display as the prompt.
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4. Click on the down-arrow to the right of the Analysis Conditions field and choose a 
default file.

5. Click on the down-arrow to the right of the Report Options field and choose a 
default parameter file. The reports chosen (preceded with a check mark) for the 
selected file will display in the list of reports below the field. Edit selections if 
desired.

6. Click on the down-arrow to the right of the Material Properties and choose a default 
parameter file.

7. Enter a value to represent the Number of Tests you typically perform with a sample; 
you can perform up to eight tests with each file.

The ranges for the numeric fields are shown in the information bar across the lower 
section of the dialog. 

8. Enter a speed at which to have the stirrer operate; 0 turns off the stirrer and 10 is the 
highest speed.

9. Choose whether you wish to have the stirrer rotate to move the particles upward or 
downward.

10. In the Dilution Factor field, enter a value to represent the dilution factor; this value 
can be edited when creating the sample file if required.

11. In the Mass Concentration field, enter a value to represent the amount of sample 
you typically use in your analysis. This value can be edited when you create your file, 
as well as after the analysis.

12. In the Rinse group box: 

a. Select Rinse if you wish to have the system rinsed; you can choose to rinse 
before or after the analysis.

b. Select the type of rinse you wish to perform. Drain and Fill completely drains 
the system and refills it, whereas Flush simply flushes liquid through the system. 

13. Click Save, then Close.

Click Advanced to view details of selected parameter files if desired.
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Defining Parameter Files

Analysis Conditions, Material Properties, and Report Options files can exist as part of the 
sample information file or as an individual parameter file. Having these files exist 
independently allows you to use them over and over again. For example; unless you 
expect each analysis to use unique sets of analysis conditions, material properties, and 
report options, you can create a group of standard parameter files containing the values 
you expect to use most frequently. The contents of these files can be copied and imported 
into sample information files, providing speed and consistency. After these values have 
been copied and imported into the sample information file, they can be edited in any way 
that you wish. The original parameter file remains intact and ready for its next use.

Several predefined parameter files are included with the Elzone program. These files are 
examples only and may not contain appropriate values for your application. If you wish 
to use one of these files as a starting point, simply create a new file and click Replace. A 
dialog is displayed so that you can select an existing parameter file. After the values from 
this file are copied into the current file, you can edit them as desired. 

Make sure you save these files to the directory specified as the Parameter File directory 
(refer to Parameter Files Directory, page 8-15 for additional information). If you do not 
save these files to the parameter file directory, they will not display in the drop-down lists 
on the Basic and Restricted sample file editors. 

Parameter files can also be created from the Advanced Sample information window using 
the Save as function on the File menu. For example, you have a sample information file 
open that contains exactly the analysis conditions that you use often in your analyses. 
Simply select File > Save As >Analysis Conditions and enter a name for the file. After 
this file has been created, it can be copied into as many sample files as you wish using the 
Replace push button on the sample file editor. 

This makes it possible for one person (such as a laboratory manager) to create 
standard parameter sets that can be used easily by others (such as laboratory 
technicians).

Unless you have changed the parameter file directory, parameter files are saved 
automatically to the param (default) directory. 
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Analysis Conditions

Analysis conditions specify data to guide an analysis.

1. Select File > Open > Analysis Conditions; the Open Analysis Conditions File 
dialog is displayed.

2. Enter a name for the file (up to eight characters) in the File name field.

3. Click OK, then Yes to create the file; the Analysis Conditions dialog is displayed.

4. Enter a description in the Analysis Conditions field. Use a description that will help 
you identify the conditions specified. You can use up to 40 characters.

5. Choose an appropriate orifice tube from the drop-down list. If the tube you select is 
preceded with an asterisk (as shown in the above dialog), the tube has not been 
calibrated for the current instrument. Calibrate the tube before using in an analysis.

6. Select Specify Diameter range and specify a range for the size of particles to be 
read. 

Refer to Analysis Conditions, page 5-13 if you need clarification of the fields on the 
dialogs used in this procedure.

Indicates the tube has 
not been calibrated.

Use Replace to copy values of an existing file into the current one. You can edit 
the values after they have been copied into the file if desired. This is useful when 
you have an existing file that contains many of the values that you wish to use in 
the current file.
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7. Specify rinse options. You can choose to rinse before or after the analysis by draining 
and filling the system or simply by flushing the system.

8. Select Purge Volumetric Pump to have the volumetric pump (if installed) purged 
during the rinsing operation.

9. In the Number of Tests field, enter the number of analyses you plan to perform using 
this file.  

10. Enter the stirrer speed and the direction in which to have the particles circulate.

11. Click Flow Control and choose flow and blockage detection options.

12. Click Data Setup and specify details on producing the raw data.

13. Specify when you wish to have the analysis end.

14. Click Save, then Close.
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Material Properties

Material properties specify data for the sample material and its electrolyte.

1. Select File > Open > Material Properties; the Open Material Properties File dialog 
is displayed.

2. Enter a name for the file (up to eight characters) in the File name field.

3. Click OK, then Yes to create the file; the Material Properties dialog is displayed.

4. Enter a description in the Material Properties field.

5. Choose the sample material from the Sample Material list. If your material is not 
listed, add it to the list:

a. Enter the sample material in the Description field.

b. Enter the material’s density in the Density field.

Refer to Material Properties, page 5-23 if you need clarification of the fields on the 
dialog used in this procedure.

Use an intuitive name that will help you identify the type of sample you plan to 
analyze using this file. You may want to use a name containing the type of sample 
material and electrolyte.
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c. Enter a shape factor if desired.

d. Choose the maximum current appropriate for the sample material, or, if known, 
enter one.

e. Click Add.

6. Choose a dispersing liquid from the Electrolyte Solution list. If your electrolyte is 
not listed, add it to the list:

a. Enter the electrolyte in the Description field.

b. Enter the density and viscosity at room temperature.

c. Click Add.

7. Use the Dispersion window to add any special preparation instructions.

8. Click Save, then Close.
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Report Options

Report options files specify the types of reports you can generate from an analysis or 
from manually entered data. They also contain details such as axis scale, axis range, 
column headings, etc. 

Report options files also can be defined to include overlay options (refer to Generating 
Graph Overlays, page 3-45). The Elzone software enables you to overlay:

• one plot type onto a different plot type from the same sample analysis

• the same plot type from all tests in the same file 

• up to eight plots of different samples onto the current plot of the same type, and 
they don’t all have to contain data collected with the Elzone. You can overlay data 
collected with Micromeritics’ Saturn DigiSizer® 5200, SediGraph 5100, and 
SediGraph 5120. 

1. Select File > Open > Report Options; the Open Report Options File dialog is 
displayed.

2. Enter a name for the file (up to eight characters) in the File name field.

3. Click OK, then Yes to create the file; the Report Options dialog is displayed.

Refer to Report Options, page 5-25 if you need clarification of the fields on the dia-
logs used in this procedure.
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4. Enter a description in the Report options field. Enter an identifier which gives a 
more intuitive description of the file’s contents. For example, Tabular Report using 
Volume Distribution.

5. Select Show report title and enter the title you wish to appear at the top of the report. 
Or you can deselect this option if you do not wish to have a report title.

6. Select Show graphic if you would like to have a graphic display in the report header. 
The graphic must be a bitmap or enhanced metafile. Use Browse to choose the file, 
and the Height and Width fields to specify the size. 

7. Click on the down arrow to the right of the Test field and choose which test you wish 
to have reported. If you choose Average, an average for all tests performed using this 
file will be generated.

8. If you wish to compare analysis results for the current sample to those obtained for a 
reference sample, click Reference and choose the desired file. Results are reflected 
in the Difference from Reference report.

9. If you wish to determine if the results for the current sample are within coarse and 
fine specifications, click Specification and choose a sample file for each boundary. 
Results are reflected in the Out of Specification report.

10. If you wish to overlay graphs, click Overlays and choose the sample file(s) you wish 
to overlay with a graph of the current sample. Then be sure you edit the desired graph 
and choose Samples in the Overlay field.

11. Click Peaks if you wish to edit Peak detection settings.

12. From the Reports to Generate list, choose the reports you wish to have generated. A 
report is selected when it is preceded with a check mark. To select (or deselect) a 
report: highlight the report, then double-click or press Spacebar. 

13. Edit desired report(s) by highlighting the report, then clicking Edit. There are 10 
graphs which can be customized as desired.

14. Click Save, then Close.
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Creating a Sample Information File

Every analysis requires a sample information file. The file consists of information groups 
which, collectively, identify the sample (sample information), guide the analysis (analysis 
conditions, material properties), and specify the data reduction (report options).

A sample file may be created in three different formats:

• Advanced. This format provides complete access to all parts of the sample file, 
allowing you to quickly edit parameters if needed.

• Basic. This format presents a single window in which you select predefined 
parameter files for your analysis. However, with this format, you can switch to the 
Advanced format to edit parameters if desired.

• Restricted. This format is identical to the Basic format, except that certain menu 
options become disabled and you cannot switch to the Advanced format.

Advanced Format

The Advanced format presents all parts of the sample file in a manner similar to that of an 
index card file, wherein each parameter set has a tab that you click to access its dialog.

1. Select File > Open > Sample Information; the Open Sample Information File 
dialog is displayed.

2. Accept the next sequenced file number or enter a new name in the File name field; 
you can use up to eight characters.

3. Click OK, then Yes to create the file; the Advanced Sample Information dialog is 
displayed.

Refer to Sample Information, Advanced Presentation, page 5-5 if you need 
clarification of the dialogs used in this procedure.
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4. Enter a description in the Sample field; you can use up to 50 alphanumeric 
characters.

5. Enter the names of the operator and submitter.

6. Enter the bar code (if used), or use a bar code reader to transfer the information. If bar 
codes are not used, this line can be omitted from the sample editor or it can be used 
for some other type of information. Refer to Sample Defaults for information on 
removing or editing this field.

7. Select the type of data for this file; you can have data collected automatically, enter 
the data, or have the data collected and saved for a background.

8. Unless you are gathering statistical process control information, it is unnecessary to 
enter parameter values. These are user-definable parameters that can be entered and 
tracked along with other statistical process control data; refer to Sample Defaults for 
information on specifying parameters.

9. Edit the values for the Dilution Factor and the Mass Concentration if needed.

10. Use the Comments window or the Add Log Entry push button to enter additional 
information about the sample or analysis conditions. Information entered in the 
Comments window appears in the header of some reports. Information you enter 
using the Add Log Entry push button displays in the Sample Log report.

11. Click on the parameter tabs to specify parameter values. Instructions for completing 
these dialogs are explained in Defining Parameter Files beginning on page 3-6.

12. Click Save, then Close.
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Basic and Restricted Formats

The Basic and Restricted formats are the simplest methods for creating a sample file, 
providing you have appropriate parameter files defined. If more detailed conditions or 
custom files are required, you should use the Advanced format. The Basic format 
provides a push button for switching to the Advanced format when editing is required;  
the Restricted format does not.

The instructions for creating sample files in the Restricted format are the same as for the 
Basic format with the following exceptions:

• You must enter a password to access this format (see Restricted, page 8-5)
• Certain  menu options become disabled
• You cannot switch to the Advanced format

1. Select File > Open > Sample Information; the Open Sample Information File 
dialog is displayed.

2. Accept the next sequenced file number or enter a new name in the File name field; 
you can use up to eight characters.

3. Click OK, then Yes to create the file; the Basic Sample Information dialog is 
displayed.

Refer to Sample Information, Basic Presentation, page 5-8 if you need clarification 
of the dialogs used in this procedure.

This push button 
does not display on 
the Restricted dialog.
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4. Enter a description in the Sample field; you can use up to 50 alphanumeric 
characters.

5. Select the down arrow to the right of the Analysis Conditions field and choose an 
appropriate file from the drop-down list. The orifice tube specified in the selected file 
displays just below the field; ensure that it is appropriate for your sample file.

6. Select the down arrow to the right of the Material Properties field and choose an 
appropriate file from the drop-down list.

7. Select the down arrow to the right of the Report Options field and choose an 
appropriate file from the drop-down list. The reports (in the Reports to Generate 
window) chosen for the selected file are preceded with a check mark; you can edit the 
selections if desired.

8. The remainder of the fields on the dialog display the values entered or chosen in the 
selected Analysis Conditions file; you may edit these values if desired. 

9. Click Save, then Close.
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Performing a Background Analysis

Occasionally, the ratio between contaminates in the electrolyte and particles in a sample 
can be low and, therefore, difficult to tell the difference between the two. When 
performing an analysis, the desired ratio between sample particles and contamination 
(sometimes called signal-to-noise ratio) in the electrolyte is approximately 99:1 in 1 mL 
of electrolyte. In other words, for every 99 sample particles, there should be no more than 
1 particle of contamination in the electrolyte.

When the signal-to-noise ratio drops below an unacceptable level, a procedure can be 
performed to remove the presence of contaminates in the electrolyte from the analysis 
data. 

Creating the Sample File

This example shows the file being created using the Advanced format. If you are using 
the Basic format, click Advanced to access the Advanced format. 

1. Select File > Open > Sample Information; the Open Sample Information dialog is 
displayed.

2. Click OK, then Yes to create the file.

3. On the Sample Information dialog:

a. Enter an appropriate description in the Sample field.

b. Select Background as the type of data.

c. Enter a dilution factor of 1.00.

d. Enter information in any other fields as desired (Operator, Submitter, etc.).

4. Click the Analysis Conditions tab, then:

a. Click the down arrow to the right of the Orifice Tube field and choose the orifice 
tube you plan to use.

b. Select Specify Diameter range; using the Minimum and Maximum fields, 
enter the range you plan to use in your analysis. 

c. Click Data Setup; select or enter the following:

Full-resolution as the Data Format
Logarithmic in Diameter for Size Classes; class range typically is the same 
range as specified for diameter range

d. Enter appropriate values for other fields (stirrer speed, etc.).
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5. Click the Material Properties tab; select the electrolyte being used. The sample 
material selected is irrelevant since only the electrolyte is being used for a 
background analysis. However, many Elzone users make an entry in the Sample 
Material list pertinent to the background. For example, you may wish to use 
“Background particles”. This is more relevant on the Background report.

6. Click the Report Options tab; select (precede with a check mark):

Inc. Number/mL% vs. Diameter Graph
Summary; click Edit and ensure that Total Number and Volume-Specific Number 
are selected.

7. Click Save, then Close.

Performing the Analysis

1. Remove the external electrode and the stirrer propeller (remove the hydropulser tube 
if the hydropulser is installed) from the analyzer.

2. Using a mild detergent, wash the propeller, the electrode, an appropriate sample 
beaker (refer to the reference material booklet for the size of sample beaker to use), 
and the orifice tube. Use the straight brush provided in the accessories kit to scrub the 
inside and outside of the orifice tube, and the orifice.

3. Rinse all items with filtered water or electrolyte.

4. Reattach the electrode and the propeller (or hydropulser tube) to their proper 
connections.

It is very important that all components be clean before performing a background 
analysis.
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5. Install the orifice tube onto the sample port (refer to Choosing and Installing an 
Orifice Tube, page 3-28).

6. Ensure that the appropriate electrolyte is connected to the Supply port.

7. Clean the installed glassware (orifice tube, electrode, and stirrer) externally.

a. Fill a squeeze bottle with clean, filtered electrolyte or water.

b. Place (or hold) a beaker under the glassware. Use the squeeze bottle to 
thoroughly rinse each piece of glassware, then remove the beaker.

8. Fill the analysis beaker with electrolyte (no sample) and place it on the sample stand; 
position the electrode next to the orifice tube so that it will be submerged in the 
beaker. 

9. Raise the sample stand.

10. Select Unit [n] > Fill System to fill the orifice tube.

11. Adjust and focus the camera if needed (if using the camera).

12. Select Unit [n] > Sample Analysis to display the analysis screen. Click Browse and 
choose the sample file you created.

After the analysis is finished, save the background data.

Squeeze bottle

Be sure the stirrer does not strike the bottom or sides of the beaker when raising 
the sample stand. The stirrer will not operate if it comes in contact with the 
beaker.
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Calibrating an Orifice Tube

An orifice tube must be calibrated for the instrument on which it is to be used. An orifice 
tube (in the drop-down list) that has not been calibrated will be indicated with an asterisk. 
If you use an orifice tube that has not been calibrated, inaccurate data will be produced. 
An orifice tube is calibrated using reference material(s).  

Follow the instructions below to calibrate an orifice tube. Be sure to have your reference 
materials and the accompanying booklet handy before starting this procedure.

1. Remove the external electrode and the stirrer propeller (remove the hydropulser tube 
if the hydropulser is installed) from the analyzer.

2. Using a mild citrus-based detergent, wash the propeller, the electrode, an appropriate 
sample beaker (refer to the reference material booklet for the size of sample beaker to 
use), and the orifice tube. Use the straight brush provided in the accessories kit to 
scrub the inside and outside of the orifice tube, and the orifice (refer to Cleaning 
Orifice Tubes, page 9-9).

3. Rinse all items with filtered water or electrolyte.

4. Reattach the electrode and the propeller (or hydropulser tube) to their proper 
connections.

5. Install the orifice tube onto the sample port (the instructions on page 3-28 explain 
how to install an orifice tube).

6. Place a beaker (not the sample beaker you washed for the calibration) on the sample 
stand and raise the stand. Refer to User Interface, page 2-3, if you need assistance on 
raising and lowering the sample stand. 

7. Clean the installed glassware (orifice tube, electrode, and stirrer) externally:

a. Fill a squeeze bottle with clean, filtered electrolyte or water.

It is very important that all components be clean before calibrating an orifice 
tube.

If you have a camera installed on the analyzer, adjust the lens to display the 
orifice.
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b. Using the squeeze bottle, thoroughly rinse each piece of glassware.

c. Lower the sample stand and remove the beaker.

8. Rinse the clean sample beaker with filtered electrolyte or water. 

9. Fill the sample beaker with the amount specified for the beaker you are using (refer to 
the reference material booklet); allow enough room at the top to prevent overflow 
when glassware is submerged.

10. Place the beaker on the sample stand; position the electrode next to the orifice tube so 
that it will be submerged in the beaker. 

11. Raise the sample stand using the knob on the front.

Be sure the stirrer does not strike the bottom or sides of the beaker when raising 
the sample stand. The stirrer will not operate if it comes in contact with the 
beaker.
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12. Close the sample compartment door on the right side; adjust the light and camera if 
needed.

13. Select Unit > Fill System; the Fill System dialog is displayed.

This step fills the internal glassware.

14. Click Start; a dialog indicating the operation is in progress is displayed. The dialog 
closes automatically when the glassware is filled.

15. Add the number of drops specified for each reference material (refer to the booklet) 
to the sample beaker.

16. Close the sample compartment door on the front side.
3-22                                                    539-42820-01 (Rev A) - Sep 2017 



Calibrating an Orifice Tube Elzone II 5390
17. Click Unit > Orifice Tube Calibration; the Orifice Tube Calibration dialog is 
displayed.

18. Click Replace; the Open Analysis Conditions File dialog is displayed.
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19. Select the default calibration file for the selected orifice tube. Click OK to return to 
the Orifice Calibration dialog; appropriate values for the calibration will be copied 
into the fields.

Default calibration files are  named calxxx.anc, where xxx = the orifice tube size. For 
example, the default file for the tube shown above would be cal150.anc where 150 is 
the orifice tube size.

20. Click the down arrow to the right of the Orifice Tube field and choose the tube you 
plan to calibrate. If the tube is not in the list, perform the following steps to add it:

 a. Click Add Orifice; the Add Orifice Tube dialog is displayed.

b. Enter an identification in the Orifice Tube ID field. Typically users enter the 
serial number shown on the orifice tube and the size, making it easy to locate in 
the Files list. However, you may wish to establish your own identification 
system.

c. Enter the orifice size in the Diameter field.

d. Click OK to return to the Orifice Calibration dialog.

Size

Serial Number
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21. Click Next; the second view of the Orifice Tube Calibration dialog is displayed.

22. The appropriate reference materials should display in the window; if not, add them as 
follows:

a. Click Add; the Reference Material dialog is displayed.

b. Enter the Identification, Lot Number, Size, and Tolerance in the appropriate 
fields. (This information is found on the reference material bottle or in its 
accompanying booklet.) 

c. Select the Size statistic (also found on the bottle or its booklet).

d. Click OK to return to the Orifice Tube Calibration dialog.

e. Repeat steps a through d for each material to be used in the calibration.
539-42820-01 (Rev A) - Sep 2017                                                    3-25 



Elzone II 5390 Calibrating an Orifice Tube
23. Be sure that only the reference materials to be used in this calibration are selected 
(preceded with a check mark). Double-click on a reference material to place (or 
remove) a check mark.

24. Verify that the appropriate Electrolyte Solution is listed and selected. If it is not 
listed, enter the appropriate information in the Description, Density, and Viscosity 
fields and click Add.

25. Click Next to display the Calibrate Orifice Screen, then click Start. This screen 
displays data as collected.

 

26. When the progress bar reaches 100%, click Save. (The example shown in the 
previous step shows the Save push button disabled; it becomes enabled when the 
calibration is complete.)

If this is a new tube or if the previous orifice tube was different, error message 
6116 will display; click No to close the message.

Becomes enabled 
when calibration is 
complete.

Progress Bar
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27. Click Finish; the Finish dialog is displayed.

Ensure that 0 (zero) is in the Number of Tests Remaining field and the data are 
saved.

28. Click OK; the final Orifice Tube Calibration screen is displayed. 

This screen shows the final parameters of the calibration. It also allows you to define 
the peaks (information on defining peaks can be found on page 6-29).

29. Ensure that the values for each reference material are within tolerance; click the 
down arrow to the right of the drop-down list to access the reference materials.

30. Click Accept to save the calibration and close the dialog.

Ensure that the 
data are saved.

Be sure no tests 
are remaining.

Click the down 
arrow to display 
each reference 
material and its 
related values.
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Preparing for an Analysis 

Choosing and Installing an Orifice Tube

1. Choose an orifice tube with an orifice that is approximately two times the diameter of 
the largest particles in the sample. If available, a  microscope can be used to 
determine particle sizes. 

2. Ensure that the orifice tube is calibrated.

a. Click Reports > Orifice Tube Calibration.

b. Click the down arrow to the right of the Orifice Tube field to see if the tube is 
included in the list.

If it is not in the list, you must calibrate the tube (refer to Calibrating an Orifice 
Tube, page 3-20) before proceeding. 

3. Install the orifice tube onto the sample port:

a. Lower the sample stand (if not in the lowered position). 

b. Turn the sample port connector nut counterclockwise to loosen, then remove the 
connector nut, ferrule, and O-ring.

Orifice tubes must be clean to ensure accurate analysis results. Refer to Cleaning 
Orifice Tubes, page 9-9.

To prevent contamination, it is recommended that you wear rubber gloves when 
handling orifice tubes. Be especially careful not to touch the orifice.

Turn connector nut 
counterclockwise (to the left)
loosen and remove.

Electrode
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c. Holding the orifice tube with one hand, slide the connector nut over the top of the 
tube. (Your hand will keep the connector nut in place.) Then slide the ferrule over 
the top of the tube; it will nest down into the connector nut. Now slide the O-ring 
over the top of the tube (approximately 1/4 in. from the top of the tube).

d. Place the connector nut over the sample port and slide the orifice tube into the 
port; turn the connector nut clockwise to tighten.

Connector Nut

Ferrule

O-ring

  

If a camera is installed, be sure the orifice in the tube is aligned with the camera 
lens. Refer to Appendix H, page G-1 for information and operating instructions for 
the camera. 
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Filling the Supply Container

Your supply container should always contain the same electrolyte as the one used to 
prepare and disperse your sample. Be sure your supply container is filled with filtered 
electrolyte before you begin the analysis. Most Elzone users use the ElectroPrep, a unit 
designed to provide a continuous supply of filtered electrolyte. Refer to Appendix D, 
page D-1 for information on electrolytes, how to filter them, and on the ElectroPrep. 

These instructions are for refilling the supply container with the same type of electrolyte 
as previously used. Refer to Changing the Liquid in the Supply Container, page 3-31 
if you plan to use a different type of electrolyte.

1. Unscrew the cap on the supply bottle. 

2. Remove the cap (and tubing); place the tube in a beaker so that the it will not touch 
the work surface and pick up dirt particles.

3. Fill the supply bottle with filtered electrolyte (refer to Preparation of Electrolyte 
Solutions, page D-4 for information on filtering electrolyte).

4. Reinsert the supply tubing in the container and reattach the cap.

Unscrew the cap of 
the supply bottle.
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Changing the Liquid in the Supply Container

Your supply container should always contain the same electrolyte as the one used to 
prepare and disperse your sample.

These instructions are written for changing to a liquid of the same type base; for example, 
a water-based electrolyte to a different water-based electrolyte. Use the instructions in 
Changing Liquids of Different Bases if you are changing to a different type base; for 
example, a water-based electrolyte to an alcohol-based electrolyte.   

1. Select Unit > Change Orifice Tube or Liquid; the Change Orifice Tube or Liquid 
dialog is displayed.

2. Read the text in the dialog, then click Start. 

3. When prompted to change the liquid:

a. Remove the supply tube from its container, then remove the cap from the 
container.

b. Rinse the container with water (when using water-based electrolytes) or alcohol 
(when using alcohol-based electrolytes).

c. Fill the container with the new electrolyte.

d. Replace the cap and the tube.

4. Click Continue to complete the operation.

5. When the confirmation dialog is displayed, click Done to close the dialog.
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Changing Liquids of Different Bases

These instructions use an example of changing from a water-based electrolyte to an 
alcohol-based electrolyte.

1. Select Unit > Change Orifice Tube or Liquid; the Change Orifice Tube or Liquid 
dialog is displayed.

2. Read the text in the dialog, then click Start. 

3. When prompted to change the liquid:

a. Remove the supply tube from its container, then remove the cap from the 
container.

b. Empty the container of the water-based electrolyte, then refill it with water.

c. Replace the cap and the tube.

4. Click Continue.

5. When the confirmation dialog is displayed, click Next Liquid.

6. When prompted to change the liquid:

a. Remove the supply tube from its container, then remove the cap from the 
container.

b. Empty the container of the water, then refill it with alcohol (the base for the new 
electrolyte).

c. Replace the cap and the tube.

7. Click Continue.

8. When the confirmation dialog is displayed, click Next Liquid.
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9. When prompted to change the liquid:

a. Remove the supply tube from its container, then remove the cap from the 
container.

b. Empty the container of the alcohol, then refill it with the alcohol-based 
electrolyte.

c. Replace the cap and the tube.

10. Click Continue.

11. When the confirmation dialog is displayed, click Done to close the dialog.

Optimizing Instrument Settings

Instrument settings should be optimized:

• at the beginning of each operating shift regardless of whether you have a change in 
electrolyte

• for the electrolyte you are using in your analysis

• when you mix a new batch of electrolyte (even when it is the same type you have 
been using)

• when you change types of electrolyte

Since it is best to use a beaker containing electrolyte only (no sample), you can optimize 
your instrument settings while preparing your sample in a separate beaker. Or you can 
wait until optimization is complete and add the sample to the beaker used in the 
optimizing procedure.

1. Place a beaker of electrolyte onto the sample stand, then raise the stand.

2. Select Unit > Sample Analysis; the Sample Analysis dialog is displayed.

3. Click Browse and choose the file you plan to use for your analysis. 
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4. Click Next; the second view of the Analysis dialog is displayed.

5. Click Instrument Setup and ensure that Specify Diameter Range is selected and a 
valid range specified; click OK to close the dialog.

6. Click Optimize Settings. After the analyzer becomes idle, you may:

• Add sample to the electrolyte and continue with your analysis.

• Remove the beaker containing the electrolyte and place the beaker containing 
sample on the sample stand; then continue with your analysis.

• Click Close and restart your analysis when ready.

If you wish to save these settings for future use, click Save Settings to display the 
Save as Analysis Conditions dialog. Enter an appropriate name and click OK. You 
can then use the Replace button on the Analysis conditions portion of the sample 
file to load the settings into your sample file.
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Preparing and Loading Your Sample

Sample Dispersion

You must disperse a sample properly before you can analyze it. Use an effective 
electrolyte and sample dispersion method, obtained from references or by comparative 
testing, for stable counts. The suggested electrolyte strength is:

Approximate conductivity, m-mho/cm = 3000/D 
Approximate equivalent in weight % NaCl = 150/D 

where D = m orifice diameter.

Particle Concentration Guidelines

Coincidence (when two or more particles pass through the orifice at the same time) 
causes an absent portion of the true distribution and a distorted distribution of oversize, 
spurious particles. By using the correct concentration of particles or cells, you can keep 
the coincidence level at a maximum of 1.0%. Any level at or below these concentrations 
is acceptable. Refer to Table 3-1 to determine the concentration of particles in the sample 
solution. 

Table 3-1. Particle Concentration Guidelines

Where headings are:

Orifice Diameter 
(m)

N/mL for 1% 
Coincidence

mL/min @ 166 
mmHg

19 1,100,000 0.064

30 280,000 0.18

48 70,000 0.50

76 17,000 1.3

95 8,800 2.1

150 2,200 5.5

190 1,100 8.6

300 280 22.0

380 140 35.0

Orifice Diameter = The diameter (in micrometers) of the orifice being used.

N/mL for 1% 
Coincidence

= The total number of particles or cells in 1 mL of suspension in 
the sample beaker required for a coincidence level of 1.0%

mL/min @ 
166 mmHg

= The flow rate of a 1.0% saline solution through the orifice at a 
vacuum of 166 mmHg.
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Procedure

If possible, prepare your sample when you are ready to start the analysis. If you prepare 
your sample in advance, be sure to place a lint-free cover over the beaker to prevent the 
entry of air-borne particles. 

1. Place approximately 0.2 gram of sample into a 25-mL beaker.

2. Add 20 mL of electrolyte to the beaker.

3. Place the beaker in an ultrasonic bath for approximately 1-2 minutes.

4. Clean the external glassware (orifice tube, electrode, and stirrer):

a. Fill a squeeze bottle with clean, filtered electrolyte or water.

b. Hold a beaker (or place one on the sample stand) under the glassware and, using 
the squeeze bottle, thoroughly rinse each piece of glassware.

5. Place the analysis beaker on the sample stand; position the electrode next to the 
orifice tube so that it will be submerged in the beaker. 

If your sample tends to agglomerate, add a few drops of surfactant. Mix until it 
resembles paste.

If sample particles are fragile, do not use the ultrasonic bath; gently stir with a 
spatula instead.
3-36                                                    539-42820-01 (Rev A) - Sep 2017 



Preparing for an Analysis Elzone II 5390
6. Add an appropriate amount of sample mix to the analysis beaker; enough to achieve a 
1% coincidence level.

7. Using the schematic (with manual control enabled), ensure that the stirrer is off.

8. Raise the sample stand using the knob on the front. (Refer to User Interface, page 
2-3, if you need assistance on raising and lowering the sample stand.)

9. Close the sample compartment door on the right side; adjust the light and camera if 
needed.

10. Close the sample compartment door on the front side.

If your sample contains large particles, manually stir the sample mixture while 
transferring to the analysis beaker. This is to prevent the larger particles from 
remaining in the transferring beaker. 

Be sure the stirrer does not strike the bottom or sides of the beaker when raising 
the sample stand. The stirrer will not operate if it comes in contact with the 
beaker.
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Performing an Analysis

Before you start your analysis, be sure you have:

3 cleaned and calibrated your orifice tube; page 3-20

3 filled your supply container with filtered electrolyte; page 3-30

3 emptied your waste container

3 optimized instrument settings for the current electrolyte (this also can be done on 
the second view of the Sample Analysis dialog before you add your sample); page 
3-33

3 created your sample file using appropriate analysis conditions (this also can be 
done from the Sample Analysis dialog); page 3-13

If your application is noise-sensitive, read the discussion in Appendix I, page H-1 for 
guidelines in obtaining optimum performance from your elzone.

1. Select Unit > Sample Analysis; the Sample Analysis dialog is displayed.

2. Click Browse; the Select a File for Analysis dialog is displayed.  

3. Select your file, then click OK; the Sample Analysis dialog now contains all the 
parameters in the file you selected.
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4. Ensure that all parameters are appropriate, then click Next; the second view of the 
Sample Analysis dialog is displayed.

5. Click Start to begin the analysis.

After the analysis ends (progress bar reaches 100%), Save is enabled allowing you to 
save the data into the sample file.
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Printing File Contents 

Using the Print command on the File menu, you can print details of a sample or 
parameter file. For example, if you print the contents of an analysis conditions file, you 
will receive the parameters used for all analysis conditions associated with the file. 

1. Select File > Print, then choose the type of file for which you wish to print the 
contents. A dialog similar to the one shown below is displayed.

2. From the Files list, choose the desired file(s). 

3. At the Destination field, click the down arrow and choose a destination for file 
output. 

• If you choose Printer, the Copies field is enabled allowing you to print up to four 
copies. Output goes to the printer specified as the default printer.

• If you choose File, the File name field is enabled allowing you to enter a name for 
the file, or you can accept the default.

4. Click OK, the contents of the requested file(s) are sent to the specified destination.

Title bar displays the type of 
file for which contents are 
being printed.

The Status drop-down 
list does not display for 
parameter files.
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Listing File Statistics

You can generate a list of the following information on one or more sample or parameter 
files:

• File name
• Date the file was created or last edited
• Time the file was created or last edited
• File identification
• File status

Perform the following steps to generate a list of file statistics:

1. Select File > List, then the type of file on which you wish information. A dialog 
similar to the one shown below is displayed.

2. From the Files list, choose the desired file(s). If you wish to include all files in the 
list, leave all files deselected.

3. At the Destination field, click the down arrow and choose a destination for file 
output. 

• Printer; the Copies field is enabled allowing you to print up to four copies. Output 
goes to the printer specified as the default printer.

• File; the File name field is enabled allowing you to enter a name for the file, or you 
can accept the default.

4. Click OK, a list for the requested file(s) is sent to the specified destination.

Title bar displays the 
type of file for which a 
list was requested.

The Status drop-down 
list does not display for 
parameter files.
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Exporting Sample Data

Export allows you to copy the reduced or full-resolution data in a sample information file 
and reformat it in ASCII format. ASCII data can be imported into other applications, such 
as spreadsheets. You may select multiple files by holding down Ctrl while selecting the 
desired files. Refer to Appendix C, page C-1 for a description of the format used for 
exported data.

Perform the following steps to export data in a sample information file:

1. Select File > Export; the Sample Information File Export dialog is displayed.

2. From the Files list, choose the file(s) you wish to export.

3. From the Settings group box:

a. Choose the type of data you wish to export; reduced or full-resolution.

b. Select a destination: 

If you choose Printer, the Copies field is enabled allowing you to print up to 
four copies. Output goes to the printer specified as the default printer.

If you choose File, the File name field is enabled allowing you to enter a name 
for the file, or you can accept the default.

4. Click OK, the requested file is exported and sent to the specified destination.
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Converting Sample Files

The Convert function enables you to convert two different file types to a format 
compatible with the current Elzone program.

• Elzone: copies and converts data from sample files used with the Model 5380 
Series of analyzers

• ASCII: copies and converts data from a text file

Elzone Files

1. Select File > Convert > Elzone; the Convert Elzone Dialog is displayed.

2. From the Directories window, navigate to the drive/directory in which the desired 
file(s) is(are) located. 

3. Select the file; if converting multiple files, hold down the Ctrl key while selecting the 
files. Then click OK; a conversion dialog containing conversion results is displayed.

4. Click X in the upper right-hand corner to close the dialog.

Click here to close 
the dialog.
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ASCII Text

1. Select File > Convert > ASCII Text; the Convert Text Files dialog is displayed.

2. From the Directories window, navigate to the drive/directory in which the desired 
file(s) is(are) located. 

3. Select the file, then click OK. If converting multiple files, hold down the Ctrl key 
while selecting the files. The Select Parameters for Converting (file name) dialog is 
displayed. 

This dialog enables you to select the type of data contained in the text file. If you 
have selected multiple files, a dialog is displayed for each file (the name of the file is 
in the header).

4. Click OK; a conversion dialog containing conversion results is displayed.

5. Click X in the upper right-hand corner to close the dialog.
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Generating Graph Overlays

Use graph overlays when you wish to compare graphically results for multiple samples or 
multiple graphs for one sample. Graphical lines are differentiated by the use of varying 
symbols and reported in a legend on the report. If color output capability is available, 
different colors are used instead of symbols.

Graph overlays can be implemented in three ways:

• Multiple Sample Overlays 
Overlay up to eight plots of the same type on top of the current plot.

• Multiple Graph Overlays
Overlay two different types of plots from one sample. 

• Multiple Tests Overlays
Overlay the same plot from all tests of the sample file. 

Multiple Samples Overlay

This type of overlay enables you to overlay up to eight plots of the same type on top of 
the current plot. The data can be collected on the Elzone, the Saturn DigiSizer 5200, the 
SediGraph 5100, or the SediGraph 5120. 

1. Select File > Open > Sample Information to display the Open Sample Information 
File dialog. 

2. Select a sample on which to overlay graphs of other samples, then click Open; the 
Sample Information dialog is displayed.

The sample file presentation must be in the Advanced format to generate 
overlays.
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3. Click the Report Options tab to display the Report Options dialog.

4. Choose the desired graph and click Edit; a graph options dialog like the following is 
displayed. 

5. Click on the down arrow at the Overlay field and choose Samples, then click OK to 
close the dialog.

Choose Samples 
from the drop-down 
list.
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6. On the Report options dialog, click Overlays; the Graph Overlay Samples dialog is 
displayed.

7. Click Browse to the right of the Sample 1 field; the Plot Overlay Sample Selection 
dialog is displayed.

8. Choose a sample file, then click OK. You may choose up to eight files in this manner.

9. After selecting the desired number of sample files, click OK to return to the main 
Report Options dialog.

10. Make any other selections desired.

11. Click Save if you wish to save your Selected Reports list. Even if you don’t save, all 
of the options regarding overlays and anything else are available as your reports are 
generated. 

12. Select Reports > Start Report; the Start Report screen is displayed with the name of 
your primary file highlighted and in the File name field. 

13. Click OK; the Selected Reports dialog is displayed. 

14. Ensure that the desired graph is selected (preceded with a check mark), then click 
OK.
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Multiple Graphs Overlay

This option enables you to overlay two types of graphs from the same file.

1. Select File > Open > Sample Information to display the Open Sample Information 
File dialog.

2. Select the desired file, then click Open; the Sample Information dialog is displayed.

3. Click the Report Options tab to display the Report Options dialog (shown on page
3-45).

4. Choose the desired graph and click Edit; a graph options dialog like the following is 
displayed. 

5. Click on the down arrow at the Overlay field and choose Plot, the Edit push button 
adjacent to the Overlay field is enabled.

Choose Plot from 
the drop-down list.
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6. Click Edit; the Overlay Settings dialog enabling you to specify the plot (and options) 
to overlay is displayed.

7. Make your selections and click Ok to return to the graph options dialog, then OK 
again to return to the Report Options dialog. 

8. Make any other selections if desired.

9. Click Save to save your Selected Reports list. Even if you don’t save, all of the 
options regarding overlays and anything else are available as your reports are run. 

10. Select Reports > Start Report; the Start Report screen is displayed with the name of 
your primary file highlighted and in the File name field. 

11. Click OK; the Selected Reports dialog is displayed. 

12. Ensure that the desired graph is selected (preceded with a check mark), then click 
OK.
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Multiple Tests Overlay

This option enables you to overlay all tests of the same file.

1. Select File > Open > Sample Information to display the Open Sample Information 
File dialog.

2. Select the desired file, then click Open; the Sample Information dialog is displayed.

3. Click the Report Options tab to display the Report Options dialog (shown on page
 3-45).

4. Choose the desired graph and click Edit; a graph options dialog like the following is 
displayed. 

5. Click on the down arrow at the Overlay field and choose Tests, then click OK to 
return to the Report Options dialog. 

6. Make any other selections desired. 

7. Click Save to save your Selected Reports list. Even if you don’t save, all of the 
options regarding overlays and anything else are available as your reports are run. 

8. Select Reports > Start Report; the Start Report screen is displayed with the name of 
your primary file highlighted and in the File name field. 

9. Click OK; the Selected Reports dialog is displayed. 

10. Ensure that the desired graph is selected (preceded with a check mark), then click 
OK.

Choose Tests from 
the drop-down list.
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4.  SOFTWARE AND SETUP MODIFICATIONS

This chapter provides instructions for:

• Installing the software, beginning on this page
• Using the Setup Program for Other Functions, page 4-6

You can also install the Elzone program for offline data manipulation on a computer other 
than the one controlling the analyzer. This allows you to:

• create or edit sample and parameter files
• generate reports on completed sample files

Review the Micromeritics PROGRAM License Agreement for restrictions on the use of 
another copy of the analysis program.

Installing the Software

Be sure you have completed the following tasks before installing the software for the first 
time.

• Connect the analyzer to the configured port and turn the analyzer on. 

Install the program as follows:

1. Select Start > Run from the Windows menu bar. 

2. Enter the name of the drive designator, followed by analyzersetup. 

For example: e:analyzersetup.

If installing multiple analyzers, connect the ethernet switch to the configured port and 
the analyzers to the ethernet switch (refer to Ethernet Switch, page 4-9); turn the 
analyzers on.
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3. Click OK; the Ethernet Introduction dialog is displayed. This screen outlines the steps 
that should be completed before installing the software.

If all of the steps have not been completed, click Cancel and perform the steps; then 
restart the installation program. Do not proceed with installation until these tasks have 
been completed.

4. Click OK; the New Installation dialog is displayed.

The Destination Folder group box displays the amount of current disk space required for 
the analysis program, and the directory into which the application will be installed. If you 
prefer a different directory for installation, click Browse to select the desired directory.
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5. Select the check box just below the Destination Folder group box to add an icon to your 
desktop; this enables quick access to the analysis program.

6. The icon is added to the Micromeritics folder by default. If you prefer a different folder, 
enter or select one from the drop-down list.

7. The Install this application for All Users check box enables you to allow or prohibit 
users other than the installer to access the application.

• Select the check box to allow access for all users logged onto Windows.
• Deselect the check box to allow access for only the user installing the application.

8. Click Next; the Analyzer configuration dialog is displayed.

The application should not be installed on a network drive with shared access. 
Multiple users cannot operate the application at the same time.
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a. In the Step 1 group box:

b. In the Step 2 group box, enter the serial number(s) for the analyzer(s) you are 
attaching to this computer.

9. Click Next; the Ethernet Ports dialog is displayed.

10. Choose one of the following:

If .... Then ....

you are installing the 
analysis program at 
initial installation:

select the number of analyzers you are installing.

you plan to use the 
analysis program for 
offline data reduction:

select 0

you are moving an 
analyzer from another 
computer to this one:

select 0 (Refer to Moving an Analyzer from One Com-
puter to Another Computer, page 4-11.)

If .... Then ....

the port you configured 
is listed:

select the port and proceed to the next step.

the port you plan to use 
has been configured but 
is not listed:

Click Specify, the Specify Ethernet Port dialog is displayed.

Enter the remaining portion of the IP address in the enabled 
fields, then proceed to the next step.
4-4                                                    539-42820-01 (Rev A) - Sep 2017  



Installing the Software Elzone II 5390
11. Click Next; the calibration files are installed.

If you are installing more than one analyzer, the Calibration File Installation dialog 
instructing you how to proceed with installation of other calibration files is displayed. 
Read the instructions carefully; they are restated here.

a. Remove this setup CD.

b. Insert the CD containing the files for the analyzer serial number requested. 

IMPORTANT: To prevent the CD from AutoPlay, hold down the Shift key before 
you close the CD door. Do not release the Shift key until the CD light stops blinking. 

c. When the CD lights ceases to blink, click Next. After the calibration files are installed, 
you will be prompted to reinsert the original setup CD.

The application software is installed after installation of all calibration files.

12. The Installation Complete dialog containing the Readme file will display when 
installation is complete. This dialog may also contain other important notices. After 
reading the information contained in this dialog, click Finish to close it. 

13. Choose one:

If .... Then ....

you are installing the analysis 
program using the installation 
video:

Return to the Installation Instructions menu and con-
tinue with the next procedure. 

you are installing the analysis 
program independent of the 
installation video and have no 
other operations to perform:

Remove the program CD and store in a secure loca-
tion. The original program CD contains calibration 
files specific to your instrument. Upgrade CDs do not 
contain calibration files. Therefore, it is important that 
you maintain your original program CD in a secure 
location in the event calibration files need to be 
reinstalled.
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Using the Setup Program for Other Functions

After initial installation of the Elzone analysis program, the application setup program can be 
used to:

• install software upgrades, page 4-8
• add an analyzer, page 4-9
• move an analyzer from one computer to another computer, page 4-11
• change the analyzer setup (port configuration), page 4-17
• remove an analyzer from the computer, page 4-16
• reinstall calibration files, page 4-19
• uninstall the analysis program, page 4-20

To start the application setup program:

1. Ensure that the analysis program is not operating and the analyzer is idle.

2. Insert the program CD into your CD-ROM drive.

3. Hold down the Shift key and close the CD door; this prevents start-up of the installation 
video.

Wait until the CD light ceases to blink before performing the next step.

4. Select Start from the Status bar, then Run from the start menu.

5. Enter the drive designator of the CD-ROM drive, followed by setup. For example:


e:setup

Alternatively, you can click Browse, navigate to the CD-ROM drive, and select 
setup.exe.

6. Click OK; the setup Welcome screen showing the options available is displayed.

Options 
available for 
the Elzone 
program are 
enabled.
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7. Select the operation you wish to perform. Procedures for performing each operation are 
in subsequent sections.

After the requested operation is completed, the setup Welcome screen is again displayed. 
A confirmation message indicating completion of the operation is shown in the lower 
section of the dialog.

8. After you have completed all desired operations, click Exit to close the dialog.

9. Remove the CD and store in a secure location.

Indicates status 
of last operation 
performed.
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Installing Subsequent Software Versions

When you install a software upgrade, the system installs all of the application files and any 
status files that do not already exist on the computer. Existing analyzer status files are not 
affected and default and data files are not overwritten. There are three types of subsequent 
installation; the software version controlled by the setup program is:

• a later version than the version installed on the computer
• the same version as the version installed on the computer
• an earlier version than the version installed on the computer

The setup program automatically detects which type of installation applies and customizes the 
selection in the Setup dialog accordingly.

1. Start the Setup program (refer to Using the Setup Program for Other Functions, page 
4-6). 

2. Choose the software option; remember, only the applicable option will display:

• Upgrade software to version (number) from version (number)
• Reinstall software version (number)
• Downgrade software to version (number) from version (number)

3. Click Start File Installation; the application installs the software and displays the setup 
Welcome dialog. If no other operations are desired using this dialog, click Exit to close 
the dialog.
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Adding an Analyzer

An ethernet switch is required when connecting multiple analyzers. After connecting the eth-
ernet switch, continue with the software section.

Ethernet Switch

An Ethernet switch with a straight-through cable is required when installing multiple 
analyzers.

1. Connect the power cord of the Ethernet switch to an appropriate power outlet.

2. Disconnect the ethernet cable of the current analyzer from the computer; do not 
disconnect it from the analyzer.

3. Connect one end of the straight-through cable to the Ethernet switch and the other end to 
the computer.

4. Connect the ethernet cable of the current analyzer to a numbered port on the Ethernet 
switch (do not use the uplink port).

5. Connect one end of the Ethernet cable (for the analyzer you are adding) to the connector 
labeled Ethernet on the rear panel of the analyzer and the other end to a numbered port 
on the Ethernet switch. Repeat this step for each analyzer you are adding.

The finished configuration should look like the following illustration.

6. Turn on the analyzer that was added. Also ensure that the computer and current analyzer 
are on.

Ethernet switch Be sure cables are not 
connected to the uplink port.
539-42820-01 (Rev A) - Sep 2017                                                    4-9 



Elzone II 5390 Using the Setup Program for Other Functions
Software

1. Insert the analysis program CD for the analyzer you are adding into the CD-ROM drive.

2. Start the Setup program (refer to Using the Setup Program for Other Functions, page 
4-6). 

3. Select Add an analyzer, then click Next; the Set up analyzer being added dialog is 
displayed.

4. Enter the serial number of the analyzer being added.

5. Click Next; the calibration files are installed and the Welcome screen is displayed.

You may see the Ethernet Introduction screen. This information is not applicable since 
you are connecting to an ethernet switch which is connected to a port that has been 
configured. Click OK to close the screen and proceed.
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Moving an Analyzer from One Computer to Another Computer

Use the instructions in this section to move a configured analyzer (along with its status, cal-
ibration, and log file) from one computer (Source PC) to a different computer (Destination 
PC). This operation does not move sample or parameter files. Use a file management pro-
gram such as Explorer or a backup/restore utility to move this type of files.

Moving a Configured Analyzer to a New Computer

This section provides steps for moving a configured analyzer to a computer that does not 
have an analyzer installed.

1. Install the analysis program on the destination computer (refer Installing the Software, 
page 4-1). Be sure to select 0 as the number of instruments; all related instrument 
information will be transferred in the Move operation.

2. Start the application setup program on the source computer (refer to Using the Setup 
Program for Other Functions, page 4-6).

3. Select Move an analyzer from one PC to another PC, then click Next; the Move 
analyzer operation dialog is displayed.

If the analysis program is already installed on the destination computer, begin with 
Step 2.
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4. Select Source PC, then click Next; the following dialog is displayed.

5. From the drop-down list in the Step 1 group box, select the analyzer that is to be moved 
from this computer.

6. In the Step 2 group box, click Browse to select a location for storing the status, 
calibration, and log files associated with the source computer. If possible, the location 
should be a shared network drive. If this is not possible, select a local folder and then use 
a transfer utility to copy its contents from the Source PC to the Destination PC.

7. Click Finish; the files are copied to the specified location and the setup Welcome screen 
is displayed.

8. Start the Setup program on the destination computer.

9. Select Move an analyzer from one PC to another PC; the Move analyzer operation 
dialog is displayed (shown on previous page).

Sample and parameter files are not copied and moved with the analyzer. Use  a file 
management program such as Explorer or a backup/restore utility to move these 
files.
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10. Select Destination PC, then click Next; the Ethernet Introduction screen is displayed. 
This screen outlines the steps that should be completed to configure the ethernet port to 
which the analyzer is connected to on the computer.

If these tasks have not been completed, click Cancel and complete them; then restart the 
setup program. Do not proceed until the ethernet port in the computer has been 
configured.

11. Click OK; the Move analyzer information dialog to this PC dialog is displayed.

12. In the Step 1 group box, enter the serial number of the unit you are moving to this 
computer.

13. In the Step 2 group box, click Browse to choose the location of the files that were stored 
previously from the Source computer.
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14. Click Next; the files are transferred and the Ethernet Ports dialog is displayed.

Select the desired ethernet port.

15. Click Next; the setup Welcome screen is displayed. Click Exit to close the dialog.

16. Turn on the analyzer and start the analysis program.
4-14                                                    539-42820-01 (Rev A) - Sep 2017  



Using the Setup Program for Other Functions Elzone II 5390
Moving a Configured Analyzer to a Computer with an Existing Analyzer

This section provides steps for moving a configured analyzer to a computer that already has 
the analysis program and a configured analyzer installed, this being the second analyzer. 
When installing two analyzers on one computer, additional hardware is required. Refer to 
Adding an Analyzer, page 4-9. 

1. Perform Steps 2 through 7 (steps for Source computer) of the procedure Moving an 
Analyzer from One Computer to Another Computer, page 4-11.

2. Disconnect the Ethernet cable of the analyzer from the Source computer (or Ethernet 
switch). Reconnect the cable to the Ethernet switch for the Destination computer. You 
must use a switch when attaching multiple analyzers. Refer to Ethernet Switch, page 4-9 
for configuring ethernet connections using a switch.

3. After ethernet connections have been established, return to page 4-12 and begin with Step 
8 (steps for Destination computer). You will not see the Ethernet Ports dialog (Step 13) 
since an ethernet port has already been assigned.

4. Turn on both analyzers and start the analysis program.
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Removing an Analyzer

You can remove an analyzer from the computer as follows. When you remove an analyzer, 
the status files are removed as well.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 
4-6.

2. Select Remove an analyzer, then click Next; the Remove an analyzer dialog is 
displayed.

3. From the drop-down list, choose the serial number of the analyzer you wish to remove.

4. Click Remove; the analyzer is removed and the Welcome screen is displayed.

This operation removes the selected instrument from the list of attached instruments. 
It does not remove calibration and status files associated with the analyzer, nor does it 
remove sample and parameter data files.
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Changing the Analyzer Setup Configuration

This option allows you to change the ethernet port being used by the analyzer. For example if 
the current ethernet port malfunctions, you would use this option to move the analyzer to 
another ethernet port.

Be sure that the ethernet port you are switching to has been configured and the firewall set-
ting between the computer and the analyzer is turned off. 

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 
4-6.

2. From the Setup dialog, select Change analyzer setup, then click Next; the Ethernet 
Introduction screen is displayed. This screen outlines the steps that should be completed to 
configure the ethernet port to which the analyzer will be connected.

If these tasks have not been completed, click Cancel and complete them; then restart the 
setup program. Do not proceed until the ethernet port in the computer has been 
configured.
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3. Click OK; the Ethernet Ports dialog is displayed.

4. Choose one of the following:

5. Click Next; the change is completed and the Welcome screen is displayed.

If.... Then....

the port you plan to 
use is listed:

select the port and proceed to the next step.

the port you plan to 
use has been config-
ured but is not listed:

Click Specify, the Specify Ethernet Port dialog is 
displayed.

Enter the remaining portion of the IP address in the 
enabled fields, then proceed to the next step.
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Reinstalling Calibration Files

Calibration files specific to the analyzer are contained on the original program CD; they are 
not contained on an update CD. It is important that you store your original program CD in a 
safe location. CDs containing calibration files will always end with a suffix of 99. Update 
CDs end with a suffix of 00.

Reinstall calibration files as follows:

1. Using the CD containing the appropriate calibration files, start the Setup program. Refer 
to Using the Setup Program for Other Functions, page 4-6.

2. Select Re-install calibration files for an analyzer, then click Next: 

If.... Then....

you have only one 
analyzer installed

the calibration files are installed and the Welcome screen 
is displayed.

you have multiple ana-
lyzers installed, a 
dialog enabling you to 
choose the desired 
analyzer is displayed.

select the appropriate analyzer, then click Next; the cali-
bration files are installed and the Welcome screen is 
displayed.
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Uninstalling the Analysis Program

You can remove the Elzone analysis program as follows. When you perform this operation, 
the application removes the analysis program, status files, analyzer setup files, and resulting 
empty directories. It does not remove data files.

1. Start the Setup program. Refer to Using the Setup Program for Other Functions, page 
4-6.

2. Select Uninstall, then click  Next; the Uninstall dialog is displayed.

3. Click Uninstall; the Select Uninstall Method dialog is displayed.
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4. Choose one of the following:

• Automatic: click Next; the system uninstalls the Elzone software automatically and 
the setup Welcome dialog redisplays.

• Custom: click Next; a series of dialogs is displayed, allowing you to choose the files 
you wish to uninstall. After all files are selected and uninstalled, the setup Welcome 
dialog redisplays.
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5.  FILE MENU

The File menu contains options that allow you to manage sample and parameter files.

Description

Listed below are brief descriptions of the File menu options. Detailed descriptions follow 
this section.

Open Opens an existing sample or parameter file, or enables 
you to create a new one. Page 5-3.

Save Saves the file in the active window. Page 5-46.

Save As Allows you to save the file that is in the active window 
under a different name. It also can be used to save a sub-
set of a sample file as an independent parameter file. 
Page 5-46.

Save All Saves all open files. Page 5-46.

Close Closes the file in the active window. Page 5-47.

Close All Closes all open files. Page 5-47.
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Print Prints details of the selected file(s). Page 5-48.

List Generates a list of certain information for the selected 
sample file(s) or parameter file(s). Page 5-49.

Export Exports a sample file in ASCII format. Page 5-51.

Convert Enables you to convert data from a text file or from an 
earlier version of the Elzone program to a format compat-
ible with the Elzone 5390 program. Page 5-53.

Blend Enables you to blend (combine) data from multiple sam-
ple files. Page 5-55.

Average Enables you to obtain an average for data in multiple 
sample files. Page 5-57.

Exit Exits the Elzone 5390 program. Page 5-58.
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Open

Select Open to create a new sample or parameter file, or to open and edit or view 
parameters of an existing one. Regardless of which file type you select, a dialog similar to 
the one shown below is displayed. 

File name For sample information files, this field contains the next 
sequenced file name generated by the system. 

For parameter files (analysis conditions, material proper-
ties, and report options), the file name displayed includes 
the wild card (*) and the default extension as follows:

*.ANC for analysis conditions
*.RPO for report options
*.MTP for material properties

If you are creating a new file, enter a name in the File 
name field. You can use up to eight characters. 

If you plan to edit an existing file, select a file from the 
list.

Status This drop-down list allows you to choose the types of 
sample files to display in the Files window. Refer to 
Table 2-2. File Status and Description, page 2-11 for a 
description of the files in this list.

This list does not display when opening parameter files. 

Displays the type of 
file you are opening 
or creating.

Does not display 
when opening 
parameter files.
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Sample Information

Sample Information files contain information used to control the analysis, as well as 
collected data. A sample information file consists of:

• Sample information
• Analysis conditions
• Material properties
• Report options
• Entered or Collected (appears after analysis is complete) data 

Portions of the sample file can also exist as independent parameter files. These parameter 
files contain frequently used analysis conditions, material properties, and report options 
that can be conveniently loaded into a new sample information file.

Sample information files are presented in three different formats; Advanced, Basic, and 
Restricted. You can select any one of these formats as your default. A convenient toggle 
button makes it easy to switch between Basic and Advanced formats, regardless of which 
is selected as your default. The Restricted format does not allow switching to any other 
format.

• Advanced Format 
Presents all parts of the sample information file as a group of dialog boxes with 
index card-type tabs (a Collected Data tab appears after analysis). Clicking on each 
tab opens the associated dialog. Use this format to create customized sample infor-
mation files. 

• Basic Format 
Presents the entire sample information file in a single dialog box. Basic format 
makes it easy to select previously created parameter files from convenient drop-
down lists.

• Restricted Format 
Restricted format is identical to the Basic format, except that you cannot switch to 
the Advanced presentation. The Restricted format prevents changes to file parame-
ters. 

Select Options > Option Presentation to specify your default format. 

Date Range Displays the Select Dates dialog enabling you to specify 
a date range for which to display files. Refer to page 2-
10 for an explanation of this dialog.

Files This window displays the files available in the selected 
directory for the chosen status within the selected date 
range.
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Advanced Presentation

The Advanced format displays the sample information file in a manner similar to that of 
an index card file. Each parameter has its own tab and is accessed by clicking the tab. Or, 
you can use Next and Prev to move through the dialogs. This format allows you to cus-
tomize sample information files. 

Sample Contains the description of the current sample file.

If this is a new file, this field contains the description 
you specified in Sample Defaults (refer to Sample 
Defaults, page 8-6). You can enter a new description or 
add to the existing one if desired.

Range: 50 alphanumeric characters

Operator
Submitter

Displays the Operator and Submitter names (if specified) 
of the current sample file.

If this is a new file, these fields contain the names 
specified in Sample defaults. You can enter a different 
name in either (or both) field if desired. You can also 
edit the prompts for these fields or choose to have them 
omitted entirely (refer to Sample Defaults, page 8-6).

Range: 40 characters

A Collected Data tab 
displays here when 
analysis is complete.

An Entered Data tab 
displays if you choose 
Manually entered 
allowing you to enter 
the data.
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Bar Code This field enables you to enter bar code information. If 
bar code information is not used, you can use this field 
to enter additional information about the sample; for 
example, you may wish to enter the lot number of your 
sample.

This field will also accept data from a bar code reader.

Range: 40 characters

You can edit this prompt to display as a different label if 
desired, or you can omit it entirely from the sample file 
editor (refer to Sample Defaults, page 8-6).

Type of Data Indicates the type of data in the current sample file.

If this is a new file, choose the type of data you wish to 
have in this file. You can have data collected automati-
cally, manually enter data, or collect data for a 
background.

If you choose Manually entered, an “Entered” tab is 
added so that you may enter the desired data. You cannot 
enter data if you are creating the file on a computer that 
is not attached to the analyzer. 

If you choose Background, be sure to select full resolu-
tion data using the Data Setup push button on the 
Analysis Conditions dialog. 

User Parameters These fields are used primarily for SPC (Statistical Pro-
cess Control) reporting. However, they can be used for 
other data as well. You may wish to enter specific anal-
ysis conditions or sample criteria such as the weight. 
These parameters will print on the Summary section of 
the Combined report. Select Options > Sample Defaults 
to specify the parameters you wish to report. The param-
eter(s) you specify replace the User Parameter label(s) 
displayed here.

If desired, you can have these fields omitted from the 
sample information file (refer to Sample Defaults, page 
8-6).
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The Analysis Conditions, Material Properties, and Report Options tabs of the 
Advanced presentation sample information file are described in subsequent sections.

Dilution Factor Enables you to enter the ratio of sample volume to elec-
trolyte volume. This value can be easily determined using 
the following formula:

Mass Concentration Enter the mass per unit volume (in grams per mL) for the 
sample you are analyzing. 

Comments Use this field to enter any comments about the sample or 
the analysis conditions that you wish to note. Comments 
entered here are printed in the header of some reports.

Range: Up to 500 alphanumeric characters

Add Log Entry Displays a dialog allowing you to enter pertinent infor-
mation relating to the sample and/or analysis. Any infor-
mation you enter here is printed as part of the Sample 
Log report (select in Report Options).

Replace All This push button allows you to replace the values for all 
parameters of the current file with the values from an 
existing file. Simply click the push button, choose the 
desired file, and click OK. The values of the chosen file 
are copied into the current file; you can edit them as 
desired.

Save Saves the current file.

Close Closes the current file. If the file contains unsaved 
values, you are prompted to save before closing.

Basic Switches the presentation format to the Basic 
presentation. 

DF
sample volume  electrolyte volume+

sample volume
----------------------------------------------------------------------------------------------------=
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Basic Presentation

The Basic format displays all parameters of the sample information file on a single 
dialog. With the Basic format, you can quickly create a sample information file using 
predefined parameter files from the drop-down lists. 

Sample Contains the description of the current sample file.

If this is a new file, this field contains the description 
you specified in Sample Defaults. You can enter a new 
description or add to the existing one if desired.

Range: 50 alphanumeric characters

Replace All This push button allows you to replace the values for all 
parameters of the current file with the values from an 
existing file. Simply click the push button, choose the 
desired file, and click OK. The values of the chosen file 
are copied into the current file; you can edit them as 
desired.
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Analysis Conditions Displays the name of the current Analysis Conditions 
file.

If this is a new file, this field contains the name of the 
file you specified as the default. Click the down arrow to 
the right of the field to choose a different file. This list 
includes Analysis Conditions files supplied with the 
analysis program and any you may have created and 
saved to the Parameter Files directory (refer to 
Parameter Files Directory, page 8-15 for details). If 
new files are not saved to the specified Parameter 
directory, they are not included in the list.

This list is disabled for files which have been used for an 
analysis.

Orifice Tube Displays the orifice tube specified in the Analysis Condi-
tions file.

Material Properties Displays the name of the current Material Properties file.

If this is a new file, this field contains the Material 
Properties file you specified as the default. Click the 
down arrow to the right of the field to choose a different 
file. This list includes Material Properties files supplied 
with the analysis program and any you may have created 
and saved to the Parameter Files directory (refer to 
Parameter Files Directory, page 8-15 for details).

Report Options Displays the name of the current Report Options file.

If this is a new file, this field contains the Report options 
file you specified as the default. Click the down arrow to 
the right of the field to choose a different file. This list 
includes Report Options files supplied with the analysis 
program and any you may have created and saved to the 
Parameter Files directory (refer to Parameter Files 
Directory, page 8-15 for details). 

Reports to Generate Displays a list of available reports. The checked reports 
are the ones requested for the current Report options file.

If this is a new file, the checked reports are the ones you 
specified for the default(s). You can select (or deselect) 
reports by double-clicking on the desired report. Alterna-
tively, you can highlight the report and press the 
Spacebar.
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Number of tests Enables you to enter the number of tests you wish to 
perform using this file. You can perform up to eight tests 
with each file.

Background Select this option to have background data collected. Be 
sure to select Full resolution using the Data Setup push 
button on the Analysis Conditions dialog when 
collecting background data.

Stirrer Speed Allows you to specify a stirrer speed. 

The speed ranges from 1 to 10 with 1 being the lowest; 0 
(zero) turns the stirrer off.

Stirrer Direction Enables you to specify a direction for particle 
circulation. 

Up rotates the stirrer in a direction that pushes the 
particles upward. Down rotates the stirrer in the opposite 
direction, pushing the particles downward. 

This option is not applicable if you have a hydropulser 
installed on the Elzone analyzer.

Dilution Factor Enables you to enter the ratio of sample volume to elec-
trolyte volume. This value can be easily determined using 
the following formula:

Mass Concentration Enter the mass for the sample you are analyzing.

DF
sample volume  electrolyte volume+

sample volume
----------------------------------------------------------------------------------------------------=
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Rinse Select this option to have internal plumbing and the 
inside of the orifice tube rinsed; all options in this group 
box are enabled. 

Use the times field to enter the number of rinses desired. 
Then choose when the rinse(s) is(are) to be performed; 
you can rinse before or after the analysis.

From the two options on the right side of the group box, 
choose the type of rinse desired. Drain and fill com-
pletely drains the system, then refills it. Flush simply 
flushes concentration through the system, maintaining 
liquid in the system at all times.

Select Purge Volumetric Pump to have the volumetric 
pump (if installed) purged during the rinsing process.

Save Saves the current file.

Close Closes the current file. If the file contains unsaved 
values, you are prompted to save before closing.

Advanced Switches the presentation format to the Advanced 
presentation. 
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Restricted Presentation

A third format is provided to control access to some portions of the sample information 
file. The Restricted format displays in the same manner as the Basic presentation format.

The fields on this dialog are identical to the ones on the Basic Information dialog except 
that this dialog does not contain an Advanced push button allowing you to switch to the 
Advanced format. This format is also password-protected, preventing the operator from 
making changes to analysis conditions, materials properties, and report options sets. 
Refer to Restricted, page 8-5 for additional information on the Restricted format.

Restricted presentation is ideal for laboratories in which standard analysis procedures are 
established by a lab manager, while one or more lab technicians actually perform the 
analyses. The lab manager can create independent analysis conditions, materials 
properties, and report options files containing standard sets of operating conditions, then 
the operator(s) can use Restricted mode for daily operations, selecting the standard 
parameter files from the drop-down lists.

This format displays in the 
same manner as the Basic 
format; however, it does not 
allow you to switch to the 
Advanced format.
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Analysis Conditions

Analysis conditions files specify each step of the analysis. You can create an Analysis 
Conditions file as an independent parameter file or as part of a sample information file. 
You can also save the analysis conditions portion of a sample information file as an 
analysis conditions file.

Analysis Conditions If you are opening an existing analysis conditions file, 
this field contains the description.

If you are creating an analysis conditions file, this field 
contains the description specified in Sample Defaults. 
You can enter a new description or add to the existing 
one if desired. Use a description that will help you 
identify this set of analysis conditions in the future.

You can use up to 40 alphanumeric characters.

Replace Allows you to replace the values in the current file with 
those from an existing file. Simply click the push button, 
choose the desired file, and click OK. The values of the 
chosen file are copied into the current file; you can edit 
them as desired.
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Orifice Tube This drop-down list contains existing orifice tubes. If the 
orifice tube has not been calibrated, its name 
(description) is preceded with an asterisk (*). The 
diameter of the selected orifice tube is displayed 
adjacent to the Orifice Tube field.

You must select an appropriate, calibrated orifice tube 
before you perform your analysis.

Add Orifice Displays the Add Orifice Tube dialog so that you can 
add an orifice tube to the drop-down list.

You can enter up to 20 characters for the identification. 

Delete Orifice Deletes the orifice tube currently displayed in the 
Orifice Tube field; a confirmation dialog is displayed 
before the tube is deleted from the list. 

Particle Size Range These options enable you to specify a diameter range or 
specify instrument settings.

Specify Diameter 
range

Enables you to specify a range for the size of particles to 
be read. You should stay within 2% to 70% of the orifice 
diameter and should not exceed a 30:1 ratio.

When you choose this option, the instrument settings are 
automatically set by the software. Most Elzone users 
choose this option.

Use instrument 
settings

Enables you to specify settings for the instrument. This 
option is used by a more advanced user. This option can 
also be used if you have a sample file used in an analysis 
and which contains appropriate settings.

Settings Displays the Signal Settings dialog allowing you to 
define signal settings for analysis conditions.
5-14 539-42820-01 (Rev A) - Sep 2017



Open Elzone II 5390
If you choose Specify Diameter range on the Analysis 
Conditions dialog, the fields on this dialog are disabled 
and display the settings automatically set by the 
software. If you feel the settings are inappropriate, you 
can select Use instrument settings and edit the values 
as required.

Use instrument settings This option enables you to specify instrument settings 
and should be used only by a more advanced Elzone 
user.

Current
Gain

Adjust these values to determine the size of particles to 
be read. Increase the settings to include smaller particles; 
decrease them for larger particles.

Low Threshold Enabled when you deselect Keep size range constant, 
allowing you to enter a value for the threshold.

The threshold is the lower limit of the size distribution. 
The lowest optimum threshold is determined 
automatically by the software. 

Load Resistor Enabled when you deselect Keep size range constant, 
allowing you to choose a different value for the load 
resistor. 

This function helps to reduce the noise level for high- or 
low-conductive electrolytes. Typically, a larger load 
resistor corresponds to smaller orifices.
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Keep size range 
constant

If this option is selected, you can adjust the current and 
gain only. Each time you edit one, the other is 
automatically adjusted to keep the range constant for the 
selected ratio.

If you deselect this option, the Low Threshold and 
Load Resistor fields, and the options in the Measured 
Particle Scale group box are enabled.

Measure conductivity 
before each test

Select this option to have the conductivity measured 
before each test specified in the file. 

If you deselect this option, the last conductivity recorded 
for the current orifice tube and liquid will be used.

Measured Particle 
Scale

Provides options for a linear or logarithmic scale. If you 
choose Logarithmic, the Particle Diameter ratio field 
is enabled, allowing you to choose a ratio (largest 
particle to the smallest particle) from the drop-down list.

Electrode 
Connections

Enables you to choose a normal or reversed connection. 

Normal transmits the electric current from the inside of 
the orifice tube to the outside.

Reversed transmits the electric current from the outside 
of the orifice tube to the inside.

Rinse Select this option to have rinse(s) performed; all options 
in this group box are enabled.

Use the times field to enter the number of rinses desired. 
Then choose when the rinse(s) is(are) to be performed; 
you can rinse before or after the analysis.

From the two options on the right side of the group box, 
choose the type of rinse desired. Drain and fill com-
pletely drains the system, then refills it. Flush simply 
flushes concentration through the system, maintaining 
liquid in the system at all times.

Select Purge Volumetric Pump to have the volumetric 
pump (if installed) purged during the rinsing process.

Number of tests Enables you to enter the number of tests you plan to 
perform using the current file; you can perform up to 
eight tests with each file.
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Stirrer Speed Allows you to specify a stirrer speed (or pulse rate). The 
lower the number, the lower the speed; 0 (zero) turns the 
stirrer (or hydropulser) off.

Stirrer Direction Enables you to choose a direction for particle circulation.

Up rotates the stirrer in a direction that pushes the 
particles upward. Down rotates the stirrer in the opposite 
direction, pushing the particles downward. 

This option is not applicable if you have a hydropulser 
installed on the Elzone analyzer.

Flow Control Displays the Flow Control dialog allowing you to 
specify the flow rate of the analysis liquid and to choose 
a blockage detection method. 

Flow Control Choose the type of flow control desired; then enter a 
value in the adjacent field. 

Differential Pressure is the default and typically is used 
for collecting sizing data. This is the method used on the 
Elzone 5380 series analyzers.

Differential flow rate typically is used for concentration 
and sizing analyses in which a known volume of liquid 
is measured.

Volumetric Flow Rate is used for the same type of 
analyses as Differential Flow Rate; however, data 
typically are a little more accurate. This option is not 
available if you do not have the volumetric pump 
installed.
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Blockage You can choose to have blockages detected and cleared 
during analysis (default) and/or just at the start of the 
analysis.

Pump and fan off during 
data collection

Turns the pump and fan off during data collection. You 
may wish to use this option for extremely noise-sensitive 
applications, such as when using a small orifice tube (19 
or 30 m) with low conductivity electrolytes.

Data Setup Displays the Data Setup dialog enabling you to specify 
how raw data are to be produced. 

After analysis is complete, the parameters for data setup 
can be edited by clicking Data Setup on the Collected 
Data dialog, explained on page 5-42.
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Calibration Displays the date and time for the type of calibration 
selected. Click Change to choose a different type of 
calibration; the Calibration Type dialog is displayed. 

Reference material measurement
Uses data from a reference material measurement.

Mass integration measurement
Before the analysis, displays Measured; after analysis, it 
will display the date and time of the analysis that was 
used for the measurement.

Entered calibration factor
Enter the desired calibration factor. The following table 
provides the nominal Kd values for Elzone orifice tubes.

Nominal Kd values for Elzone Orifice Tubes

Orifice Size Kd

19 33
30 42
48 60
76 93
95 120
150 185
190 250
300 448
380 582

Calibration copied from sample
Uses calibration data from a completed sample file that 
used the same orifice tube; the Browse push button is 
enabled allowing you to choose the file.
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Correct for 
Coincidence

Select this option to have coincidence correction applied.

It is always possible that two or more particles may pass 
through the orifice at the same time; this is known as 
coincidence. Coincidences cause a portion of the true 
distribution to be absent and a distorted distribution of 
oversize, spurious particles. The coincidence correction 
removes distortion from the distribution and restores the 
missing pulses.

Subtract Background This option enables you to subtract any particles that 
may have been detected in the background measurement.

When you select this option, be sure to click Browse 
and choose a background file or select Use most recent 
background. If you choose a background file that 
contains numerous tests, the test that is selected from the 
Test drop-down list on the Report Options dialog is the 
one that will be used for the background subtraction.

If you neglect to choose a background, you will be 
warned at the time of analysis and given another 
opportunity to select a background. If a background is 
still not selected, a “null” background will be used for 
data reduction.

The type of background subtraction you use will be 
printed in the report header. 

Use most recent 
background

Select this option to use the most recent background.

If you wish to use a different background file, deselect 
this option and use the Browse push button to choose 
the file containing the desired background.

Size Classes The options in this group box enable you to specify how 
distribution data are binned (sorted).

You can choose to report data as linear or logarithmic 
by diameter or volume. 

Use the classes field to specify the number of bins 
desired, and the range fields to enter a range.

Distribution Enables you to choose the manner in which data are 
presented. Choose one in each column.
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Smoothing Select Smooth Data to reduce data scattering.

Use the Groups of drop-down list to choose the number 
of size classes to be included.

The smoothing process defaults to 1; however, you can 
have it repeated by choosing 2 from the Repetitions 
drop-down list.

Data Format Enables you to choose the type of data format you wish 
to store in the sample file. These choices affect the size 
of the sample file.

Full resolution
This option saves and stores full-resolution data. Be sure 
to select this option if you plan to generate pulse length 
reports or if you are collecting background data.

Reduced
This option saves only the binned data; high-resolution 
data are lost. The size of the file is reduced but you 
cannot edit any data setup parameters (collected data 
dialog) other that distribution and smoothing.

Store pulse length vs. particle size data
Select this option to have pulse length and particle size 
data collected and stored for the Pulse length vs. particle 
size data report. If this option is not selected, you will be 
unable to generate the report.

Extrapolation Use this feature to complete data below the ending point 
when data does not return to zero on the y-axis; missing 
points will be calculated automatically.

You can also have data extrapolated after the analysis 
(see Collected Data, page 5-42).

Ending Conditions 
group box

Choose one of these options to specify when to end the 
analysis.

Time Analysis ends when the specified time interval expires.

Volume Analysis ends when the specified liquid volume is 
reached.
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Total count Analysis ends when the specified number of particles 
over the entire range is reached.

Modal count Analysis ends when the specified number for the particle 
size is reached.   
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Material Properties

This dialog allows you to specify the properties of the sample material being analyzed 
and the electrolyte solution in which it is dispersed. You can create a Material Properties 
file as an independent parameter file or as part of a sample information file. You can also 
save the materials properties portion of a sample information file as a material properties 
file.

Material Properties Contains the description of the current Material 
Properties file.

If this is a new file, this field contains the description 
specified in Sample Defaults (page 8-6). You can enter 
a new description or add to the existing one if desired. 
Use a description that will help you identify this set of 
properties.

You can enter up to 40 alphanumeric characters.

Replace Allows you to replace the values in the current file with 
those from an existing file. Simply click the push button, 
choose the desired file, and click OK. The values of the 
chosen file are copied into the current file; you can edit 
them as desired.

Sample Material Displays a list of available sample materials. After you 
select a sample material from the list, its description and 
properties are displayed. 
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Description Displays the sample material you select from the list. 
This field is also used to add sample materials to the list.

Density Displays the density of the selected material. 

Shape Factor Displays the shape factor of the selected material, or 
enables you to enter a shape factor for a material you are 
adding to the list.

The shape factor is an adjustment for non-spherical 
particles.

Maximum current Displays the maximum current for the selected material.

Add Enables you to add sample materials to the list.

Use the Description, Density, Shape Factor, and 
Maximum Current fields to enter your material and its 
properties, then click Add to add it to the list.

Delete Deletes the selected material from the list.

Electrolyte Solution Displays a list of available electrolyte solutions 
(dispersing liquids). After you select a solution from the 
list, its description and properties are displayed.

Description Displays the electrolyte solution you select from the list. 
This field is also used to add liquids to the list.

Density Displays the density of the selected electrolyte solution. 

Viscosity Displays the viscosity of the selected electrolyte 
solution.

Add Enables you to add sample materials to the list.

Use the Description, Density, and Viscosity fields to 
enter your electrolyte and its properties, then click Add 
to add it to the list.

Delete Deletes the selected electrolyte solution from the list.

Dispersion Enables you to enter information about the material 
preparation. The information you enter in this window 
appears in the Options report.
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Report Options

This dialog is used to edit existing report options, or to specify report options for a new 
file. You can create a Report Options file as an independent parameter file or as part of a 
sample information file. You can also save the Report Options portion of a sample 
information file as a Report Options file.

.
Report options If you are editing an existing file, this field displays the 

description or identification of the report options file. 
This description can be edited if desired.

If this is a new file, this field contains the description 
specified in Sample Defaults (page 8-6). You can enter 
a new description or add to the existing one if desired. 
Use a description that will help you identify this set of 
report options.

You can enter up to 40 alphanumeric characters.

Replace Allows you to replace the values in the current file with 
those from an existing file. Simply click the push button, 
choose the desired file, and click OK. The values of the 
chosen file are copied into the current file; you can edit 
them as desired.

A report is 
selected when 
preceded with a 
check mark.
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Show report title This option allows you to have a heading appear on your 
report and to enter a title for it.

If this is a new file, the title you specified as the default 
is displayed. Accept the default title or enter a different 
one.

You can enter up to 40 alphanumeric characters.

Show graphic Select this option to have a graphic (bitmap or enhanced 
metafile) display above the report title. For example, you 
may wish to display your company logo. Click Browse 
to select the desired graphic, use the Height and Width 
fields to specify a size. This image can be edited from 
the report window if desired.

Reference Displays the Reference Sample dialog.

This dialog enables you to choose a sample file with 
which to compare analysis results of the current sample; 
produces a Difference from Reference report.

Click Browse to choose the file. Use Clear to clear the 
field of its entry.
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Specification Displays the Specification Samples dialog.

This dialog enables you to choose sample files to be 
used for the boundaries of coarse and fine specifications; 
produces an Out of Specification report. This enables 
you to determine if the results of the current sample are 
within the specified boundaries.

Click Browse to the right of the fields to choose the 
files. Use Clear to clear the field of its entry.

Overlay Displays the Graph Overlay Samples dialog so that you 
can choose the sample files containing the data you wish 
to overlay onto a selected plot.

Click Browse to the right of the sample number field(s) 
to choose the desired file(s). Use Clear to clear a field of 
its entry. You can select up to eight files.

After choosing the desired files, be sure to edit the type 
of graph you are overlaying and choose the Overlay 
samples option. 
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Peaks Displays the Peak Detection Settings dialog, allowing 
you to choose how peaks are detected.

Auto Select this option to have peaks detected automatically. 
When you select this option, the Minimum distribution 
to report and Minimum valley depth to separate 
peaks fields are enabled, allowing you to specify a 
threshold for the peak size.

The valley depth option enables you to specify a 
threshold for resolving multiple peaks. Valley depth is 
calculated as:

where a = the smaller peak
b = lowest point between the two peaks

If the depth is greater than the value you enter as the 
minimum, the two peaks are treated as separate; 
otherwise, they are treated as one peak.

a b–
a

------------ 100%

a b
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Manual This option enables you to define the peaks by Diameter 
or Volume. Use the table to enter the minimum and 
maximum values for each peak to be detected.

Test Use this drop-down list to choose the test on which to 
have a report generated.

If you choose All, the selected reports will be generated 
for each test in the file.

For background files, the test selected in this field is the 
one that will be used for any background operation; for 
example if you have selected this file to use for subtract-
ing a background.

Reports to Generate Contains a list of available reports.

A report is selected when it is preceded with a check 
mark. Select reports by double-clicking the desired 
report(s). Alternatively, you can highlight the desired 
report and press the Spacebar. Reports are deselected in 
the same manner. Most reports can be edited by high-
lighting the desired report and clicking Edit. 

You can also generate Statistical Process Control (SPC) 
reports using the options on the Reports menu.

Edit Enables you to edit the highlighted report. Refer to sub-
sequent sections for editing details on the reports avail-
able with the Elzone program.

The following reports cannot be edited:

• Calibration
• Log Probability
• Options
• Rosin Rammler
• Sample Log 
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Graphs

All graph report options are similar and are edited in the same manner. Click Edit for a 
selected graph report; a dialog like the following is displayed.

Data Plot
Difference from Reference
Out of Specification

From this group, choose the type of plot desired.

If you select Difference from Reference or Out of 
Specification, be sure to click the related push button on 
the Report Options dialog to choose the file(s).

Points
Curve
Histogram
Curve and Points

Enables you to choose the manner in which to have data 
plotted. 

X-Variable Enables you to choose the x-axis variable.

Y-Variable Enables you to choose the y-axis variable and the 
manner in which it is to be plotted; make a selection 
from each column.

Overlay Click on the down arrow to display the types of overlays 
available.
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Samples Overlays the current curve with the same type of curve 
from multiple sample files. Click Overlays on the 
Report Options dialog to choose the sample file(s) 
containing the desired curves.

Tests Overlays the same type of curve from all tests performed 
with this file.

Plot Overlays a different variable with the selected variable 
(the one you are currently editing). Use the Edit button 
to specify details.

Edit Enabled when you choose Plot as the type of overlay 
allowing you to choose the overlay variable and specify 
details for the variable; the Overlay Settings dialog is 
displayed.

X-axis
Y-axis

Allows you to choose between a Linear or Logarithmic 
scale as well as autoscale options.

Autoscale Select this option to have the X- and/or Y-axis scaled 
automatically. Both axes begin at zero; the highest 
values collected during analysis are the ending points. 

If you deselect this option, the adjacent fields become 
enabled so that you may specify a range. Valid ranges 
are displayed in the information bar when the field is 
selected.
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Editing Tables

Select a table to edit; a dialog similar to this one is displayed.

The Standard Class Size Table and the Standard Sieve Table are fixed and, therefore, do 
not contain a table of values, nor push buttons.

• The Standard Class Size Table is fixed based on the classes specified in Analysis 
conditions (Data Setup). After the analysis is finished, data can be edited from the 
Collected Data dialog.

• The Standard Sieve Table is fixed based on the sieves specified using the Data 
presentation, Sieve Table option on the Options menu (page 8-14). 

Table Enter the values at which you wish the data to be 
reported (or accept the defaults).

Not included on the dialogs for the Standard Class Size 
Table and the Standard Sieve Table.

The title bar 
displays the 
name of the 
table being 
edited.

Included only on the Cumulative 
Fraction Table dialog.

The table and editing push buttons do not display if you 
are editing the Standard Class Size and Sieve tables. 
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Rosin Rammler

The Rosin Rammler report depicts the collected data as applied to the Rosin Rammler1 
theory; this report cannot be edited.

Insert Inserts a point above the selected point.   

Use Ctrl  to add points at the beginning of the table 
(first row must be selected) and Ctrl to add points at 
the end of the table (last row must be selected).

Not included on the dialogs for the Standard Class Size 
Table and the Standard Sieve Table.

Delete Deletes the selected point.

Not included on the dialogs for the Standard Class Size 
Table and the Standard Sieve Table.

Clear Clears all but one point from the table; one point is 
required.

Not included on the dialogs for the Standard Class Size 
Table and the Standard Sieve Table.

Column [n] These options enable you to choose the type of data to 
display in your table. Click the corresponding Edit push 
button to choose and edit the variable.

Sort Order Choose whether you wish to have points collected in an 
ascending or descending order.

Truncate table at
distribution limits 

Select this option to have the table shortened to the 
limits of the distribution.

Cumulative table by Enables you to select the manner in which to display the 
Y-axis.

Displays only on the Cumulative Fraction Table dialog.

1 Rosin, P. and Rammler, E., J. Inst. Fuel, 7, 20 (1933)
539-42820-01 (Rev A) - Sep 2017  5-33 



Elzone II 5390 Open
Log Probability Report

The Log Probability Report provides a comparison of the collected data to that of a log-
normal distribution; this report cannot be edited.

Summary Report

The Summary report provides a condensed listing of analysis statistics and data results. 
The Summary Report Options dialog allows you to choose the type of information to 
include in the report.

Statistics 
Type/Distribution

Choose the type of statistics and distribution you wish to 
report.

Arithmetic Statistics Choose the arithmetic statistics you wish to include in 
the report.

Statistics Select the variables you wish to include in the report.

Reports Choose the type of distribution(s) you wish to report.
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Percentiles Displays the Summary Percentiles dialog.

This dialog allows you to report the particle diameter (or 
radius) corresponding to each specified coarser (or finer) 
percentile. You can enter up to 10 values in any order. If 
you enter zero (0.00), a blank line is shown on the 
report.

Sizes Displays the Summary Sizes dialog.

This dialog allows you to report the cumulative percent 
(or fraction) coarse (or finer) for each specified diameter 
(volume). You can enter up to 10 values in any order. If 
you enter zero (0.00), a blank line is shown on the 
report.
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Peaks Displays the Summary Peaks dialog.

This dialog enables you to specify the types of data to 
display in the columns of the peak table. Column 1 is 
fixed and cannot be edited.

Sample Choose the sample parameters you wish to include in the 
report.
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Background Report

Select Background to edit; the Background Report Options dialog is displayed.

Overlay backgrounds Choose this option to overlay the background of this 
sample analysis with the background(s) of other 
analyses. Click Overlays on the Report Options dialog 
to choose the files containing the backgrounds you wish 
to overlay.

Points
Curve
Histogram
Curve and Points

Choose the manner in which you wish the background to 
display.

X variable Choose the variable you wish to display for the X-axis.
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Pulse Length vs. Particle Size Report

Select Pulse Length vs. Particle Size to edit; the Pulse Length vs. Particle Size Report 
Options dialog is displayed.

This dialog enables you to specify a variable for the x- and y-axes. You must also ensure 
that the pulse length and particle size data are stored to obtain this report. This is 
requested on the Analysis conditions screen; click Data Setup and select the Store pulse 
length vs. particle size data option located on the lower portion of the dialog. If this 
option is not selected, appropriate data will not be stored and, therefore, the Pulse Length 
vs. Particle Size report cannot be produced. You must also choose Full Resolution on the 
Data Setup dialog to generate this type of report.
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Pulse Length Report

Select Pulse Length to edit; the Pulse Length Report Options dialog is displayed. When 
generating this type of report, you must choose Full Resolution (page 5-21) on the Data 
Setup dialog before analysis

X Axis Variable Enables you to have the X-axis variable reported as 
Pulse Duration or Pulse Length. When Pulse Length 
is selected, the Subtract Orifice Length field is 
enabled; this allows you to have the orifice length 
subtracted from the pulse length.

Y Axis Variable Enables you to have the Y-axis variable reported as 
Incremental or Cumulative.

Overlay Select Tests to overlay data from all tests in the current 
file, or Samples to overlay data in the current file with 
data from other analyses.

If you select Samples, select Overlays on the Report 
Options dialog to choose the files you wish to use.

X-axis
Y-axis

Allows you to choose between a Linear or Logarithmic 
scale as well as autoscale options.

Displays valid 
ranges for the 
selected field.
539-42820-01 (Rev A) - Sep 2017  5-39 



Elzone II 5390 Open
Options Report

The Options report is a subset of the contents report; it provides pertinent information for 
the following:

• the sample
• analysis conditions
• material properties
• data collection

The Options Report cannot be edited.

Calibration Report

The Orifice Tube Calibration report contains tabular data for the reference material and 
goodness of fit, as well as a graphical representation of the goodness of fit. This report 
can also be generated using the Orifice Tube Calibration command on the Reports menu; 
refer to Orifice Tube Calibration, page 7-7 for additional information on this report.

The Calibration Report cannot be edited.

Sample Log Report

The Sample Log Report provides the following statistics:

• manual control operations performed during analysis
• information entered using the Add Log Entry push button on the sample file editor
• warnings and/or errors that occurred during analysis

The Sample Log Report cannot be edited.

Autoscale Select this option to have the X- and/or Y-axis scaled 
automatically. Both axes begin at zero; the highest 
values collected during analysis are the ending points. 

If you deselect this option, the adjacent fields become 
enabled so that you may specify a range. Valid ranges 
are displayed in the information bar when the field is 
selected.
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Combined Report

Select the Combined Report to edit; the Combined Report Options dialog is displayed.

The list of reports for the Combined Report is identical (with the exception of the 
Combined report) to the list of reports generated in the normal manner. The difference is 
that the reports generated from the selections on this dialog contain no page breaks or 
headings. And, unless too many are selected, all reports display on a single page.
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Collected Data

The tab for Collected Data does not appear on the Advanced dialog presentation until 
after analysis

Table Displays data points for the current test selected from the 
Test drop-down menu.

Test Displays the current test for this sample file. If you wish 
to view data for another test, click on the down arrow to 
select the desired test.

Delete Test Click this push button to delete the test displayed in the 
Test field. If only one test exists, this push button is 
disabled; one test must remain in the file.

Merge with 
external data

Enables you to merge data collected by some other 
method with the data of the current test. Click External 
Data to enter the data.

External Data Enabled when you select Merge with external data. 
Displays the External Data dialog so that you can enter 
the data you wish to have merged.
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Full scale volume 
percent

Select this option if you analyzed part of the sample by 
another method but you do not wish to merge the results 
with the reports for the current test. Specify the volume 
percent of the sample actually analyzed by the analyzer 
versus the percent that is manually analyzed. The data 
are scaled accordingly. 

Disabled when Merge with external data is selected.

Distribution Type Enables you to choose the manner in which data are 
presented.

Data Setup Displays the Data Setup dialog. This dialog enables you 
to edit the manner in which the data are displayed. If 
Reduced was selected as the Data Format, many of the 
options are disabled and cannot be edited.

Subtract Background Enabled for Full resolution data allowing you to 
subtract particles that may have been detected in the 
background measurement. After you select this option, 
click Browse to choose the background file you wish to 
use.

If you choose a background file containing multiple 
tests, be sure to access the Report Options dialog in the 
file and ensure that the desired test is selected in the Test 
field prior to selecting it on this dialog.
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From Graph This option enables you to choose a size range marked 
on the graph by a set of cross-hairs. This button does not 
become enabled until you have marked the range.

Simply click in the graph at the point you wish to begin 
the range to place the first cross hair. Hold down the 
Shift key and click at the ending range to place the sec-
ond cross hair. Then click From Graph to set the range.

The total number of particles in the specified range dis-
plays in the lower left of the dialog.

Distribution Enables you to select the manner in which data are pre-
sented in the graph. Each time you select a different 
option, the data are rescaled accordingly. 

Extrapolation Use this feature to complete data below the ending point 
when data does not return to zero on the y-axis; missing 
points will be calculated automatically.

A From Graph push button is also provided for this 
feature (it works in the same manner as the one 
explained above).

This feature is available for full-resolution or reduced 
data; the extrapolation point is displayed in the report 
header.

Remaining fields on 
this dialog

Refer to page 5-18 for a description of their functions.
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Entered Data 

An Entered Data tab displays when you select Manually entered on the Sample 
information dialog. The dialog for Entered Data enables you to enter data as opposed to 
having it collected automatically during analysis.

You cannot enter data if you are using a computer other than the one that is connected to 
the analyzer.

Table Enables you to enter the desired data; data are entered in 
an ascending order.

Insert Inserts a row above the selected row. 

Use Ctrl + to add rows below the selected row. 

Delete Deletes the selected row.

Clear Clears the table of all but one entry; one is required.

Size Type Enables you to select the type of size data you plan to 
enter.

Distribution Type Enables you to select the type of distribution to report.

Use this key 
sequence to 
add rows to the 
list.
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Save

Save enables you to save any changes made to the file in the active window. The file is 
saved under its current name.

Save As

Save As enables you to:

• save a sample or parameter file in the active window under a different name. This 
option is useful for making a duplicate copy of a file that you can modify as desired 
without changing the original one. If you are using the Save As function on a com-
pleted file, you will not be able to edit the values in the new file; you simply will be 
making a duplicate copy of the file. If you wish to create a file using the conditions of 
a completed file, you should create a new file and use the Replace All push button to 
copy the values of the completed file into the new file. 

• save a subset (parameter) of the sample file in the active window as a standalone 
parameter file. For example, select Analysis Conditions from the Save As menu to 
create a standalone parameter file of the analysis conditions portion of the active sam-
ple file.

Be sure to save parameter files to the directory specified as the Parameter Files directory 
(see Parameter Files Directory, page 8-15 for additional information) or it will not 
display in the drop-down list on the Basic Sample Information file editor. The default 
directory is params. 

Save All

Save All enables you to save all open files under their current names. This option provides 
a faster way to save all open files at one time and avoids having to perform a Save 
operation on each individual file. 

When you use the Save As function, the original file remains open. Be sure to 
open the new file before making any changes.
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Close

Close enables you to close the file in the active window. The following message is 
displayed if changes have been made to the file:

(path\file name) has been changed. Save changes 
before closing?

Yes No Cancel

• Click Yes to save the changes and close the dialog 
• Click No to discard the changes and close the dialog 
• Click Cancel to allow the file to remain active

Close All 

Close All enables you to close all open files under their current names. The following 
message is displayed for each file in which changes have been made:

(path\file name) has been changed. Save changes 
before closing?

Yes No Cancel

• Click Yes to save the changes and close the dialog 
• Click No to discard the changes and close the dialog 
• Click Cancel to allow the file to remain active
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Print

Print enables you to print details of a sample or parameter file. For example, if you 
choose to print the contents of an analysis conditions file, you will receive the parameters 
used for all analysis conditions associated with the file. The print dialog is common to all 
file types; the title bar displays the type of file requested for printing.

File name The name of the file you select from the Files list 
window is copied to this field. If choosing multiple files, 
the last name chosen is displayed.

Status Enables you to choose the type of files to display in the 
Files window. Refer to Table 2-2. File Status and 
Description, page 2-11, for Status types.

This field does not display for parameter files.

Date Range Enables you to choose a date range for the files to 
display in the Files window. Refer to Selecting Files, 
page 2-10 for an explanation of this push button.

Title bar displays the type of 
file for which contents are 
being printed.

The Status drop-down 
list does not display for 
parameter files.
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List

List enables you to generate a listing of the following information on a selected file, or on 
multiple files:

• File name
• Date the file was created (or last edited)
• Time the file was created (or last edited)
• File identification
• File status

Regardless of which file type you select, a dialog similar to the one shown below is 
displayed.

Settings group box The Destination field contains a list of the available 
print destinations.

If you select Printer, the Copies field is enabled 
allowing you to enter up to four copies.

If you select File, the tabular reports of the requested file 
are converted to a text file which can be viewed with a 
text editor or other text file manipulation tools. The File 
name field is also enabled allowing you to enter a name 
(or you can accept the default).

Title bar displays the type of 
file for which statistics are 
being requested.

The Status drop-down 
list does not display for 
parameter files.
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File name If you select only one file from the Files list box, the 
name is copied to this field. If multiple files are selected, 
the last one selected displays.

To select multiple files, hold down the Ctrl key while 
selecting the files. 

Status Enables you to choose the type of files to display in the 
Files window. Refer to Table 2-2. File Status and 
Description, page 2-11, for Status types.

This field does not display for parameter files.

Date Range Enables you to choose a date range for the files to display 
in the Files window. Refer to Selecting Files, page 2-10 
for an explanation of this push button.

Settings group box The Destination field contains a list of the available 
print destinations.

If you select Printer, the Copies field is enabled 
allowing you to enter up to four copies.

If you select File, the tabular reports of the requested file 
are converted to a text file which can be viewed with a 
text editor or other text file manipulation tools. The File 
name field is also enabled allowing you to enter a name 
(or you can accept the default).
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Export

Export allows you to copy the reduced or full-resolution data in a sample information file 
and reformat it in ASCII format. ASCII data can be imported into other applications, such 
as spreadsheets. You may select multiple files by holding down Ctrl while selecting the 
files. Refer to Appendix C, page C-1 for a description of the format used for exported 
data.

File name The name of the file you select from the Files list box is 
copied to this field.

Status Enables you to choose the type of files to display in the 
Files window. Refer to Table 2-2. File Status and 
Description, page 2-11 for Status types.

Date Range Enables you to choose a date range for the files to 
display in the Files window. Refer to Selecting Files, 
page 2-10 for an explanation of this push button.

Export Type You can export Reduced Data or Full-resolution Data 
from a sample file, or multiple sample files.

Copies Enabled when you select Printer as the destination, 
allowing you to print up to four copies.
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Destination You can print to a Printer, the Screen, or to a File.

File Type You can export the data as a text file (TXT) or in a 
spreadsheet format (XLS).

File name Enabled when you select File as the destination, 
allowing you to enter a file name if desired.

Include average of tests Select this option to export values for the average of all 
tests included in the file.
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Convert

When you select Convert, two types of files are displayed:

• Elzone: copies and converts data from sample files used with the Model 5380 Series 
of analyzers

• ASCII: copies and converts data from a text file. The text must be comma-
delimited; for example: size 1, quantity 1; size 2, quantity 2; etc.

These data are converted to a format compatible with the Elzone II program. A dialog 
like the following is displayed regardless of the type of file you are converting.

File name Defaults at *.HST when converting Elzone files and 
*.CSV when converting text files. After you select a file, 
its name displays in this field. If multiple files are 
selected, the last one selected displays.

To select multiple files, hold down the Ctrl key while 
selecting the files.

Destination Displays the destination directory to which the converted 
file will be sent. A default name (the same as the source 
file) is assigned. This name and the destination folder 
may be edited if desired.

Date Range Use this push button to specify a date range in which to 
display files. Refer to Selecting Files on page 2-10 if 
you need help on using this push button.

Displays the type 
of file you are 
converting.
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OK Converts the data of the selected files; a confirmation 
dialog is displayed.

If you are converting ASCII text files and select this 
push button, a dialog enabling you to select data 
parameters is displayed before the confirmation dialog.

This dialog enables you to select the type of data 
contained in the text file. If you have selected multiple 
files, a dialog is displayed for each file (the name of the 
file is in the header)

Cancel Cancels the operation and closes the dialog.

Click here to close 
the dialog.
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Blend

Blend enables you to merge data from multiple analyses in which different orifice tubes 
were used. A single orifice tube is capable of measuring particles within a certain size 
range. You can use multiple orifice tubes to measure the distribution over a wider range. 
The Blend option enables you to blend the data from all of the orifice tubes used in the 
analysis. Blending is the preferred method of completing the data. The Blend Sample 
Files dialog is displayed.

You can also edit graph properties; for example, you may wish to hide data from one of 
the sample files. Right-click in the graph area and select Hide curve, then choose the one 
you wish to hide. Refer to Shortcut menus for graphs, page 7-27 for an explanation of 
the options available.

Fields 1 through 5 Display the files you choose for the blending operation; 
in this above example, three are shown.

Browse Click this push button to choose the desired file.

Clear Clears the field of its entry.

Range fields Displays the range for overlapped data. This range is 
determined automatically by the analysis program; how-
ever these values may be edited. The blend ranges are 
marked on the graph with circles.
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Show Blend Select this option to blend the data from all files and plot 
the graph as if it were one distribution. 

Show Overlays Plots the data from each file as overlays.

Size Classes Defaults to the number of size classes for the first data 
set (field 1); this value can be edited as desired.

Save As Displays the Save as Blend dialog.

This dialog enables you to save the blended data as a 
sample file. If desired, you can then use Report > Start 
Report to generate reports to the printer or to the screen 
to view data.

Print Becomes enabled after you save the blended data. Click 
this push button to display the Report Settings dialog so 
that you can specify output options.

Close Closes the dialog.
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Average

Average enables you to choose up to five sample files and average the data from all files. 
Or, you can choose Add to add and combine the data from the selected files. A graph is 
drawn on the right side of the dialog and updates automatically each time a file is added 
(or removed). The Add or Average Samples dialog is displayed.

 
Fields 1 through 5 Display the files you choose using Browse.

Browse Click this push button to choose the desired file.

Clear Clears the field of its entry.

Scale Enables you to scale the distribution. Users typically use 
this to scale data in relation to sample concentration or 
analysis time. For example: you are averaging data from 
two files. One was analyzed for 60 seconds and the other 
one for only 30 seconds. Enter 2.00 in the Scale field of 
the 30-second analysis to scale the data to match the 60-
second analysis. After editing the value in this field, 
click in the graph area to initiate the rescale. 

You can also use negative values in this field to subtract 
distributions.
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Exit

Exit enables you to exit (close) the Elzone program. 

• If an analysis is in progress, the following message is displayed:

CAUTION: Sample analysis is in progress. If you exit 
the program analysis will continue to completion, but 
the data are not saved to disk until the program is 
restarted. Do you want to exit the program?

Yes No

Click Yes to close the program. The analysis continues and data are collected.

Click No to allow the program to remain active.

• If a report is in progress, you are cautioned that reports are being generated, and 
given the opportunity to either cancel the print job or allow the reports to print 
before exiting.

Add Choose this option to obtain a total of all data sets in the 
selected sample files.

Average Choose this option to obtain an average for all data sets 
in the selected sample files.

Save As Allows you to save the data as a sample file.

Close Closes the dialog.

Although data are stored in the analyzer when you exit the program during 
analysis, they are not saved in the file until the program is restarted. At that time 
the data are saved automatically. If a power failure occurs in the interim and you 
do not have an Uninterruptible Power Supply (UPS) attached, loss of data will 
result.
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6.  UNIT MENU

The Unit menu contains the operations which can be performed with the Elzone analyzer. 
The main menu contains a Unit menu for each attached analyzer. For example, if you 
have two attached analyzers, the main menu contains two Unit menus. 

The unit number and the serial number also are displayed in the title bar of the opera-
tional windows. The status windows also display in different colors. 

Description

Listed below are brief descriptions of the Unit menu options. Detailed descriptions are 
found in subsequent sections.

The Unit menu does not appear on the menu bar if the analysis program is being 
used for offline data manipulation.

Sample Analysis Use this mode of operation to perform single sample 
analyses. This option is disabled if analyses are being 
performed in another mode. Page 6-3.

QuickStart Analysis Use this mode of operation to perform successive sample 
analyses using the same analysis conditions. Page 6-14.
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Change Orifice Tube
 or Liquid

Enables you to change the orifice tube or the liquid 
(electrolyte solution). Page 6-19.

Rinse Enables you to rinse the system (internal glassware). 
Page 6-20.

Fill System Enables you to fill the system with liquid. Page 6-21.

Flush System Enables you to flush liquid through a filled system. Page 
6-21.

Drain System Drains the system of all liquid. Page 6-22.

Clear Blockage Enables you to clear a blockage from the orifice tube. 
Page 6-22.

Orifice Tube Calibration Enables you to calibrate the orifice tube. Page 6-23.

Background List Allows you to edit the background list. Page 6-31.

Zero Pressure Scale Enables you to zero the pressure transducer to atmo-
spheric pressure. Page 6-32.

Diagnostics Enables you to perform predefined user diagnostics. 
Page 6-33

Enable Manual Control Allows you to control certain instrument components 
manually. Page 6-36.

Show Instrument 
Schematic

Displays the instrument schematic. Page 6-42.

Show Status Displays only the status window of the operational win-
dow, enabling you to view the status of the operation in 
progress. Page 6-43.

Show Instrument Log Displays the instrument log. Page 6-44.

Unit Configuration Displays the configuration of the analyzer. Page 6-47.
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Sample Analysis

Use this mode of operation to perform up to eight tests (analyses) on a single sample. 
When you select this option from the Unit menu, the Sample Analysis dialog is displayed 
with all fields disabled (greyed out). Click Browse to select an existing sample file for 
your analysis, or you can create a new one.

After a sample file has been designated, the Sample Analysis dialog is displayed. The 
fields now contain the values for the selected file, or if creating a new file, the specified 
defaults.

Calibration Enables you to perform certain instrument calibrations. 
The options on this menu are enabled only with the 
direction of a Micromeritics service representative.
Page 6-49

Service Test Allows you to perform certain troubleshooting proce-
dures. This option is enabled only under the direction of 
a Micromeritics service representative. Page 6-49.
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View Allows you to view one of the following in the current 
window:

• the current operation
• the instrument schematic
• the instrument log

Browse Displays the Select a File for Analysis dialog, allowing 
you to select a sample file for your analysis, or to create 
a new one.

Sample Displays the identification of the sample.

Replace All This push button allows you to replace the values for all 
parameters of the current file with the values from an 
existing file. Simply click the push button, choose the 
desired file, and click OK. The values of the chosen file 
are copied into the current file; you can edit them as 
desired.

Data Setup Displays the Data Setup dialog enabling you to edit anal-
ysis conditions. Data does not display in this view of the 
dialog.
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Analysis Conditions Displays a description of the analysis conditions file in 
the selected sample information file. 

Use the drop-down list to select a different file if desired.

Orifice Tube Displays a description of the orifice tube specified in the 
Analysis Conditions file. If the identification is pre-
ceded with an asterisk, the orifice tube has not been 
calibrated for this instrument. Orifice tubes should be 
calibrated to obtain accurate results.

Material Properties Displays a description of the materials properties file in 
the selected sample information file. 

Use the drop-down list to select a different file if desired.

Report Options Displays a description of the report options file in the 
selected sample information file. 

Use the drop-down list to select a different file if desired.

Reports to Generate Displays the reports selected for the current Report 
Options file (the ones preceded with a check mark); 
these selections may be edited if desired.

Number of tests Displays the number of tests chosen for this sample file; 
you can perform up to eight tests with each file. This 
number can be edited if desired.

Background This option enables you to have the data collected in this 
analysis saved as a background. If you choose this 
option, click Data Setup and ensure that Full resolution 
is selected as the Data Format.

Stirrer Speed Displays the stirrer speed specified in the sample file; 
you can edit this value if desired. The lower the number, 
the lower the speed; 0 (zero) turns the stirrer off.

Stirrer Direction Displays the stirrer direction (particle circulation) speci-
fied in the sample file; you can change the direction if 
desired.

This option is not applicable for the hydropulser.
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Dilution Factor Displays the dilution factor specified in the sample file; 
you can edit this value if desired.

Mass Concentration Displays the concentration specified in the sample file; 
you can edit this value if desired. 

Rinse Displays the rinse options selected in the sample file; 
you can edit these options if desired.

Report after analysis Displays the Reports Settings dialog so that you can 
specify report output options.

Select the option on this dialog to have reports printed 
automatically after analysis. If you do not wish to have 
reports generated automatically, you can generate them 
after the analysis using the Start Report option on the 
Reports menu.

Copies Enabled when you choose Printer as the destination, 
allowing you to print up to four copies.

Destination This drop-down list contains report output options.

Choices:  Screen, Printer, File

File name Enabled when you choose File as the destination, allow-
ing you to enter a name (or you can accept the default).
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Export after Analysis Enables you to export data automatically after analysis; 
the Export Settings dialog is displayed.

 If you do not wish to have reports exported automati-
cally, you can export them after the analysis using the 
Export option on the File menu.

Export Type You can export Reduced Data or Full resolution Data.

File Type You can export the data as a text file (TXT) or in a 
spreadsheet format (XLS).

File name The data will be exported as the file name and the appro-
priate extension to the application directory. You can 
enter a different directory if desired.

Include average 
of tests

Select this option to export values for the average of all 
tests included in the file.

Next Saves the settings in the current dialog and advances you 
to the next view of the Analysis dialog.
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View Allows you to view one of the following in the current 
window:

• the current operation
• the instrument schematic
• the instrument log

Report Enables you to generate a report for the data collected up 
to the time you request the report.

Sparkle Display Displays during data collection or while in Preview 
mode. 

The Sparkle display emulates an oscilloscope (turned 90º 
to the right). The analyzer measures the change of resis-
tance across the orifice and displays a dynamic scan of 
pulses (tips) in real time.

Coincidence Displays the current coincidence level.

Preview Enables you to view signals (in the Sparkle display) and 
the coincidence rate.
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Orifice Displays the description of the orifice tube being used in 
this analysis.

Diameter Range Displays the range in which to detect particles.

Instrument Setup Displays the Instrument Setup dialog, enabling you to 
edit certain analysis conditions prior to analysis.

Optimize Settings Enables you to have the optimum Load Resistor, Cur-
rent, and Gain determined. These values will be stored in 
the analysis conditions file as well as in the collected 
data, and as the optimized settings for the orifice/electro-
lyte combination. 

Typically, it is best to optimize settings with a beaker 
containing only electrolyte; no sample. Then add your 
sample after optimization is complete. Refer to Optimiz-
ing Instrument Settings, page 3-33 for additional 
information.

Data Setup Displays the Data Setup dialog, enabling you to edit data 
parameters if desired. A graph of the last saved test is 
displayed. 
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From Graph This option enables you to choose a size range marked 
on the graph by a set of cross hairs. This button does not 
become enabled until you have marked the range.

Simply click in the graph at the point you wish to begin 
the range to place the first cross hair. Hold down the 
Shift key and click at the ending range to place the sec-
ond cross hair. Then click From Graph to set the range.

The total number of particles in the specified range dis-
plays in the lower left of the dialog.

Save Settings Displays the Save as Analysis Conditions File dialog 
allowing you to save the current settings as an Analysis 
Conditions file. 

Measure Conductivity Select this option to measure the conductivity for the 
current orifice tube and liquid. The date and time of the 
last recorded measurement for this tube/liquid 
combination displays to the right of the push button.
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Actions The following actions are available prior to analysis:

• Drain: drains the system, leaving the glassware empty

• Fill: fills the glassware with electrolyte solution

• Flush: flushes solution through the glassware; it does 
not empty the glassware

• Rinse: displays the Rinse dialog enabling you to spec-
ify rinsing preferences

• Clear Blockage: clears any blockage that may be in 
the orifice tube. This option is also available during 
analysis, but only up to the point where data collection 
begins.

• Turn Stirrer Off: turns the stirrer off.

Ending Conditions Displays the Ending Condition dialog so that you can 
edit the ending criteria if desired.

Time, Volume, Total and 
Modal count

Displays the parameters for the current ending 
conditions.

Start
Continue

Enables you to start or continue (when stopped) data 
collection. 

Stop Stops data collection. 

Clear Discards all data collected for this analysis. This action 
is recorded in the instrument log.

Save Enables you to save the collected data into the sample 
file as the next test. The data is discarded after it has 
been saved.
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Finish Enabled when all setup parameters are appropriate for 
the analysis; displays the Finish Analysis dialog.

After verifying information in this dialog, click OK to 
close the dialog and complete the analysis.

After the analysis is complete, you will be returned to 
the first dialog in the Analysis series to begin another 
test or end the session.

Cancel Cancels the current operation.

Close Closes the dialog; you will be prompted to save data 
before the dialog closes.

Status Window Displays the status of the current analysis. Refer to 
Show Status, page 6-43 for additional information on 
this window.
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Click Start to begin the analysis; data starts to collect and the dialog now looks like this:

After data are collected (concentration bar reaches 100%), Save is enabled allowing you 
to save the data into the sample file.    

Becomes 
enabled when 
concentration 
bar shows 
100%.

Concentration Bar
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QuickStart Analysis

Use this mode of operation to analyze a series of samples of the same type which contain 
the same analysis conditions; sample files are created automatically using default values. 
When you select this option from the Unit menu, the QuickStart dialog is displayed.

     
View Allows you to view one of the following in the current 

window:

• the current operation
• the instrument schematic
• the instrument log

Sample Displays the description specified in Sample Defaults; 
you can edit if desired.

Report after analysis Select this option to have reports printed automatically 
after analysis. If you do not wish to have reports gener-
ated automatically, you can generate them after the 
analysis using the Start Report option on the Reports 
menu.
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Copies Enabled when you choose Printer as the destination, 
allowing you to print up to four copies.

Destination This drop-down list contains report output options.

Choices:  Screen, Printer, File

File name Enabled when you choose File as the destination, allow-
ing you to enter a name (or you can accept the default).

Export after analysis Select this option to have report data exported automat-
ically after analysis. If you do not wish to have reports 
exported automatically, you can export them after the 
analysis using the Export option on the File menu.

Refer to page 6-7 for an explanation of the fields on this 
dialog.

Next Advances you to the next view of the QuickStart dialog. 
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View Allows you to view one of the following in the current 
window:

• the current operation
• the instrument schematic
• the instrument log

Filename Displays the next sequenced file name. Click Browse if 
you wish to use an existing sample file. 

Sample Displays the identification you entered on the previous 
view of this dialog; you may still edit this identification 
if desired.

Save as background Select this option to have the data collected for this anal-
ysis saved as a background. For example, you may wish 
to have the first run of the current series of analyses 
saved as the background analysis. 

Measure Conductivity Select this option to measure the conductivity for the 
current orifice tube and liquid. The date and time of the 
last recorded measurement for this tube/liquid 
combination displays to the right of the push button.

Optimize Settings Enables you to have the optimum Load Resistor, Cur-
rent, and Gain determined. These values will be stored in 
the analysis conditions file as well as in the collected 
data, and as the optimized settings for the orifice/electro-
lyte combination. 

Typically, it is best to optimize settings with a beaker 
containing only electrolyte; no sample. Then add your 
sample after optimization is complete. Refer to Optimiz-
ing Instrument Settings, page 3-33 for additional 
information.

Turn Stirrer On
Turn Stirrer Off

This toggle switch enables you to turn the stirrer on or 
off during analysis.

Check Concentration Use this push button to check the concentration level of 
the electrolyte after you have specified a range in the 
Counts/Sec fields. The measured rate of the concentra-
tion will display between the range fields and the 
concentration bar will indicate visually whether or not 
the concentration is within range.
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Counts/Sec These fields are provided to enter a range for the amount 
of particles per second that you wish to have pass 
through the orifice. The valid range is 0 to 10000.

Concentration bar This bar indicates the concentration in relation to the 
specified range. When the Check Concentration push 
button is clicked, the status bar is divided into three sec-
tions, separated with vertical bars; the first representing 
0 to the minimum range you specify, the second mini-
mum to maximum ranges, and the third maximum range 
you specify to the limit of 10000.

The bar will be colored up to the measured concentra-
tion. For example: a bar colored like this one indicates 
low concentration; add more sample.

A bar colored like this one indicates the concentration is 
within the specified range.

A bar colored like this one indicates the concentration is 
too high; add more electrolyte or discard sample and 
start over.

Rinse Displays a dialog containing the rinse options selected in 
the sample file; you can edit these options if desired. 
This enables you to rinse the internal glassware before 
the current analysis begins.

Indicates 0 to minimum (value in left 
range field)

Indicates minimum to maximum 
(range specified in the range fields).

Indicates maximum (value in right 
range field) to 10000.
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This view of the dialog displays the data as they are collected.

        

After the analysis is finished, you are returned to the second view of the QuickStart dialog 
allowing you to add sample and continue analyses.

Status Window Displays the status of the current analysis. Refer to 
Show Status, page 6-43 for additional information on 
this window.

Next After loading your sample, click this push button to 
begin analysis and advance to the next analysis screen. 

Sparkle Display Displays during data collection. 

The Sparkle display emulates an oscilloscope (turned 90º 
to the right). The analyzer measures the change of resis-
tance across the orifice and displays a dynamic scan of 
pulses (tips) in real time.

Time, Volume, Total and 
Modal count

Displays the parameters for the current ending 
conditions.

Concentration bar Displays the percentage of completion for the current 
operation.

Cancel Cancels the current analysis and returns you to the orig-
inal sample selection window.
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Change Orifice Tube or Liquid

This option enables you to change the orifice tube or liquid; the Change Orifice Tube or 
Liquid dialog is displayed.

This dialog is the first of a series of dialogs that guides you through the process of chang-
ing the orifice tube or liquid. After you click Start on this dialog, you receive (in 
sequence):

• a dialog showing the status of the initial draining step; after draining operation is 
completed, you are advanced to the next dialog automatically

• a dialog prompting you to replace the orifice tube or liquid; after you have 
performed the requested action, click Continue to proceed to the next dialog

• a dialog showing the status of the draining/filling operations; after this operation is 
complete, you are advanced to the next dialog automatically

• a dialog indicating that the operation is complete; this dialog contains two push 
buttons.

Next Liquid For some liquids, one or more intermediate liquid changes 
are required; click Next Liquid if this is the case with your 
liquid.   

Example: If you are using as the electrolyte sodium chlo-
ride in water and you wish to change to a lithium chloride 
in IPA, you should use this option. This enables you to 
rinse first with the water (base for current solution), then 
with IPA (base for new solution), then with the new elec-
trolyte solution. 

Refer to Changing the Liquid in the Supply Container, 
page 3-31 for step-by-step instructions.

Done Click this push button to close the dialog
539-42820-01 (Rev A) - Sep 2017                                                 6-19 



Elzone II 5390 Rinse
Rinse

This option enables you to rinse the system (internal glassware); the Rinse dialog is 
displayed.

Drain and fill Choose this option to drain, rinse, and refill the system 
with liquid.

Flush Choose this option to flush the system with liquid; liquid 
remains in the glassware at all times.

Rinses Enter the number of times you wish to perform the 
selected option; you can enter up to 9 rinses.

Purge Volumetric Pump Select this option to have the volumetric pump (if 
installed) purged during the rinsing process
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Fill System

This option enables you to fill a system (internal glassware) that has been drained of liq-
uid. Before selecting this option, place a beaker of electrolyte on the sample stand and 
raise the stand.

Flush System

This option enables you to flush liquid through the system; the Flush System dialog is 
displayed.

Before selecting this option, place a beaker of electrolyte on the sample stand and raise 
the stand.

Start Click this push button to start the filling process.   

Cancel Cancels the operation.

Start Click this push button to start the flushing process; liquid 
remains in the system at all times.   

Cancel Cancels the operation.
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Drain System

This option enables you to drain the liquid from the system; the Drain System dialog is 
displayed.

Before selecting this option, be sure that the sample stand is in its lowest position; your 
orifice tube should not be submerged for this operation.

Clear Blockages

This option enables you to clear blockages from the orifice tube; the Clear Blockage dia-
log is displayed.

Start Click this push button to start the draining process.   

Cancel Cancels the operation.

Start Click this push button to start the process.   

Cancel Cancels the operation.
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Orifice Tube Calibration

This option enables you to calibrate an orifice tube to a selected sample and electrolyte 
solution. A sample file for the calibration is created automatically and stored in the calib/
serial number subdirectories, which are located in the data subdirectory of the applica-
tion. A sample identification containing the orifice identification and size is automatically 
assigned making it easy to recognize the calibration. 

The fields on this dialog are identical to the fields on the Analysis conditions dialog; refer 
to Analysis Conditions, page 5-13 for an explanation of this dialog. 
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Click Next to advance to the next view of the calibration dialog.

View Allows you to view one of the following in the current 
window:

• the current operation
• the instrument schematic
• the instrument log

Reference Material
Identification List

This window lists the reference material(s) required to 
calibrate orifice tubes. Reference materials required for 
the current calibration must be selected (check mark). 
Double-click on the reference material to place (or 
remove) a check mark.

If the reference materials required for the calibration are 
not in the list, use the Add push button to add them.

Show only materials in 
range of orifice tube

Select this option to show only the materials appropriate 
for the current orifice tube.

Be sure the reference 
materials required in the 
calibration are checked.
6-24                                              539-42820-01 (Rev A) - Sep 2017



Orifice Tube Calibration Elzone II 5390
Add Displays the Reference Material dialog so that you can 
add a new reference material to the list.

The information required in these fields can be found on 
the reference material bottle or its accompanying 
booklet.

Identification Enter an appropriate description; you can use up to 20 
alphanumeric characters. Most users enter the size of the 
orifice tube and the serial number (located on the orifice 
tube).

Lot Number Enter the lot number of the reference material; you can 
use up to 20 alphanumeric characters.

Size Enter the size specified on the reference material 
container.

If you enter a value in this field that is not within the 
range allowed for the orifice tube being calibrated, a 
warning is displayed. 

Tolerance Enter the tolerance level.

Size statistic in Select appropriate statistic.

Edit Displays the Reference Material dialog (shown above) 
enabling you to edit the selected material.

Delete Deletes the selected material from the list.
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Click Next to advance to the next view of the calibration dialog.

Maximum Current Choose the maximum current; typically this choice will 
be Particle. If you wish to specify a different value, 
select the third choice and enter the desired current. 

Electrolyte Solution Displays a list of available electrolyte solutions (dispers-
ing liquids). After you select a solution from the list, its 
description and properties are displayed.

Description Displays the electrolyte solution you select from the list.

Density Displays the density of the selected electrolyte solution. 

Viscosity Displays the viscosity of the selected electrolyte 
solution.

Add Enables you to add electrolyte solutions to the list.

Use the Description, Density, and Viscosity fields to 
enter your electrolyte and its properties, then click Add 
to add it to the list.

Delete Deletes the selected electrolyte solution from the list.

Becomes enabled 
when calibration is 
complete.

Progress Bar
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The fields on this dialog are identical to the fields on the Sample Analysis dialog 
explained on page 6-3.

The values on the left side of this dialog display the calibration information of the current 
calibration as well as the previous one (if one exists). If a reference material is out of tol-
erance, a notice will be displayed just below the calibration information.

Save Enabled when the calibration is complete (progress bar 
reaches 100%) allowing you to save the data.

Finish Displays the Finish Analysis dialog.

This dialog enables you to verify that the reference mate-
rial data were saved. You should also verify that a 0 
(zero) is in the Number of Tests Remaining field; oth-
erwise another calibration will be performed.

When you click OK on this dialog, the final Orifice Tube 
Calibration screen is displayed.

Indicates the data 
were saved.

Be sure 0 (zero) 
is displayed here.

Choose the refer-
ence material on 
which to display 
information from this 
list.
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The values on the right side of the dialog are specific to a reference material. The refer-
ence material is selected from the drop-down list just above the information.

Report Generates the calibration report to the computer screen. 
You can print a hard copy of the report from the report 
window if desired.

Show collected data
Show fit

The collected data option is selected automatically. 
Select Show fit to show the goodness of fit. 

Reference Material 
drop-down list

Choose a reference material used in the calibration to 
display its related information (below the list).

Use in calibration Initially, this option is checked for all materials included 
in the calibration, indicating that all will be included in 
the line-fit calculation. If you do not wish to have a ref-
erence material included in the calculation, deselect this 
option when the desired reference material is displayed 
in the field of the drop-down list. 

Edit Displays the Edit Pulse Height dialog.

The pulse height is initially calculated by the software; 
this dialog enables you to manually enter a pulse height. 
The pulse height can also be edited with cross hairs (see 
Graph below).
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From Graph This option enables you to:

• set the pulse height at the position of a single cross hair

Simply click in the graph at the desired location for a 
single cross hair, then click From Graph.

• have the mean (mode or median) value calculated 
between two cross hairs

Click in the graph at the left side of the desired peak 
for the first cross hair. Hold down the Shift key and 
click at the right side of the desired peak. Then click 
From Graph.

Calculate Click this push button to recalculate the pulse height to 
its original value.

Force Fit Through Zero Select this option to force the calibration fit to where 
zero voltage of the peak detector corresponds to a parti-
cle of zero size.

This example 
shows a graph in 
which two cross 
hairs are used.
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Fit Order Enables you to choose the highest order for the polyno-
mial fit. If the fit is invalid, the order will decrease to the 
next lowest selection and refit.

The coefficients of the polynomial fit are displayed on 
the left side of the dialog.

Accept If values are within tolerance and are as desired, click 
Accept to save the calibration and close the dialog

The file is automatically assigned a name and saved into 
the CALIB\(serial number) directory. These directories 
are created in the DATA directory the first time an ori-
fice tube calibration is performed. If you have two 
instruments attached, directories for each instrument 
serial number will be created.
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Background List

The software maintains a list of backgrounds performed on the analyzer; the Back-
grounds List dialog is displayed.

Orifice Tube Contains a list of the orifice tubes which have been used 
with this analyzer.

Electrolyte Solution Contains a list of electrolyte solutions that have been 
used in backgrounds for this analyzer.

Background list Lists the backgrounds available for the selected orifice 
tube/electrolyte combination.

This window lists the:

• minimum and maximum particle diameter range
• date and time for the background
• sample file identification

An asterisk preceding the values listed in the minimum 
and maximum fields indicates approximate values.

Add Enables you to add a sample file for an analysis contain-
ing data you wish to use for a background.

Remove Removes the selected file from the list; it does not delete 
the file. You can add the file back to the list using the 
Add push button if desired.   
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Zero Pressure Scale

This option enables you to zero the pressure transducer to atmospheric pressures; the 
Zero Pressure Scale dialog is displayed.

List All Generates a report of the window contents to the screen, 
enabling you to print or save the list.

Close Closes the dialog.

Start Click this push button to start the zeroing process. When 
the operation is complete, the dialog closes 
automatically.

Cancel Cancels the operation.
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Diagnostics

This option enables you to perform a diagnostic test to determine if the signal processing 
circuitry is operating properly. This test actually emulates an analysis sending electronic 
pulses through a series of predefined ranges. Your service representative may request this 
test when data results are inaccurate and you have been unable to resolve the problem. 
The data generated from this test may be insignificant to you as a user, but can be very 
helpful to your service representative. Your service representative may be able to view 
the results of this test and resolve the problem, eliminating downtime and repair costs.

This test generates a file to the 5390\Service\userdiag directory. Your service represen-
tative will request that you E-mail this file to him so that he may examine it. If E-mail is 
unavailable, you may print the report and fax it. Your service representative will provide 
you with the applicable destination information.

When you select Unit [n] > Diagnostics, the Service Test dialog is displayed:

View Allows you to view the current operation (operate), the 
instrument schematic, or the instrument log in the Ser-
vice Test dialog. Operate is the appropriate choice for 
this test.

Sequence Displays the test file number. This number is assigned 
automatically and incrementally sequenced by the soft-
ware each time a test is performed. This also serves as 
the name of the file that is generated to the userdiag 
directory, and will be appended with SVT. For example, 
the name of the file for the test shown in the above dia-
log is 0018.SVT.
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Report after test Select this option to have a report generated automati-
cally after the test; page 6-6 provides an explanation of 
output options.

If you do not select this option, you can still have a 
report generated from the report window.

Cancel Cancels the test.

Next Begins the test; displays the next view of the Service test 
dialog.

Report Contains a list of predefined pulse ranges. Unless other-
wise instructed, this choice should remain as Linear. 

Item [n[ Enables you to display data for the selected report as a 
Histogram and a Graph. 

Report Enables you to generate a report.

Cancel Cancels the test.

The following push buttons become enabled when the test is complete.

Repeat Repeats the test; not applicable for this test.
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Next Returns you to the first view of the Service Test window.

Close Closes the dialog.
539-42820-01 (Rev A) - Sep 2017                                                 6-35 



Elzone II 5390 Enable Manual Control
Enable Manual Control

Select this option to manually control the system. Manual control typically is only used 
for service issues; normal operation does not require manual control. If the instrument 
schematic is not displayed, select Show Instrument Schematic from the Unit menu.

When you enable manual control, the symbols for pumps and valves change color on the 
control screen to indicate manual operation. 

Use one of the following options to move among the system components depicted on the 
instrument schematic:

• click on the desired component
• use the Tab key or arrow keys to move to the desired component

Manual Control is disabled when an automatic operation is in progress.

Valves: Open = Green

Closed = Yellow

Pumps: On = Green
Off = Yellow
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A component is selected when it is surrounded by a dotted line. Each component has a 
shortcut menu displaying the operations available for that particular component. These 
menus may be accessed by right-clicking on the desired component, or by using the 
shortcut keys Shift + F9 when the component is selected.

Components on the instrument schematic are:

Volumetric pump The volumetric pump is optional and displays only when 
installed on the Elzone. If a volumetric pump is not 
installed, the fill valve is connected directly to the 
orifice.

The arrow indicates direction of flow. 

 indicates the syringe is emptying and resetting to 
the Start position (towards start) where it will fill. 

 indicates the syringe is filling (towards end). When 
in this position, liquid is being pulled from the outside of 
the orifice tube through the orifice for analysis, or 
through the Fill valve if open.

The emptying/filling sequence repeats until the 
requested volume is obtained.

Actions: Turn Off
Move to Start
Move to End
Move Volume
Move Steps

Move to Start empties the pump syringe and goes to the 
starting position.

Move to End fills the pump syringe, pulling liquid 
through the orifice for analysis, or through the Fill valve 
if open.

Arrow
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Volumetric pump

(continued)

Move Volume displays a dialog enabling you to specify 
flow direction, the total volume to move, and the flow 
rate.

Move Steps displays a dialog enabling you to specify 
flow direction, the number of steps to move, and the rate 
at which to move the steps. 

Air valve Supplies air to the system for draining the liquid; auto-
matically opens when you perform the draining 
operation.

Actions: Open
Close
Close All

Close All closes all valves and turns off the Servo valve.

Fill valve Allows filling of the orifice with liquid.

Actions: Open
Close
Close All

Close All closes all valves and turns off the Servo valve.

Arrow

Shows valve 
in a closed 
position.

Shows valve 
in an open 
position.
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Stirrer/Orifice tube A stirrer or optional hydropulser is used to maintain par-
ticle suspension in the sample beaker. The current speed 
is displayed in the icon.

Actions: Turn On (green)
Turn Off (yellow)
Increase Speed 
Decrease Speed
Set Speed
Set Stirrer Direction Up (stirrer only)
Set Stirrer Direction Down (stirrer only)

Set Speed displays the Stirrer Speed dialog enabling you 
to specify a speed for the stirrer (or hydropulser); the 
value you specify (and the operating speed) is displayed 
in the icon.

The speed range is 1 through 10; the higher the number, 
the faster the rotation. 

Sample Valve Allows the sample to flow through the orifice. This 
valve is also used during filling and draining operations.

Actions: Open
Close
Close All

Close All closes all valves and turns off the Servo valve

If the sample compartment is not closed, Door Open (in 
red text) is displayed above the valve. Both sample com-
partment doors should be closed during analysis.

Vacuum pump Provides vacuum for system operations.

Actions: Pump On (green)
Pump Off (yellow)
Fan On
Fan Off 

There is no icon associated with fan operations.

Stirrer

The icon displays 
in this manner if a 
hydropulser is 
being used.

Electrodes

Orifice tube Sample beaker
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Servo valve Regulates the system vacuum pressure.

Actions: Turn On
Turn Off
Vent
Set Target
Flow

Vent allows air into the system.

Set Target displays the Set Target dialog enabling you to 
specify a target differential pressure.

Flow displays the Flow dialog enabling you to specify 
flow requirements.

The choice you make enables its corresponding fields so 
that you can enter appropriate values.

Pressure reading This rectangular box located to the right of the vacuum 
pump displays the amount of pressure below 
atmospheric.

Actions: Zero Pressure Scale

Zero Pressure Scale simply zeroes the pressure scale, 
assuming that the current pressure is at atmospheric.
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Sensors There are two sensors displayed on the schematic; one 
for the waste container and one for overflow of the waste 
container.

Colors: White; indicates no liquid present at the 
sensor level

Blue; indicates liquid is present at the 
sensor level

Waste Represents the Waste container. The sensor to the right 
of the icon indicates the presence (blue) or absence 
(white) of liquid at the sensor’s height. If the waste sen-
sor displays blue, the waste container is full; the current 
operation will be canceled automatically. You must 
empty the waste container before proceeding.

Overflow The Overflow sensor is provided as a safety precaution 
in the event the Waste sensor did not detect a full con-
tainer. For example, the Waste sensor may not have been 
securely connected. If the Overflow sensor turns blue, 
the pump stops automatically to prevent liquid from 
reaching internal components. Terminate all operations 
and contact your Service Representative. 
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Show Instrument Schematic

Select this option to display a schematic of the Elzone analyzer. 

You can determine the state of the valves and pumps by color.

• Valves: Closed = White* Open = Green
• Pumps: Off = White* On = Green

*Closed and Off positions are yellow if manual control is enabled. Select Unit > Enable 
Manual Control to control components manually (refer to page 6-36 for a description of 
the components on the instrument schematic).
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Show Status

Select this option to show only the status window of an operation in progress.

You may wish to use this option if:

• You have an automatic operation in progress and you wish to edit a sample file, for 
example. This way, you can monitor the operation while performing another task.

• You have two units attached to your computer. You can select Show Status on each unit 
menu and view the status of the operations on both units at the same time.

The following items display in the status window:

Sample ID The path and name of the sample file being used with the 
current analysis.

Test The current test being used with the sample file; you can 
perform up to eight tests with each sample file. 

Flow Control The current plumbing operation: Draining, Filling, 
Flushing, Rinsing. Idle displays when a plumbing oper-
ation is not in progress. 

Data Collection The current operation in preparation for data collection 
or calibration: Optimizing Settings, Blockage Detec-
tion, Checking Blockage, Testing Conductivity, 
Collecting Data, Calibrating. Idle displays when an 
operation is not in progress. 
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Show Instrument Log

Select this option to display a log of recent analyses, calibrations, errors or messages, and 
conductivity details. By default, information for analyses and messages are retained 60 
days; calibration and conductivity information is retained 90 days. You may change the 
time for which this information is retained in the Unit section of the WIN5390.INI file.

You can choose the type of information to display in the window by selecting only the 
desired item(s). For example, check the Analysis box to display only analysis 
information.

Analysis 
Conductivity 
Calibration
Message 

These options enable you to choose the type of entries to 
display in the log. For example, if you select Analysis, 
only Analysis operations are displayed.

Add Log Entry Becomes enabled when you make an entry in the adja-
cent field. Entries display in the Log Report.

Report Enables you to display on the screen or print a report of 
log entries; the Log Report Settings dialog is displayed.
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Start Date Use this field to specify a date at which to begin listing 
entries. You can specify a start date using any of the fol-
lowing methods:

• Highlight the field (or press F2 to clear the field) and 
type in the desired date.

• Double-click in the field (or press F4) to display a cal-
endar to choose a date.

• Press F2 to clear the field, then F3 to insert the current 
date.

Copies Enabled when you choose Printer for the destination, 
allowing you to print up to four copies.

Destination Specify a report destination. 

Choices:  Screen, Printer, File

File name Enabled when you select File for the destination, enter a 
file name.

Use this set of left/right arrows to select a year.

Use this set of left/right arrows to select a month.

Click the desired date.
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Conductivity Report Enables you to display on the screen or print a report of 
conductivity for a selected orifice tube and electrolyte 
solution; the Conductivity Report Settings dialog is 
displayed.

The Orifice Tube and Electrolyte Solution drop-down 
lists enable you to choose the combination desired.

The remaining options function in the same manner as 
the Log Report (explained on previous page).
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Unit Configuration

Select this option to display software/hardware configurations for the selected analyzer. 
When you select Unit Configuration from the Unit menu, the Unit Configuration dialog is 
displayed.

 
Software Versions Displays the software versions for components being 

used by the analyzer.

Last analysis Displays the orifice and electrolyte solution used in the 
last analysis, or unknown. Also shows the calibration 
date of the orifice tube.

Calibration Displays calibration dates for components being used by 
the analyzer.

Options Indicates whether the volumetric pump is installed. Also 
displays the type of stirrer installed on the analyzer.

Configuration Displays the analyzer’s serial number and IP address. 
Also enables you to view details of the boards installed 
in the analyzer.
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Board ID Displays the Board ID dialog containing information on 
the circuit boards installed in the instrument; the Board 
ID dialog is displayed.

Use the Board drop-down list to choose the board for 
which you wish to view details.

Change Displays the Unit IP Setup dialog.

This dialog shows the IP address and Subnet mask that 
were assigned during installation. Do not edit these 
fields unless directed by a Micromeritics service 
representative.
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Calibration

The Calibration option provides a method of storing instrument calibration data. Your 
Micromeritics service representative may use this option to enter calibration data or per-
form component calibrations for future reference when servicing the analyzer.

This option is enabled only when the analysis program is operating in Service Test mode 
(refer to Service Test Mode, page 8-15 for additional information).

Service Test

Certain service tests are included in the operating program, but can be performed only 
with the assistance of a trained Micromeritics service representative. These tests are 
designed to provide your service representative with instrument readouts, as well as to 
assist him in troubleshooting potential problems and, perhaps, eliminating unnecessary 
repair services. This service strategy allows you to conduct expert tests in less time than it 
would take to be properly trained in servicing the instrument.

This option is enabled only when the analysis program is operating in Service Test mode 
(refer to Service Test Mode, page 8-15 for additional information).
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7.  REPORTS MENU

The options on the Reports menu enable you to generate reports on:

• sample analyses
• orifice tube calibrations
• statistical process control parameters
• historical particle size distribution

This chapter provides a description of these options, as well as examples (page 7-33) of 
some of the reports available with the Elzone program.

Description

Listed below are brief descriptions of the options contained on the Reports menu. 
Detailed descriptions follow this section.

Start Report Allows you to generate a report on a completed sample 
analysis. Page 7-3.

Close Reports Closes all open report windows. Page 7-6.

Open Report Enables you to open a saved report. Page 7-6.

Orifice Tube Calibration Allows you to generate a report on an orifice tube cali-
bration. Page 7-7.

SPC Report Options Allows you to specify the sample data to be included in 
SPC reports. Page 7-8.

Regression Report Allows you to generate a regression report. Page 7-11.
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Control Chart Allows you to generate a control chart report. Page 7-15.

PSD History Allows you to generate a particle size distribution his-
tory report. Page 7-19.
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Start Report

Select this option to generate a report on a sample analysis. The Start Report dialog is 
displayed.

File name The name you select from the Files list box is displayed 
in this field. If you select multiple files, only the last one 
selected is displayed.

Status This drop-down list determines the type of sample files 
displayed in the Files list window.

Choices: All, Analyzing, Complete, Entered

Refer to Table 2-2. File Status and Description, page 
2-11 for a description of the status types

Date Range Use this push button to specify a range of dates in which 
to display sample files. Refer to Selecting Files, page 2-
10 for a description of this push button.

Copies Enabled when you choose Printer, allowing you to print 
up to four copies of the selected report(s).
539-42820-01 (Rev A) - Sep 2017                                                 7-3 



Elzone II 5390 Start Report
Destination This drop-down list contains a list of output destinations.

Choices: File, Printer, Screen

Printer generates the requested reports to the printer 
designated as your default printer.

Screen generates the requested reports to the computer 
screen. When using this destination, you can customize 
reports with various options (refer to Onscreen Reports, 
page 7-22).

File generates tabular data to a text file which can be 
viewed with a text editor or other text file manipulation 
tool.

File name Enabled when you choose File as the destination, allow-
ing you to enter a name for your file (or you can accept 
the default).

Files list window Displays a list of the available sample files for the choice 
shown in the Status field and in the selected date range.

Directories Displays a list of available drives and directories. The 
drive and directory last accessed is displayed directly 
above the Directories list box.
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If you choose a single sample file, the Selected Reports dialog is displayed when you 
click OK. The reports selected are the ones you specified in the sample file. This dialog 
allows you to deselect reports or select additional ones.

Double-click on the report(s) you wish to select (or deselect). A check mark is placed 
before each selected report. Pressing the Spacebar performs the same function. After you 
make your report selection and click OK, the requested reports are sent to the specified 
destination.

If you choose more than one file, this dialog is not displayed. The reports you specified in 
each sample file will be generated and sent to the specified destination.

Check marks indicate 
selected reports.
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Close Reports

This option enables you to close all open report windows at one time. This avoids having 
to click Close on each report window. This option is unavailable if reports are being 
generated.

Open Report

This option enables you to open a report that was saved from the Report window; the 
Report window opens with an Open dialog positioned on top. 

After you navigate to the desired directory, select your file, and click Open, your report is 
displayed in the Report window.

Report Window
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Orifice Tube Calibration

This option enables you to generate a report on an orifice tube calibration; the Start Ori-
fice Tube Report dialog is displayed.

Instrument Drop-down list containing the serial number of the 
instrument(s) installed on the current computer. You can 
install two instruments on the same computer.

Orifice Tube Drop-down list containing the calibrated orifice tubes 
that exist for the selected instrument.

Calibration date 
and time

Displays the date and time of the calibration for the 
selected orifice tube.

Report settings The options in this group box enable you to choose out-
put criteria.

The Copies field is enabled when you choose Printer as 
the destination, enabling you to print up to four copies of 
the report.
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SPC Report Options

When you select SPC Report Options, the SPC Calculations dialog is displayed.

Test This drop-down list contains analysis choices for  SPC 
calculations.

Last reports statistics for the last analysis performed.

First reports statistics for the first analysis performed.

Average reports an average based on all tests  in the 
selected sample file(s).

Statistics Type Allows you to choose the type of statistics for which the 
SPC variables are to be calculated.

Distribution Type Allows you to choose the type of distribution data for 
which the SPC variables are to be calculated.

Arithmetic Statistics Allows you to choose the type of arithmetic statistics for 
which the SPC variables are to be calculated.

Statistics Displays a list of the variables available for SPC report-
ing; you may choose as many as you wish.

Displays the range 
for the selected 
field.
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Sample Displays the Sample SPC Options dialog, allowing you 
to select the sample parameters you wish to have 
reported.

Specific parameters can be designated for the fields 
labeled Parameter [n].

Analysis Displays the SPC Analysis Conditions Options dialog, 
allowing you to select the analysis conditions you wish to 
have reported.
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Sizes Displays the SPC Size Options dialog, allowing you to 
specify up to 10 sizes and 5 distribution types at which 
the cumulative percent finer (or coarser, depending on 
the selection in the Units dialog) is to be reported.

Percentiles Displays the SPC Percentile Options dialog, allowing 
you to specify the percentiles and distribution types for 
which the cumulative percent finer (or coarser, depend-
ing on the selection in the Units dialog) is to be reported.

Peaks Allows you to choose the peaks to include in SPC calcu-
lations; you can include up to 10 peaks. 
7-10                                                   539-42820-01 (Rev A) - Sep 2017



Regression Report Elzone II 5390
Regression Report

Select this option to generate a regression report. The regression report is used to deter-
mine the interdependency between two variables. Up to three dependent variables (Y-
axis) may be plotted against a single independent variable (X-axis). The degree of corre-
lation between the variables also is reported. The graphs for the regression report are 
scaled so that all three fit on a single page. If you choose less than three, the graphs are 
scaled to fill most of the page.


Show report title Select this option to have a title display on your report. 

Accept the default or enter a new title. You can enter up 
to 40 alphanumeric characters. 

Deselect this option to omit the report title.

Show graphic Select this option to have a graphic display above your 
report title. For example, you may wish to display your 
company logo. The graphic must be a bitmap (bmp) or 
enhanced metafile (emf).

Click Browse to choose the file, then use the Height and 
Width fields to specify a size. This image can be edited 
in the report window (when printed to the screen), or 
removed if desired.
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X- and Y-Axes 
Variable fields

Allows you to designate the X- and Y-axes variables. 
Click on the down arrow to display a list of variables. 
The variables in this list are the ones you specified in the 
SPC report options.

With this option, you can plot the regression of up to 
three Y-axis variables against the X-axis variable. The 
X-axis specifies the independent variable for the regres-
sion, while the Y-axes provide the dependent variables.

Axis Range Enables you to specify the beginning and ending values 
for the X- and Y-axis ranges. Data collected outside these 
ranges are not included in the plot. These fields are dis-
abled if you choose Autoscale.

Autoscale Allows you to have the X- and/or Y-axes scaled automat-
ically. When scaled automatically, both axes begin at 
zero. The analysis program uses the highest values col-
lected during analysis as the ending points.

Tabular report Enables you to generate tabular, as well as graphical, data 
of the included samples. A tabular report contains the 
numeric values contributed by each sample.

Label data Allows you to label the points on the plot to correspond 
with the values in the sample files.

Samples Displays the Regression Report Sample Selection dialog, 
allowing you to choose the sample files you wish to have 
reported.
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File name Use this field to limit the files displayed in the Available 
Files pane. For example; enter a*.smp to display only 
the files beginning with an a.

Status This drop-down list determines the type of sample files 
that display in the Available Files pane in the selected 
directory for all dates, or within the specified range of 
dates (using Date Range push button). Refer to Table 
2-2, page 2-11 for an explanation of the Status types.

Date Range Displays the Select Dates dialog so that you can specify 
a range of dates. Refer to page 2-10 for an explanation of 
this dialog

Use all files in
this directory

Select this option to include all files from the selected 
directory in the report.

Directories Lists the current directory. Use the directory window to 
navigate to a different directory (refer to page 2-11 for 
information on choosing a different directory).

Add Moves the selected file in the Available Files pane to the 
Selected Files pane. Alternatively, you can simply dou-
ble-click on the desired file(s). You can select multiple 
files by holding down Ctrl while making your selections. 
You can include up to 200 sample files.

Remove Removes the selected file from the Selected Files pane 
and places it back into the Available Files pane.
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Save As Default Saves the current definition of the report as the default.

Recalculate archived 
SPC results

Select this option to have archived SPC values recalcu-
lated. This ensures that any changes made to the SPC 
Report Options are included in the new report; however, 
it does lengthen the time required to generate the report.

Report Settings The options in this group box enable you to choose out-
put criteria.

The Copies field is enabled when you choose Printer as 
the destination, enabling you to print up to four copies of 
the report.

Report Generates the report.
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Control Chart

This option enables you to generate a control chart report which plots the changes in a 
statistic.

Show report title Select this option to have a title display on your report. 
Accept the default or enter a new title. You can enter up 
to 40 alphanumeric characters.

Deselect this option to omit the report title.

Show graphic Select this option to have a graphic display above your 
report title. For example, you may wish to display your 
company logo. The graphic must be a bitmap (bmp) or 
enhanced metafile (emf).

Click Browse to choose the file, then use the Height and 
Width fields to specify a size. This image can be edited 
in the report window (when printed to the screen), or 
removed if desired.
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X-axis Order By Enables you to choose the order in which X-axis statis-
tics are placed. You can have them placed by Time, File 
name, Date, Minutes, or Days.

Time places the files on the graph at numerical points in 
the order of the date/time the files are analyzed.

File name places the files on the graph at numerical 
points in alphanumeric order.

Date places the files on the graph at points representing 
the actual date/time the files are analyzed.

Minutes places the files on the graph at points represent-
ing the minutes that have elapsed from the first file 
placed on the list, which is the earliest-analyzed file.

Days places the files on the graph at points representing 
the number of days that have elapsed from the first file 
placed on the list, which is the earliest-analyzed file.

Graph [n] Displays the Control Chart Graph [n] Options dialog, 
allowing you to define the Y-axis of each graph. 

Statistic This drop-down list displays the SPC variables selected 
on the SPC Report Options dialog. The variable you 
choose will be plotted against time.

Autoscale Allows you to have the Y-axis scaled automatically. If 
you wish to specify a range, deselect this option and 
enter a range in the From and To fields.
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Center Line Displays placement options for the variable’s optional 
value. Choose Entered to specify placement of the line.

Limit Lines Displays the options available for limiting lines. You can 
have the lines placed at some multiple of the standard 
deviation or at specified positions (Entered).

When you select Entered, the High limit and Low limit 
fields are enabled, allowing you to enter appropriate 
values.

Tabular report Allows you to generate tabular, as well as graphical, data 
of the included samples. A tabular report contains the 
numeric values contributed by each sample.

Recalculate archived 
SPC results

Select this option to have archived SPC values recalcu-
lated. This ensures that any changes made to the SPC 
Report Options are included in the new report. It also 
lengthens the time required to generate the report.

Samples Displays the Control Chart Sample Selection dialog, 
allowing you to choose the sample files on which you 
wish to report. 

This dialog functions in the same manner as the Regres-
sion Report Sample Selection Dialog explained earlier in 
this chapter. Refer to page 7-12 if you need assistance on 
the fields of this dialog.
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Summary Statistics Allows you to select the statistics to display in the report.

Coefficient of Variation is the Standard Deviation
divided by the Mean.

Confidence Interval of the mean value (shown on the 
same line below the graph on the report). When you 
select this option, the Confidence Level field is enabled 
allowing you to enter the percentage.

Select Number of Samples to have the number of sam-
ples analyzed included in the report.

Save as Default Saves the current definition of the report as the default.

Report Settings The options in this group box enable you to choose out-
put criteria.

The Copies field is enabled when you choose Printer as 
the destination, enabling you to print up to four copies of 
the report.

Report Generates the report.
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PSD History

This option enables you to report a sequence of full particle size distribution graphs.


Show report title Select this option to have a title display on your report. 

Accept the default or enter a new title. You can enter up 
to 40 alphanumeric characters.

Deselect this option to omit the report title.

Show graphic Select this option to have a graphic display above your 
report title. For example, you may wish to display your 
company logo. The graphic must be a bitmap (bmp) or 
enhanced metafile (emf).

Click Browse to choose the file, then use the Height and 
Width fields to specify a size. This image can be edited 
in the report window (when printed to the screen), or 
removed if desired.

X-axis Order By Enables you to choose the order in which X-axis statis-
tics are placed. You can have them placed by Time, File 
name, Date, Minutes, or Days. Refer to page 7-16 for 
explanation of these options.

Samples Displays the PSD History Sample Selection dialog, 
allowing you to choose the sample files on which you 
wish to report. 
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This dialog functions in the same manner as the Regres-
sion Report Sample Selection Dialog explained earlier in 
this chapter. Refer to page 7-12 if you need assistance on 
the fields of this dialog.

Save as default Saves the current definition of the report as the default.

Report Settings The options in this group box enable you to choose out-
put criteria.

The Copies field is enabled when you choose Printer as 
the destination, enabling you to print up to four copies of 
the report.

Report Generates the report.
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Printed Reports

Headers

All printed reports (either to the screen or to a printer) contain a header displaying file 
statistics, as shown in the following example

The report header may contain a graphic (such as a company logo) and/or title if speci-
fied. The header also contains: 

• Sample and instrument statistics such as date and time of analysis, analysis 
conditions, and background data for tabular and graphical reports.

• Comments entered in the Comments window.

• Notes of any changes to the sample file which occur after analysis (excluded in 
summary reports).

• SPC and PSD report headers also display the range of dates of the selected samples 
as well as the current date. 
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Onscreen Reports

The report window containing onscreen reports provides many options for customizing 
and manipulating reports: 

• a tool bar
• shortcut menu options
• zoom feature
• axis cross hairs 

When reports are printed to the screen, they are printed in a window like the one shown 
below. Each requested report is listed in the Reports window above the tool bar; they are 
also indicated by selectable tabs across the top of the report header. To view a specific 
report, select its tab or select the report in the Reports window and click Show.

Header

List of 
Requested 
reports

Toolbar

Displays 
graphical (or 
tabular) data

Tabs display for each type of report generated.
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Tool Bar

Reports Contains a list of all requested reports.

Show Shows the selected report in the report window. If the 
report has been hidden, it and its associated tab will 
become visible.

Delete Deletes the selected report. A deletion confirmation dia-
log is displayed since this function cannot be undone. 
The deleted report(s) will have to be regenerated if 
deleted in error.

Hide Hides (removes) the selected report from the report win-
dow. The report’s associated tab is also removed.

Open Allows you to open a previously saved report file.

Print Displays a print dialog so that you can choose an appro-
priate printer for report output. A list of available reports 
is displayed in the window on the right side of the 
dialog.
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For convenience in selecting reports to print, push but-
tons are provided beneath the report window. Or, you 
can make your selection by clicking on the desired 
reports.  

Current Selects the report displayed in the report window.

Shown Selects only the shown reports; any reports that are not 
highlighted indicate they are hidden. You can still select 
hidden reports from this window to print.

All Selects all reports, including those that may have been 
hidden.

Clear Clears all selections

Save Saves all reports of the currently open file in a report for-
mat using the same name as the sample file, only with an 
.rep extension. If you wish to specify a name and/or spe-
cific reports to save, use the Save As push button. 
Reports saved in this format can be opened from the 
report window or using the Open Report option on the 
Reports menu. 
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Save As Allows you to save all or specified reports from the cur-
rently open file. The push buttons displayed on this dia-
log perform in the same manner as the print dialog 
(explained above).

Reports can be saved in three different formats:

• Report system (*.rep): Saved in a format which allows 
you to reopen the file using the Open push button on 
the Report window tool bar or the Open Report 
option on the Reports menu.

• Spreadsheet (*.xls): Saved in a format which can be 
imported into most spreadsheet programs.

• Ascii Text (*.txt): Saved in ASCII text, which can be 
imported into programs accepting this type of file.

Default Style Displays the Default Style dialog so that you can edit 
report defaults.

Fonts Contains a list of report elements for which the font can 
be edited. Simply highlight the desired element and click 
Edit; a font dialog is displayed so that you can specify 
the desired font and attributes.

Curve The items in this group box enable you to specify a thick-
ness for report curves and, when using histograms, the 
type of fill to apply.

Graph border 
line thickness

Enables you to specify a thickness for the border of the 
graph.

Load Loads the last saved defaults.
539-42820-01 (Rev A) - Sep 2017                                                 7-25 



Elzone II 5390 Printed Reports
Save Saves the changes as the defaults. If you do not click 
Save, the changes will apply to the current report set 
only. The next reports will revert to the defaults.

Close Closes the dialog and applies the changes. If you clicked 
Save, the changes become the defaults. If you did not 
click Save, the changes apply to the current report only.

Close Closes the report window.
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Shortcut Menus

Shortcut menus are accessed when you right-click on the tabular or graphical portion of a 
report. 

 Tabular Reports


Resize column Displays a dialog so that you can specify the width of the 

selected column (in inches).

Rename column Displays a dialog so that you can edit the name of the 
selected column. Use Ctrl + Enter to insert line feeds.

Move column Allows you to move the location of the selected column 
to the left or to the right.

Align column Enables you to right-align, left-align, or center the data in 
the selected column.

Hide column Displays a list of all columns, enabling you to select the 
one you wish to hide.

Show column Displays a list of all hidden columns, enabling you to 
select the one you wish to have shown again.

Column font Displays a Font dialog, allowing you to change font attri-
butes for the tabular data in the current report.

Header font Displays a Font dialog, allowing you to change font attri-
butes for column headers in the current report.
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 Graphs

Edit title Allows you to edit the table title and font.

Copy table as text Enables you to copy the entire table (column headers and 
data) and then insert it into another program. Columns 
are tab-delimited, allowing easy alignment.

Autoscale Sets the axis boundaries to autoscale, presenting the sig-
nal in full scale. 

Redraw Sets axis boundaries to its original view. This option is 
also used to remove cross-hairs.

In many cases, the Autoscale and Redraw options will show very little difference. 
Both options are also used to return the view to its original presentation after 
zooming a report or to remove cross hairs.

Show curve Allows you to show curves that have been hidden. This 
option is disabled (greyed) if no curves have been 
hidden.

Hide curve Allows you to hide (remove) unwanted curves.
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Edit curve Enables you to select a curve and edit its properties; the 
Curve Properties dialog is displayed.

Title Displays the title of the curve you are editing.

Style Drop-down list containing styles in which collected data 
can be displayed.

Curve Contains options for curves and points. You can: 

• choose a linear or Akima Spline interpolation for the 
curve (disabled when points is chosen)

• choose a style and color for curves and/or points

• specify a line thickness for curves

The options in this group box are disabled if Histogram 
is chosen from the Style drop-down list.

Histogram Allows you to specify the type of fill as well as the color 
when Histogram is chosen as the style for collected 
data. 

The options in this group box are disabled if Curve, 
Points, or Curve/Points is chosen from the Style drop-
down list.
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Edit axis Enables you to choose an axis and edit its properties; the 
Axis Properties dialog is displayed.

Title Displays the title of the axis you are editing; use the Title 
font push button to edit font attributes if desired.

Scale The items in this group box enable you to:

• choose a linear or logarithmic scale
• invert the scale 
• edit the autoscale values
• edit the attributes for the scale font 

Gridlines This drop-down list enables you to choose solid or dot-
ted grid lines, or you can choose None to omit grid lines.

Edit legend Displays the Legend Properties dialog, allowing you to 
edit the placement of the legend, as well as the legend 
font.
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Zoom Feature

A zoom feature is included with the report system so that you can zoom in to examine fine 
detail of the distribution. To use this feature, simply hold down the left mouse button and 
drag the mouse cursor (drawing a box) across the area you wish to view; then release the 
button. The enlarged area immediately fills the graph area. You can return to the normal 
view by right-clicking on the graph and selecting Autoscale or Redraw.

Edit Title Displays the Title Properties dialog, allowing you to edit 
the current graph’s title and font.

Copy as metafile Copies the graph and places it on the clipboard, allowing 
you to paste it into other applications accepting Win-
dows metafiles. 

Copy as text Copies the data used to generate the graph as a series of 
tab-delimited columns of text.
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Axis Cross Hair

A cross hair function is available so that you can view axis coordinates. To use this fea-
ture, simply left-click in the desired area of the graph.

Right-click in the graph area and choose Autoscale or Redraw from the shortcut menu to 
remove cross-hair lines and return to the normal view. Alternatively, you can click out-
side of the graph area.

Y-axis position

Point of Coordination

X-axis position
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Report Examples

This section contains examples of some of the reports available with the Elzone 5390 
analysis program.
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Combined Report
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Standard Class Size Table

This is an example of the first page of the Standard Class Size tabular report.
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Cumulative Percent Table
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Incremental Number Percent vs. Diameter Graph
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Incremental Volume Percent vs. Diameter
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Pulse Length Report
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Pulse Length vs. Particle Size
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Calibration Report

This report contains tabular data for the reference material and goodness of fit, as well as 
a graphical representation of the goodness of fit
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Options Report
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Sample Log Report
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8.  OPTIONS MENU

The Options menu contains options which allow you to configure the system to your lab-
oratory’s requirements. With the options on this menu, you can:

• Choose a sample file presentation; advanced, basic, or restricted mode
• Edit program defaults
• Specify data presentation modes
• Specify a directory for predefined parameter files

Description

Listed below are brief descriptions of the Options menu selections. Detailed descriptions 
are found later in this chapter.

Option Presentation Allows you to display the sample file dialog in the Basic, 
Advanced, or Restricted format. Page 8-3.

Sample Defaults Allows you to specify the parameters you wish to use 
when creating a sample and parameter files. Page 8-6.

Units Enables you to choose the manner in which to display 
units of measurement, pressure, and temperature. 
Page 8-12.

Invert size axis Enables you to invert the size axis. Page 8-12.
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Graph Grid Lines  Enables you to choose the type(s) of grid lines to show 
on your report. Page 8-13.

Sieve Table Allows you to specify defaults for sieve sizes. Page 8-14.

Check Orifice Tube and 
Liquid

Use this default option to have the program verify at the 
start of an analysis that the orifice tube and liquid in the 
current analysis match those of the previous analysis. 
Page 8-14.

Parameter Files 
Directory

Allows you to specify a location for predefined parame-
ter files when using the Basic and Restricted modes. 
Page 8-15.

Service Test Mode Enables Service Test Mode, which is used for trouble-
shooting and maintaining the analyzer. Page 8-15.
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Option Presentation

The sample editing dialogs for the Elzone analysis program may be presented in three 
different formats: Advanced, Basic, and Restricted. Each format displays sample infor-
mation and menu options differently.

• Advanced: displays all parts of the sample information file in a tabbed dialog 
similar to that of an index card file. You just click on the tab of the parameter you 
wish to edit. This format is used for customizing sample files.

• Basic: displays all parts of the sample file as a single dialog. This format is used to 
create sample files quickly by choosing from predefined parameter files. You can 
also switch to the Advanced format for editing parameters if desired.

• Restricted: displays in the same manner as the Basic format. Certain menu options, 
however, become disabled and you cannot switch to the Advanced mode. You must 
also enter a password to enter and exit this mode.

Advanced

The Advanced format presents all parts of the sample information file in a tabbed dialog. 
Each tab opens its associated dialog. When you have Advanced chosen as the presenta-
tion and you open or create a sample information file, the following dialog is displayed. 

The Advanced format can be used to edit sample parameters and customize files. This 
format typically is used by the more experienced operators or by the Lab Manager who 
creates files for Technicians.
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Basic

The Basic format presents the sample information file and its parameter files in a single 
dialog. You also have access to all menu options. When you have Basic chosen as the 
presentation and you open or create a sample information file, the dialog is displayed in 
this manner.

The Basic format is used to create sample information files using previously defined anal-
ysis conditions, material properties, and report options files. You can also switch to the 
Advanced format to edit values if desired.
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Restricted

The Restricted format is identical to the Basic format, except that certain menu options 
are disabled. You also cannot switch to the Advanced format. 

This format is password-protected and typically is used in laboratories where analysis 
conditions must remain constant, for example, in the pharmaceutical industry.

When you select Restricted, a dialog requesting a password is displayed:

Any password (up to 31 characters) can be used to enable the restricted format. The same 
password, however, must be used to exit the Restricted format. For example, if you enter 
“password” to enable the Restricted format, then you must enter “password” to exit the 
Restricted format before you can enable the Basic or Advanced format. 

If you forget the password, open the system INI file and navigate to the Private section. 
The current password will be shown immediately following “OptionPresentationPass-
word.” Make a note of the password, exit the INI file, and enter the password where 
requested. Do not attempt to delete the password in the INI file; doing this will not place 
the application out of Restricted mode.

The Restricted 
format does not 
allow you to 
switch to the 
Advanced format.
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Sample Defaults

This option allows you to specify default parameters for sample information files and 
parameter files. This option is presented in two formats: Advanced and Basic. The values 
you specify for the Basic format also apply to the Restricted format. The values you spec-
ify for parameters of the Advanced sample information file serve as the parameter file 
defaults. For example, the values specified for the Analysis Conditions portion of the 
Advanced sample file display as the defaults for a newly created Analysis Conditions file. 

Advanced

When you select Sample Defaults while in the Advanced format, the Elzone Sample 
Defaults dialog is displayed.

Sequence Number Allows you to specify a default sequence for the sample 
file name. The number you specify is incrementally 
sequenced each time you create a sample file. It is the 
number that appears in the File name field when you 
select File > Open > Sample information.

• Use numbers, letters, or other printable characters, 
such as dashes. At least three numbers must be 
included.

• Use up to eight characters.
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Sample
 

Allows you to enter an additional identification that pro-
vides more information than the sample file name.

In the field on the left, you can edit the prompt for Sam-
ple. For example, you may prefer to use Test or Material. 
You can enter up to 20 characters.

In the field on the right, you can specify a format for the 
sample identification.

• Use numbers, letters, or other printable characters, 
such as dashes.

• Maximum number of characters is 42, plus the $ sym-
bol.

• Include the automatically generated file name as part 
of the identification by using the $ symbol where you 
wish to have the sequence number appear.

For example, if the sequence number is 000-001, enter 
the identification as follows:

   Lab #25 - $

The resulting sample identification for the first sample 
information file would be:

   Lab #25 - 000-001

for the second:

           Lab #25 - 000-002, and so on.

Operator
Submitter
Bar Code

These fields contain the name (or other identification) of 
the operator, submitter, and bar code number. 

The names of the prompts (the fields on the left) can be 
changed to display differently if desired. For example, if 
bar code information is not used, you may wish to label 
this field as Lot Number, or remove the label completely 
and use the field for additional descriptive information.

In the fields on the right, enter the operator and submitter 
names you wish to use as the defaults.
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Operator
Submitter
Bar Code
(continued)

• Include the automatically generated file name as part 
of the identification by using the symbol $ where you 
wish to have the sequence number appear. Refer to the 
example in the previous section.

• Maximum number of characters for the prompt is 20.

• Maximum number of characters for the identification 
is 42, including the $ symbol.

• Omit any desired field from appearing on the sample 
information file by selecting Omit.

User Parameters The fields in this group box are used primarily for SPC 
(Statistical Process Control) reporting. They are used to 
specify characteristics of the sample or its manufacturing 
process.

Once specified, these parameters display on the sample 
editor and in the SPC Sample Options dialog (accessed 
through the SPC Report Options dialog).

These fields can also be used to record analysis condi-
tions or sample information so that it can be printed on 
the Summary report.

Select Omit if you do not wish to use these fields; this 
will prevent them from displaying on the sample infor-
mation dialog.

Dilution Factor Enables you to enter the ratio of sample volume to elec-
trolyte volume. This value can be easily determined using 
the following formula:

Mass Concentration Enter a value to represent the amount of sample you typ-
ically use in your analysis. A more accurate value can be 
entered at the time of analysis or after the analysis is 
complete.

Comments Use this window to record comments about the sample or 
its analysis conditions. Any comments you enter here are 
displayed in the header of the report.

Replace All Enables you to replace the values in the current file with 
the values from an existing file. After the values have 
been copied into the file, you can edit them as desired.

DF
sample volume  electrolyte volume+

sample volume
----------------------------------------------------------------------------------------------------=
8-8                                                    539-42820-01 (Rev A) - Sep 2017



Sample Defaults Elzone II 5390
Click on each remaining tab of the Advanced sample information dialog to establish 
parameter defaults. The values you specify for these defaults serve as the defaults for 
independent parameter files as well. Refer to the following sections if you need assistance 
on the fields of the parameter dialogs:

• Analysis Conditions, page 5-13
• Material Properties, page 5-23
• Report Options, page 5-25 

Basic

When you select Sample Defaults while in the Basic format, the Sample Defaults dialog 
is displayed in this manner. The defaults you specify using this format also apply for the 
Restricted format.

Sequence Number Allows you to specify a default sequence for the sample 
file name. The number you specify is incrementally 
sequenced each time you create a sample file. It is the 
number that appears in the File name field when you 
select File > Open > Sample information.

• Use numbers, letters, or other printable characters, 
such as dashes. At least three numbers must be 
included.

• Use up to eight characters.
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Sample
 

Allows you to enter an additional identification that pro-
vides more information than the sample file name alone.

In the field on the left, you can edit the prompt for Sam-
ple. For example, you may prefer to use Test or Mate-
rial. The maximum number of characters is 20.

In the field on the right, you can specify a format for the 
sample identification.

• Use numbers, letters, or other printable characters, 
such as dashes.

• Maximum number of characters is 42, plus the $ sym-
bol.

• Include the automatically generated file name as part 
of the identification by using the $ symbol where you 
want the sequence number to appear.

For example, if the sequence number is 000-
001, enter the identification as follows:

   Lab #25 - $

The resulting sample identification for the first 
sample information file would be:

   Lab #25 - 000-001

for the second:

           Lab #25 - 000-002, and so on.

Replace All Enables you to replace the values in the default sample 
file with values from an existing sample information file. 
An Open-type dialog is displayed allowing you to choose 
the file. After the values have been copied into the file, 
you may edit them if desired. 
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Analysis Conditions Drop-down list containing the analysis conditions files 
included with the software, as well as any you may have 
created on your own. Choose the file you wish to have as 
the default.

The number of tests, stirrer speed, and stirrer direction 
display as specified in the selected Analysis Conditions 
file; you may edit these options if desired. Any changes 
you make to these options will override the ones speci-
fied in the file; however, it does not change the original 
Analysis conditions file. 

Rinse Displays rinsing options specified in the selected analysis 
Conditions file. You can edit these selections if desired. 
Any changes you make will override the selections in the 
file; however, it does not change the original Analysis 
conditions file.

Report Options Drop-down list containing the report options files 
included with the software, as well as any you may have 
created on your own. Choose the file you wish to have as 
the default.

Reports to Generate Contains a list of available reports; the ones selected are 
those chosen in the selected Report Options file. You 
may edit the selections if desired. Any changes you make  
will override the selections in the file; however, it does 
not change the original Report options file.

Material Properties Drop-down list containing the material properties files 
included with the software, as well as any you may have 
created on your own. Choose the file you wish to have as 
the default.
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Units

This menu command displays the Units Selections dialog which allows you to choose the 
manner in which to display units. 
 

Invert Size Axis

Select this option to invert the size axis.
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Graph Grid Lines

Graph Grid Lines enables you to choose the type(s) of grid lines to show on your reports; 
the Graph Grid Lines dialog is displayed.

X-Axis
Y-Axis

Enables you to choose Major and/or Minor lines to 
display in printed reports for the Logarithmic and Linear 
scales. 

If you deselect these items (remove the check marks), 
your report will not display grid lines.

Grid Line Style Allows you to choose the type of grid line to display if 
grid lines are being shown.
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Sieve Table

Displays the Sieve Table allowing you to specify default sieve sizes for sieve data.

To select sizes, move to the desired size, then double-click the left mouse button or press 
Spacebar. A sieve size is selected when it is preceded by a check mark. 

Check Orifice Tube and Liquid

Select this option to have the analysis program check at the beginning of each analysis to 
verify that the orifice tube and liquid specified in the sample file match the ones used in 
the previous analysis. If the tube and liquid do not match, an error message is displayed.

Indicates the size is 
selected.
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Parameter Files Directory

This option allows you to select the location for the predefined Analysis conditions, 
Materials properties, and Report options files displayed in the drop-down lists on the 
Basic and Restricted Sample Information dialogs. The current directory specified for 
parameter files is displayed above the directory window.

The default directory is param and includes several parameter files supplied with the 
analysis program. If you specify a different directory, these files will not be included in 
the drop-down lists unless you copy (or move) them to the new directory.

If you wish to continue to use the param directory for parameter files, it will display as 
the default when saving parameter files.

Service Test Mode

Certain service tests are included in the operating program, but can be performed only 
with the assistance of a trained Micromeritics service representative. These tests are 
designed to provide your service representative with instrument readouts, as well as to 
assist him in troubleshooting potential problems and, perhaps, eliminating unnecessary 
repair services. This service strategy allows you to conduct expert tests in less time than it 
would take to be trained in servicing the instrument properly.

When you select Service Test Mode from the Options menu, a dialog prompting you to 
enter a password is displayed. This password can be provided only by your service rep-
resentative; therefore, you will not be able to enter Service Test Mode and perform these 
tests without his guidance.
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9.  TROUBLESHOOTING AND MAINTENANCE

The Elzone II 5390 analyzer has been designed to provide efficient and continuous ser-
vice. However, in order to obtain the best results over the longest period of time, certain 
maintenance and service procedures should be followed. This chapter contains informa-
tion regarding common operational problems and corrective action, and maintenance and 
service procedures.

If you encounter a problem that is not covered in this chapter, contact your Micromeritics 
service re;-presentative.

Troubleshooting

The following table lists some solutions for common operational problems that may be 
incurred.

Table 9-1. Common Operational Problems

Problem Reason Solution

No liquids flow when 
the valves are open; the 
vacuum pump is oper-
ating properly.

Possible valve damage. Using the instrument sche-
matic, ensure that valves are 
open and that the pump is oper-
ating. Then contact your 
Micromeritics service 
representative. 

Sizes are incorrect 
when analyzing refer-
ence material.

The orifice may be partially 
blocked.

Clean the orifice tube. Refer to 
Cleaning Orifice Tubes, page 
9-9.

The orifice may have changed 
size or may be cracked.

Replace the orifice tube.

The sample you analyzed did 
not represent the reference 
sample.

Prepare a new sample or use 
another reference material.

The wrong calibration data 
were used.

Ensure that the correct calibra-
tion and setup data were used.

Air bubbles are stick-
ing to the inside of the 
orifice tube around the 
orifice.

The surface of the orifice tube 
may not be clean.

Clean the orifice tube; refer to 
Cleaning Orifice Tubes, page 
9-9.
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Problem Reason Solution

There is a high back-
ground count on 
electrolyte.

The electrolyte may be 
contaminated.

Filter the electrolyte.

Front and/or side panel doors 
are open.

Ensure that the doors are 
securely closed.

The orifice tube may be 
cracked.

Check the orifice tube; replace 
if necessary.

Noise from electronics, power 
line, or radio frequency (RF) 
may be causing interference.

Have an electrician check for 
noise on the power line or for 
RF noise. 

Noise from CRT monitor may 
be causing interference.

If possible, place the monitor to 
the left side of the analyzer 
where it will be away from the 
sample compartment. If not 
possible, place the monitor at 
least two feet away from the 
sample compartment.

Use an LCD monitor if 
available.

Instrument is unable to 
measure conductivity 
within the normal 
range.

There is no electrolyte in the 
sample beaker.

Fill the beaker with electrolyte.

The external electrode is not in 
the sample beaker.

Place the electrode in the 
beaker.

The external electrode is not 
plugged in securely.

Ensure that the plug is securely 
seated in the connector.

The orifice is blocked. Use one (or more) of the fol-
lowing options on the Unit 
menu to clear the orifice tube:

• Clear Blockage
• Flush System
• Drain System; if you use this 

option, be sure to refill the 
system

• Fill System

Faulty circuit board. Contact your Micromeritics 
service representative.

The orifice tube is not filled 
completely.

Fill the orifice tube.
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Problem Reason Solution

System won’t fill. Waste container lid may not be 
securely screwed onto the 
container.

Tighten lid on waste container, 
then try to fill the system.

Supply tube may not be sub-
merged in the Supply container.

Be sure the supply tube is com-
pletely submerged in the supply 
liquid.

Leak in plumbing system. Access instrument schematic 
and enable manual control. 
Right-click on servo valve; set 
target to 100. Turn on servo 
valve and pump. When target 
reaches 100, open sample 
valve. If vacuum drops signifi-
cantly, a leak is indicated. Call 
your Micromeritics service 
representative. 

Valves may not be functioning 
properly.

Call your Micromeritics ser-
vice representative.

Vacuum is unable to reach the 
target vacuum.

See below. 

Vacuum does not reach 
target.

Calibration files may have 
become corrupted.

Reinstall calibration files (refer 
to Reinstalling Calibration 
Files, page 4-19). If you are 
still unable to reach the target, 
call your Micromeritics service 
representative.

Filters to servo valve may be 
blocked.

Call your Micromeritics ser-
vice representative.

Vacuum pump may be faulty. Call your Micromeritics ser-
vice representative.
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Preventive Maintenance

Table 9-2 lists the preventive maintenance procedures you should perform to keep your 
system operating at peak performance. Instructions for each procedure follow the table.

Table 9-2. Preventive Maintenance Schedule

Maintaining Orifice Condition

A clean, undamaged orifice jewel is essential for collecting valid data. Contaminated sur-
faces or obstructions cause signal noise and false pulse amplitudes. Check the orifice 
daily for changes.

The orifice tube may remain connected to the analyzer when not in use. When not in use, 
immerse the orifice tube in clean water or detergent rinse. If this practice is not followed, 
evaporate buildup and/or slow-to-wet active sites on orifice surfaces will cause signal 
noise or false amplitude.

The following practices will help keep the orifice in proper condition and help detect 
potential problems.

Storing Orifice Tubes

If the orifice tube is removed from the analyzer, store it as follows:

1. Clean the orifice tube (refer to Cleaning Orifice Tubes, page 9-9).

2. Store the orifice tube in a dust-free container.

Maintenance Required Frequency

Maintain orifice condition, page 9-4 Daily

Clean the sample area, page 9-6 Daily

Clean the system, page 9-6 Monthly

Replace the air filter, page 9-8 Monthly

Clean the orifice tube, page 9-9 Monthly
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Preventing Orifice Blockages

Sample materials are seldom sources of fibers or debris in sufficient amount to cause fre-
quent blockages. If blockages do occur due to sample materials, you can “scalp off” 
debris by wet-sieving the prepared suspension through a clean mesh that is roughly 75% 
of the orifice diameter.

At all times, there must be no substantial source of dust or debris:

• in the outer surface of the orifice tube, or inner surface of the sample beaker
• on the operator’s hands or clothing
• on the instrument or bench-top
• in the ambient air

A good technique is to filter the electrolyte properly through a 0.2-m microporous mem-
brane. Clean all surfaces in contact with this filtered electrolyte with detergent and then 
rinse two to three times with the filtered electrolyte.

Do not use towels to dry sample beakers. Keep sample beakers covered or inverted on a 
clean surface.

Stress Cracking of Orifice Jewel

The orifice jewel seal is a ceramic bonding of synthetic sapphire and glass which with-
stands virtually all chemicals. By nearly matching thermal expansion coefficients, the 
bonding is strong but can, in time, develop stress cracks in the glass around the jewel, 
which may cause a noise signal. Repeated cracking will require remount of the jewel in 
new glass or replacement of the orifice tube.

Check the orifice jewel periodically for signs of cracking. The illustrations below show 
the jewel portion of the orifice tube. The illustration on the left shows a jewel in good 
condition while the one on the right shows a jewel that has begun to crack.

This is a jewel in good 
condition.

This is the jewel of the same 
orifice tube; note how it is 
beginning to crack.

Cracking
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Cleaning the Sample Area

For this procedure you will need the following:

• Lint-free cloth
• Isopropyl alcohol (IPA), mild detergent, or hydrogen peroxide solution

Use a clean, lint-free cloth to wipe up spills as they occur. 

All surfaces of the analyzer should be kept clean and dry at all times. You may use a 
clean cloth, dampened with IPA, a mild detergent, or a 3% hydrogen peroxide solution to 
clean the outer casing of the analyzer.

Cleaning the System

You should clean the Elzone system (internal glassware) at least every 30 days.

For this procedure, you will need the following:

• a sample beaker of water
• 500 - 1000 mL beaker of water
• 500 - 1000 mL beaker of soapy water

1. Install an orifice tube onto the sample port.

2. Place a sample beaker of water on the sample stand, then raise the sample stand. Be 
sure the tube is submerged.

3. Disconnect the Supply tube from the side of the analyzer, then remove the tube from 
the bottle allowing any contents to drain back into the Supply bottle.

4. Reattach the Supply tubing to the side of the analyzer; place the other end of the 
tubing into the 500 - 1000 mL beaker of water.

Your system may require cleaning more often, depending on the type of sample 
being analyzed.
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5. Select Unit > Rinse to display the Rinse dialog.

Select Drain and fill and enter 1 in the Rinses field (as shown in the dialog).

6. Click Start; the dialog closes automatically when the rinsing operation is complete.

7. Remove the Supply tube from the 500 - 1000 mL beaker of water, then place it into 
the 500 - 1000 mL beaker of soapy water.

8. Select Unit > Rinse to display the Rinse dialog again; ensure that Drain and fill is 
selected; this time, enter 2 in the Rinses field.

9. Click Start; the dialog closes automatically when the rinsing operation is complete.

10. Remove the Supply tube from the 500 - 1000 mL beaker of soapy water. Rinse the 
end of the tube thoroughly to remove any soap residue, then place it back into the 500 
- 1000 mL beaker of water.

11. Select Unit > Rinse to display the Rinse dialog again; ensure that Drain and fill is 
selected; this time, enter 3 in the Rinses field.

12. Click Start; the dialog closes automatically when the rinsing operation is complete.

13. Remove the Supply tube from the 500 - 1000 mL beaker of water and place it into the 
Supply container.

14. Lower the sample stand and remove the sample beaker of water.
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Replacing the Air Filter

The air filter should be replaced every 30 days (more often in environments with 
increased levels of dust).

1. Remove the filter by inserting a pointed object, such as a flat-blade screwdriver, into 
the outer edge of the retaining cover; then pop off the cover. You do not have to 
remove the screws.

2. Discard the old filter and replace with a new one from your accessories kit.

3. Replace the retaining cover.

Insert screwdriver 
here.

Do not remove these screws.
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Cleaning Orifice Tubes

Orifice tubes must be kept clean to ensure accurate analysis results. Follow the procedure 
below to clean an orifice tube when:

• the orifice tube will not be used for at least one week
• air bubbles are forming on the inside of the orifice tube
• at least once a month when the orifice tube is in use

You will need the following items to perform this procedure:

• Scrub brush (provided in the accessories kit)
• Rubber gloves
• Detergent (citrus-based detergents are recommended; they are easier to rinse and 

leave less residue)
• Nitric acid
• Acetone

1. Protect your hands with rubber gloves.

2. Use detergent and the scrub brush to scrub the inside of the tube, then scrub across 
the outside of the jewel.

Do not touch or breathe vapors from the solvents used in this procedure. Failure 
to observe these precautions could result in a health hazard. Refer to the Nitric 
Acid MSDS and the Acetone MSDS for proper handling instructions. Dispose of all 
solvents appropriately.

Do not attempt to clean the orifice with a hard or pointed object or by immersing 
the orifice tube in an ultrasonic cleaner. Doing so could damage the orifice jewel.
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3. Rinse off the detergent with water.

4. Rinse the inside and outside of the tube with acetone.

5. Let the tube dry and store it, or place it on the analyzer.

Orifice tubes should be cleaned on a monthly basis as follows:

1. Perform steps 1 through 4 (above).

2. After rinsing with acetone, rinse with water. Make sure all acetone is rinsed off.

3. Place the tube in a nitric acid solution, which can be concentrated or diluted. Be sure 
to fill half the tube with the nitric acid solution.

4. Soak the tube for at least one hour. You can soak the tube overnight or over a 
weekend if desired.

5. Rinse the tube with water to remove completely all acid.

6. The tube is ready to be placed on the analyzer or you can rinse it with acetone and 
allow it to dry for storage.
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Clearing Blockages

Occasionally, a particle may become lodged in the orifice and cannot be cleared through 
the use of the software. Perform the following steps to manually clear a blockage from 
the orifice.

1. Click Stop on the Analysis window (if not stopped by the software) to stop the 
analysis.

2. Lower the sample stand to gain access to the orifice tube.

3. Using the bent orifice brush provided in the accessories kit, brush the orifice area of 
the tube. Then rinse the outside of the tube to remove any debris that may have 
remained from the brush.

4. Raise the sample stand; click Continue to restart the analysis.

• If the orifice is still blocked, proceed to the next step.

• If the orifice is unblocked, continue with the analysis.

5. Lower the sample stand to gain access to the orifice tube.

6. Using the larger orifice tube brush provided in the accessories kit, brush the orifice 
area of the tube. Then rinse the outside of the tube to remove any debris that may 
have remained from the brush.

7. Raise the sample stand click Continue.

• If the orifice is still blocked, proceed to the next step.

• If the orifice is unblocked, continue with the analysis.

8. Lower the sample stand and remove the sample beaker.

9. Select Unit > Drain to drain the system.

Bent brush

Straight brush
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10. Remove the orifice tube and clean it thoroughly (refer to Cleaning the Orifice Tube, 
page 9-9 for instructions).

11. After cleaning the tube, check the orifice to see if it is unblocked; a good procedure 
for doing this is:

a. Rinse the tube with cold tap water.

b. Holding the tube underneath the faucet, fill completely until it forms a meniscus 
at the top of the tube.

c. Place your index finger over the top of the tube and press downward; this will 
spew water out of the orifice if the tube is unblocked. You may have to hold the 
tube against a darker background to obtain a clear view of the stream of water.

12. Reinstall the orifice tube.

13. Prepare a new beaker of electrolyte and place it on the sample stand.

14. Raise the sample stand, submerging the orifice tube in the beaker.

15. Select Unit > Fill to fill the system with electrolyte.

16. Prepare a fresh sample mixture and restart the analysis.

If the orifice is still blocked, call your Micromeritics Service representative.
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Installing the Hydropulser

The hydropulser and stirrer are installed in the same location, the back wall of the sample 
compartment. 

These instructions are assuming you have a stirrer currently installed on your analyzer.

1. Ensure that the sample stand is in its lowest position.

2. Grasp the propeller and pull downward to remove it from its rubber connector.

3. Gently pull downward on the external electrode to remove it from its red connector.
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4. Turn the four captive thumb screws counterclockwise to loosen the stirrer assembly. 

5. Slide the stirrer assembly out and store in a secure location for future use.

6. Insert the hydropulser assembly, ensuring that the back plate of the hydropulser 
assembly slides into the two slots inside the opening.

7. Make sure the hydropulser assembly is flush with the analyzer back panel; this 
ensures that the connector on the back plate of the hydropulser plugs into the 
connector inside the analyzer.

8. Turn the four captive thumb screws clockwise to tighten.
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9. Gently slide the external electrode back into its red connector.

10. Use the clip to attach the hydropulser tube to the orifice tube when performing an 
analysis.

Retaining clip
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Cleaning the Hydropulser

The hydropulser tube should be cleaned daily between sample analyses and more thor-
oughly on a monthly basis, or when the hydropulser is not to be used for long periods of 
time.

Daily

Clean the hydropulser tube after each analysis and at the end (or the beginning) of the 
work day.

1. Place a beaker of clean electrolyte on the sample platform.

2. Raise the sample platform until the orifice tube, electrode, and hydropulser tube are 
submerged (as shown above).

3. Enable manual control and use the instrument schematic to turn on the hydropulser. 

a. Double-click on the stirrer icon; the icon is green when it is on. 

b. Allow the electrolyte to cycle through the tube for approximately 10 seconds

c. Double-click on the icon to turn the hydropulser off; the icon is yellow when 
turned off.

4. Proceed with the next step if you are ready to load the sample. If you are not ready to 
load the sample, allow the glassware to remain submerged in the electrolyte.
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5. Fill a squeeze bottle with clean, filtered electrolyte or water and thoroughly rinse the 
hydropulser tube, the orifice tube, and the electrode. Do not squeeze electrolyte up 
into the hydropulser tube.

6. Place your sample into the beaker and start your analysis.

Monthly

The hydropulser tube should be removed and thoroughly cleaned on a monthly basis. It is 
good practice to perform this procedure on the first of each month so it will be easy to 
remember.

1. Lower the sample platform.

2. Remove the retaining clip from the orifice tube; it is not necessary to remove it from 
the hydropulser tube.

3. Grasp the tube and remove it from its barbed fitting.     

Do not squeeze electrolyte up into the hydropulser tube. Liquid may get into the 
hydropulser assembly and damage the assembly, or cause erratic results. Remove 
the tube, clean, and dry it thoroughly if this occurs.
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4. Place the tube into a beaker of diluted detergent, then place the beaker into an 
ultrasonic bath for approximately five minutes.

If an ultrasonic bath is not available, use a pipette or a syringe attached to the end of 
the tube; cycle the detergent solution in and out of the tube at least ten times.

5. Flow water through the tube until all detergent is completely removed.

6. Allow the tube to dry completely. Pour IPA through the tube to speed the drying 
process.

7. Reattach the hydropulser tube to the barbed fitting.

8. Perform the steps given for Daily cleaning in the previous section.
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10.  ORDERING INFORMATION

The Elzone II 5390 system components and accessories can be ordered using one of the 
following methods: 

• Call our Customer Service Department at (770) 662-3636
• Access our web site at www.micromeritics.com
• Contact your local sales representative

When ordering, please use the information provided below to place your order:

Part Number Item and Description

538-61704-01 Stirrer, medium propeller;  enables you to maintain dispersion of 
samples. The stirrer provides a rotary movement, the speed of 
which is specified in the software.

538-61704-02 Stirrer, large propeller

539-34020-00 Hydropulser; provides gentle agitation and fits neatly in small 
vials, such as a blood counting vial, when sample quantity is lim-
ited. The hydropulser uses a fluid pulsing movement, the speed of 
which is specified in the software.    

539-33602-00 Camera, for viewing the orifice jewel; includes a backlight and 
mounting hardware

539-33604-00 Volumetric pump, enables you to measure particle concentration 

539-33610-00 Orifice Tube Kit;  includes one 19-m orifice tube, reference 
materials, and reference booklet

539-33611-00 Orifice Tube Kit; includes one 30-m orifice tube, reference 
materials, and reference booklet

539-33612-00 Orifice Tube Kit; includes one 48-m orifice tube, reference 
materials, and reference booklet

539-33613-00 Orifice Tube Kit; includes one 76-m orifice tube, reference 
materials, and reference booklet

539-33614-00 Orifice Tube Kit; includes one 95-m orifice tube, reference 
materials, and reference booklet

539-33615-00 Orifice Tube Kit; includes one 150-m orifice tube, reference 
materials, and reference booklet

539-33616-00 Orifice Tube Kit; includes one 190-m orifice tube, reference 
materials, and reference booklet
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Part Number Item and Description

539-33617-00 Orifice Tube Kit; includes one 300-m orifice tube, reference 
materials, and reference booklet

539-33618-00 Orifice Tube Kit; includes one 380-m orifice tube, reference 
materials, and reference booklet

004-16840-00 Reference material, 1 m; approx. 8 mL

004-16840-01 Reference material, 2 m; approx. 8 mL

004-16840-02 Reference material, 3 m; approx. 8 mL

004-16840-03 Reference material, 5 m; approx. 8 mL

004-16840-04 Reference material, 10 m; approx. 8 mL

004-16840-05 Reference material, 20 m; approx. 8 mL

004-16840-10 Reference material, 30 m; approx. 8 mL

004-16840-06 Reference material, 40 m; approx. 8 mL

004-16840-07 Reference material, 60 m; approx. 8 mL

004-16840-08 Reference material, 100 m; approx. 8 mL

004-16840-09 Reference material, 160 m; approx. 8 mL

538-61703-00 Beaker, 150 mL, contoured

538-61703-01 Beaker, 240 mL, contoured

538-61706-00 Sample vial, 25-mL polystyrene with flat sides and snap cap

003-51130-01 Fuse, 1.0 Amp, 5x20 mm Slow-Blow (230/240 VAC) 

003-51131-00 Fuse, 2.0 Amp,  3 AG, Slow-Blow  (100/120 VAC)

004-25474-00 O-ring, -013, Kalrez®; for sample port

004-54615-00 Brush, for cleaning orifice tubes

004-54616-00 Brush, bent, for cleaning orifice jewel

004-32209-00 Squeeze bottle, 500 mL, for cleaning glassware

004-61039-01 Bottle, 2 liters, for supply liquid

004-32117-00 Bottle, 2 liters, for waste liquid

539-32804-00 Tubing, for waste bottle

539-32805-00 Tubing, for supply bottle

539-60804-01 Sensor cable, for supply liquid
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Part Number Item and Description

539-25856-00 Clip, hydropulser tube

539-32803-04 Tubing, flexible, hydropulser

539-32802-08 Tubing, rigid, hydropulser

004-27015-00 Air filter (rear panel), package of 10

539-42801-00 Operator’s manual

539-33020-00 Software package; includes current version of software and 
operator’s manual

539-33022-00 Software package, CFR Part 11 Confirm, includes current version 
of software and operator’s manual
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2200 Series Elzone II 5390
A.  ERROR MESSAGES

This appendix contains a numerical listing of the error messages associated with the Elzone 
program.

2200 Series

2201- Cannot execute report subsystem.

2400 Series

2401- FATAL ERROR: (Error message)

2430- Error accessing file (file name), error code = (number)

The 1000-series error messages (used primarily for software testing) are not 
included in this appendix. These errors should not occur during normal operation. 
If you receive a 1000 series error message or an error message not listed in this 
appendix: record the error message, make backup copies of any files involved, 
then contact your service representative.

Cause: The software for the report subsystem has been corrupted and cannot 
be started.

Action: Reinstall the software.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Action A: Hard disk may be damaged.

Action A: Run diagnostics.

Action B: A software error occurred when the file was accessed.

Action B: Contact your service representative.
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2431- Error writing file (file name), error code = (number).

2432- Invalid response from MMI 'FILE_READ' request.

2433- New entries have been found in this directory. Refresh the directory 
information?

2434- File (file name) - Subset # (number) wrote wrong amount of data.

2436- Path specification (path name) is invalid.

Cause: The hard disk does not have enough space left to perform the opera-
tion.

Action: Copy files not used regularly from the hard disk to diskette, delete 
them from the hard disk, and then try the operation again.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: Files have been added to this directory by some function other than the 
analysis program.

Action: Click Yes to update the directory information with data from each new 
file. This operation may take a few minutes. Click No if you do not 
want to spend the time updating the directory information. 

This option may be feasible if a large number of files has been copied 
into the directory and you know the name of the file you wish to 
access.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this error 
message.

Cause: You entered an invalid path name and/or extension.

Action: Enter a valid path name (including the proper extension) and press 
Enter.
A-2                                                        539-42820-01 (Rev A) - Sep 2017



2400 Series Elzone II 5390
2437- File (file name) does not exist.

2438- Disk drive (letter): is inaccessible.

2439- Could not register file.

2440- Subset not found.

2441- Seek within file failed.

2442- Had header in subset file.

2443- Subset owner denied access.

2444- Not a valid file format.

2445- Subset wrote the wrong amount of data.

2446- Error reading data.

2447- Error writing data.

2448- File directory (path name) is invalid. Resetting to the installation directory.

2449- This field does not contain a valid file specification.

Cause: You entered an invalid file name.

Action: Enter the name of an existing file or select a file name from the Files 
list window.

Cause: You selected a disk drive that is presently inaccessible.

Action: Ensure that the disk in the disk drive is not write-protected.

Cause: An unexpected error occurred when you tried to access a data file.

Action: Contact your service representative.

Cause: A working directory specified in the .INI file is invalid. The directory 
may have been deleted or moved to a different location.

Action: The installation directory will be substituted. The next time you open a 
file, use the Directories list to navigate to the correct directory.

Cause: You entered an invalid file name.

Action: See the description of file naming conventions in your operating sys-
tem or Windows manual and reenter the name.
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2450- Sample Defaults may not be edited while this operation is in progress. Do you 
wish to save and close the Sample Defaults edit session?

2452- Attempt to write MICATTR.DIR in read only mode. File (file name).

2453- Attempt to append MICATTR.DIR in read only mode. File (file name)

2454- Too many selections for a print-to-file operation. Only the first (number) selec-
tions will be processed. Please reselect the remainder.

2455- Too many selections for an export-to-file operation. Only the first (number) 
selections will be processed. Please reselect the remainder.

2456- Insufficient file handles available. Application cannot continue.

2457- Results cannot be displayed. More than (number) windows are currently dis-
playing or printing results.

Cause: You are in the process of initiating an automatic analysis (an analysis in 
which sample files are created using the defaults) while editing the 
defaults.

Action: Finish your edit session of the defaults and close the dialog. Then 
restart the automatic analysis.

Cause: The Read-Only attribute is turned on in the application's 
MICATTR.DIR file (this file exists in each folder containing sample or 
parameter files).

Action: Use Windows Explorer to access the folder containing the 
MICATTR.DIR file and disable the Read-Only option.

Cause: You selected too many files for this operation.

Action: Select only the number of files specified in the message.

Cause: You have more than 50 files open at the same time.

Action: Refer to the manual for your operating system and set the limit for 
open files to 50 or greater.

Cause: You have too many windows open in the application.

Action: Close some of the open windows.
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2458- An instrument is performing a critical operation. Wait a few moments before 
exiting the application.

2459- An instrument is busy. A delay in restarting this application could result in loss 
of new data. Continue with program Exit?

2460- Fatal Communications error on (Unit n - S/N: nnnn)

Cause: You are attempting to exit the application while the instrument is per-
forming a critical operation. This operation must be completed before 
the application can be stopped.

Action: Wait a short time and attempt to stop the application again.

Cause: You tried to exit the analysis program while an analysis is in progress. 
While this is possible, the data collected while the analysis program is 
inactive will not be permanently recorded until the analysis program is 
restarted. A power failure to the instrument could cause some data to 
be lost.

Action: If your are not concerned with potential loss of data if a power failure 
occurs, click Yes to continue with the exit; click No if you wish to wait 
for the analysis to finish.

Cause: There was a fatal error in the serial communications between the anal-
ysis program and the analyzer. All displays for the analyzer will close.

Action: Ensure that the analyzer is connected to the computer on the commu-
nications port configured by the Setup program. Stop and restart the  
analysis program. If the restarted application cannot establish commu-
nications with the analyzer, turn the analyzer off, then back on. If this 
error persists, contact your Micromeritics service representative.
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2461- No instruments are in operation. This application will unconditionally 
terminate.

2477- Unit n - S/N: nnnn did not properly initialize.

2478- Error copying sequential data segment.

Cause: An analyzer must be active for the application to operate. The initial-
ization of the analyzes configured with the Setup program has failed. 
The application stops.

Action A: Usually this message is preceded by another message giving the reason 
for the analyzer's failure to initialize. See the instructions for that mes-
sage. 

Action B: Ensure that the analyzer is attached to the computer. Verify that the 
analyzer has the power switch in the ON position. If the application 
continues to fail in its attempts to initialize the analyzer, contact your 
service representative.

Cause A: There were communication problems between the computer and the 
analyzer.

Action A: Check the communication cables and make sure they are connected 
securely.

Cause B: You selected Cancel during initialization.

Action B: None required.

Cause: An internal processing and/or hardware error occurred while accessing 
a portion of a sample file.

Action: Confirm that the media being accessed does not contain errors; for 
example, you may wish to use a utility such as ScanDisk. 

Contact your service representative if you continue to receive this mes-
sage.
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2479- Unit n - S/N: nnnn The instrument is busy performing an operation of which 
this application is unaware. Do you want to cancel?

2480- File (name) cannot be analyzed. It is currently being edited.

2481- Error accessing the sample information file (name).

2482- File (file name) cannot be opened for writing. It is already in use.

2483- An analysis cannot be performed on (file name). It is open for editing and con-
tains errors.

Cause: During initialization, the instrument was found to be analyzing, but the  
analysis program has no record of it. 

Action: Click Yes to cancel the analysis and synchronize the analysis program 
with the instrument’s status. Click No to abort the initialization and 
allow the analyzer to continue the analysis.

Cause: You attempted to start an analysis using a file that is open for editing.

Action: Finish editing the file, save and close it; then restart the analysis.

Cause: An unexplained error prevents you from accessing this file.

Action: The hard disk drive may be corrupt. Run diagnostics.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.

Cause: You attempted to start an analysis using a file that contains errors and is 
open for editing.

Action: Finish editing the file, save and close it; then start the analysis.
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2484- The edit session for (file name) must be saved before the analysis. Save 
changes and proceed with the analysis?

2486- Cannot construct (name) report type. Program will terminate.

2487- Cannot start report generator. Error code (number). Program will terminate.

2488- File (file name) cannot be opened for editing. It is already in use.

2489- File (file name) cannot be opened for writing. It is already in use.

Cause: You attempted to start an analysis using a file that contains unsaved 
changes and is still open.

Action: Click Yes to save the changes and proceed with the analysis. Click No 
to cancel the analysis and continue editing the file.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this mes-
sage.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative if you continue to receive this mes-
sage.

Cause: The file you specified is already open for editing.

Action: Check the windows list to locate the other edit session.

Cause: The file you specified in a Save As operation is already open for edit.

Action: Select a different file for the Save As operation.
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2490- No '.INI' file present. Application will terminate.

2491- Highlighted fields contain errors. Please correct the errors before closing.

2492- This field's entry is invalid.

2493- An entry is required for this field.

2494- Value is out of the valid range.

Cause: The ASCII file containing initialization information and system 
options information used during program startup does not exist.

Action: Contact your Micromeritics service representative.

Cause: The highlighted fields contain invalid entries. You will not be able to 
close the dialog until you correct the errors.

Action: Check the entries, correct the errors, and close the dialog. 

Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

Cause: This field contains an invalid entry.

Action: Enter or select an appropriate value.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter or select a value within the indicated range. 
The valid range is shown in the information bar across the bottom of 
the dialog.
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2495- Value is out of the valid range. Enter a value between (value) and (value).

2496- Invalid number.

2497- This field contains an invalid character.

2498- The requested change to the Sample’s status is invalid at this time.

2499- Sequence number must contain at least 3 digits.

Cause: The value you entered in the highlighted field is outside the valid range 
of values.

Action: Check the entry and enter a value between the range indicated. The 
valid range is shown in the information bar across the bottom of the 
dialog.

Cause: The number you entered in the highlighted field is invalid.

Action: Check the entry and enter or select a valid number.

Cause: You entered an invalid character in the highlighted field.

Action: Check the entry and enter valid characters.

Cause: A request to change the file’s status (for example, from automatically 
collected to manually entered data) could not be done.

Action: Contact your service representative if you continue to receive this mes-
sage. Record the name of the sample file in which the problem 
occurred.

Cause: You attempted to enter a sequence number that did not contain at least 
three digits.

Action: Enter a sequence number that contains at least three digits.
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2500 Series

2500- All sample files that can be created using the sequence number pattern already 
exist. You may want to modify the next sequence number.

2501- System resources have reached a dangerously low level. Please close some 
windows to avoid the loss of data.

2502- Error writing to file (name) during print. Error code: (number).

2503- Error converting file (name). Could not create DIO intermediate file.

Cause: No more sample information files can be created using the currently 
specified file sequence number.

Action: Select Options > Sample Defaults from the main menu and enter a 
new sequence number.

Cause: A large number of windows are open and consuming the system 
resources available to all applications.

Action: Close one or more windows on the screen. Contact your Micromeritics 
service representative if you continue to receive this error message.

Cause: An error occurred in the file being written to during a print operation.

Action: Ensure that there is sufficient space on the drive containing the file.

Cause A: Insufficient space is available on the hard disk. The DIO file is placed 
in the directory specified by the TEMP environment variable.

Action A: Determine if there is sufficient space on the drive where the TEMP 
directory is located.

Cause B: An internal processing and/or hardware error has occurred.

Action B: Contact your service representative.
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2504- Cannot create output file for sample (name).

2505- Error Logger cannot be initialized. Error code (number). Program will exit.

2506- (sample file) Output device (name) is not installed. Printing cannot be 
accomplished.

2507- Error opening file (name) for printing. Error code: (number).

2508- (sample file) Overlay file (name) was not found. It will not be included in the 
reports.

2509- (sample file) Error opening file (name): (error). Reports cannot be produced.

Cause: Insufficient space may be available on the hard disk.

Action: Ensure that sufficient space is available. Contact your service repre-
sentative if you continue to receive this message.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your service representative.

Cause: The selected output device is not installed.

Action: Install the device using the Control Panel, Printers operation.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.

Cause: The specified overlay file could not be found.

Action: Ensure that the file specified as an overlay does exist.

Cause: An error occurred while the program was opening a file necessary to 
the report operation.

Action: Use the name given in the error message to investigate. Contact your 
service representative if you continue to receive this error message.
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2510- (sample file) Error parsing reports from file (name). Reports cannot be 
produced.

2511- Print job (name) has been cancelled due to insufficient disk space. Delete 
unnecessary files and restart the report.

2512- Print job (name) has been canceled.

2513-  Unable to read the calibration file (file name).

Cause A: One or more data entry fields in the sample file may contain an invalid 
character (such as a single quote or double quotes).

Action A: Review the data entry fields (for example, the Sample field) and 
remove the invalid character.

Cause B: The system was unable to create the usual temporary files during the 
report, possibly due to insufficient disk space.

Action B: Check the space available on the had disk.

Cause C: An internal processing error occurred.

Action C: Contact your service representative.

Cause: The disk drive does not have enough space for the temporary file 
required by the Windows Print Manager. Therefore, printing of the 
requested report has been canceled.

Action: Delete unnecessary files from the disk. You will require at least five 
megabytes of free space for normal operation.

Cause: The requested print job was canceled at your request.

Action: None required.

Cause: The calibration file selected for loading is not valid or cannot be read.

Action: Confirm the media containing the alleged calibration file has no prob-
lems.
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2514-  Unable to write the calibration file (file name).

2515- Warning: Changing the calibration information will affect the performance of 
the instrument. Only qualified service personnel should do this. Do you wish to 
proceed?

2516- Warning: Keeping a backup copy of the calibration data is recommended by 
Micromeritics. Would you like to do so now?

2517- Canceling this dialog will reset the calibration state to what it was when this 
dialog was first opened. Are you sure you want to cancel?

Cause: An attempt to Save calibration data has failed due to possible media 
problems

Action A: Confirm the media containing the alleged calibration file has no prob-
lems.

Action B: Choose an alternate media to Save the calibration data.

Cause: You have started the process of performing a calibration operation.

Action: Calibration operations should only be done by or under the direction of 
qualified service personnel.

Cause: You have performed a calibration operation; a backup copy is recom-
mended.

Action: Perform a calibration Save operation.

Cause: You clicked Cancel on the calibration dialog; this will cancel the cal-
ibration you just performed and revert back to the previous calibration.

Action: If the calibration operation was successful, click Accept.
A-14                                                        539-42820-01 (Rev A) - Sep 2017



2500 Series Elzone II 5390
2519- Entered or merged data must have at least two points with unique mass per-
cent values.

2521- Unable to program controller.

2522- Invalid controller application file.

2523- Programming the controller failed.

2524- CRC check failed on programming controller.

2525- Unknown error programming controller.

2526- Controller download was not successful.

2527- Controller CRC error on boot block.

2528- Controller DRAM error.

2529- Controller Com1: error.

2530- Controller Com2: error.

2531- Controller debug port error.

Cause: The entered and/or merged data included in the report being attempted 
does not have sufficient unique mass percent values.

Action: Review the entered or merged data. There must be at least two points 
and the mass percent value of the last point must be different than the 
mass percent value of the first point.

Cause: A hardware malfunction has occurred.

Action: Contact your local Micromeritics service representative.

Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the analysis program.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative if you continue to 
receive this error message.
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2532- The instrument contains a different software version. Do you want to reset it?

2533- Analyzer initialization failed.

2534- Error opening file (name) for printing. Error code: (number)

2547- The instrument is busy. Exiting the application will result in the termination of 
the analysis. Continue with program exit? (Yes, No)

2549- Error accessing online manual file (name).

Cause: The application has discovered a different version of software operat-
ing in the analyzer. 

Action: If there are no analyzers other than the one connected to the computer, 
select Yes and allow the updated software to load.

Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics service representative if you continue to 
receive this error message.

Cause: An error occurred in the selected file for print output.

Action: Ensure that sufficient space is available on the drive containing the file.

Cause: You attempted to exit the application while an analysis is in progress. 

Action: If you are not concerned with cancellation of the analysis, click Yes to 
continue the exit; otherwise select No and allow the analysis to finish.

Cause: You were unable to open the online manual.

Action: Exit the application and reinstall the software. The manual and/or 
reader may have been accidentally deleted. Reinstalling the software 
will reinstall the manual and reader.
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2550- Attempts to acquire the instrument’s status timed out.

Cause: Communication between the analyzer and application have been 
unsuccessful for more than one minute.

Action A: Exit the application, then restart it.

Action B: Ensure that the ethernet cable is securely connected to the computer 
and analyzer.

Action C: Exit the application. Turn off the analyzer, then turn it back on. Restart 
the application. If communication problems persist after all actions 
have been taken, contact your Micromeritics representative.
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4200 Series

4200- An error occurred while loading the application control information. Data entry 
cannot be performed. (Code # <number>)

4201- No reports selected.

4202- No valid data to report.

4203- The reference file is not valid. ‘Diff. from ref.’ column was deleted.

Cause: An internal error occurred while read control information was being 
read from a disk file.

Action: The disk on which the application is installed may have failed. Contact 
your Micromeritics service representative and report the code number 
given in the message.

Cause: You failed to select reports in the Reports to Generate list box. No 
output could be produced.

Action: Ensure that at least one report is selected for the sample and re-submit 
the sample for reporting.

Cause: The selected analysis in the sample file activated for reporting does not 
contain any valid data.

Action: If the sample is still analyzing, wait until enough data have been col-
lected to allow reporting. If the sample is complete, an error or operator 
intervention stopped this analysis before sufficient data could be col-
lected. The analysis may be deleted from the file.

Cause: You requested a tabular report with Difference from reference 
selected as one of the columns. This quantity cannot be computed 
because the reference file is invalid.

Action: If no reference file has been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.
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4204- Coarser specification file is not valid. ‘Out of spec.’ column was deleted.

4205- Finer specification file is not valid. ‘Out of spec.’ column was deleted.

4206- The tabular report has no valid columns selected. No report produced.

4207- No valid data are available for this report. No report produced.

Cause: You requested a tabular report with Out of Specification selected as 
one of the columns. This quantity cannot be computed because the 
coarse specification file is invalid.

Action: If no specification file has been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.

Cause: You requested a tabular report with the Out of Specification selected 
as one of the columns. This quantity cannot be computed because the 
finer specification file is invalid.

Action: If no specification file has been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.

Cause: You requested a tabular report with all of the columns set to none.

Action: Edit the options for that table and select a variable in at least one col-
umn of the table.

Cause: The selected test in the sample file activated for reporting does not con-
tain any valid data.

Action: If the sample is still analyzing, wait until enough data have been col-
lected to allow reporting. If the sample is complete, an error or operator 
intervention stopped this analysis before sufficient data could be 
collected. The analysis may be deleted from the file.
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4208- An overlay file is not valid. It was not included in the report.

4209- The reference file is not valid. The report was not produced.

4210- Coarser specification file is not valid. The report was not produced.

4211- Finer specification file is not valid. The report was not produced.

Cause: The sample file you selected for overlay does not exist or contains 
invalid data.

Action: From the Report Options dialog, click Overlays and remove the sam-
ple file.

Cause: You selected the Difference from Reference graph; it cannot be com-
puted because the reference file is invalid.

Action: If a reference file has not been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.

Cause: You selected the Out of Specification graph; it cannot be computed 
because the coarse specification file is invalid.

Action: If a specification file has not been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.

Cause: You selected Out of Specification graph; it cannot be computed 
because the fine specification file is invalid.

Action: If a specification file has not been specified, select one from the Report 
Options dialog and re-run the reports. If a file has been specified, 
ensure that it contains valid information.
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4212- At least one report item must be selected. Press Cancel if you do not want a 
report.

4213- Are you sure you want to delete the test?

4214- The reference file is not valid. The overlay was not produced.

4215- Coarser specification file is not valid. The overlay was not produced.

4216- Finer specification file is not valid. The overlay was not produced.

Cause: You failed to select reports in the Reports to Generate list box. No 
output could be produced.

Action: Ensure that at least one report is selected for the sample and re-submit 
the sample for reporting.

Cause: You selected Delete on the Collected Data editor.

Action: Click Yes to remove the indicated test from the sample file. Click No 
to have the test remain in the sample file.

Cause: The reference file specified in the current file does not exist.

Action: On the Report Options dialog, click Reference and choose a different 
file.

Cause: The file specified for the coarser specification does not exist.

Action: On the Report Options dialog, click Specification and choose a dif-
ferent file.

Cause: The file specified for the finer specification does not exist.

Action: On the Report Options dialog, click Specification and choose a dif-
ferent file.
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4217- No table entries are within the distribution limits.

4218- In order to use (option) you must select a Statistics Type or Arithmetic Statis-
tics Type.

4219- In order to use (option) you must select a Distribution Type.

Cause: Truncate to distribution limits is selected on the report editor, but 
table entries are not within the range of the collected data.

Action: Edit the table entries, or deselect Truncate to distribution on the 
report editor.

Cause: You requested a Summary report, but did not select a Statistics Type.

Action: Edit the Summary report and select at least one Statistics Type.

Cause: You requested a Summary report but did not select a Distribution Type.

Action: Edit the Summary report and select a Distribution Type.
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6000 Series

6001- DataAcq: Peak width read timed out. Height: (number)

6002-  DataAcq: Peak data sequence error. Height: (number) Width: (number) Status: 
(number)

6003-  DataAcq: Current D/A Converter Timed Out.

6004-  DataAcq: Test Pulse D/A Converter Timed Out.

6005-  DataAcq: Low Threshold D/A Converter Timed Out.

6006-  DataAcq: Electrode Current A/D Converter Timed Out. Status: (number)

6007- DataAcq: Preamplifier A/D Converter Timed Out. Status: (number)

6008- DataAcq: Amplifier A/D Converter Timed Out. Status: (number)

6009- DataAcq: Electrode Voltage A/D Converted Timed Out. Status: (number)

6010- DataAcq: Preamplifier Digital Potentiometer Timed Out.

6011- DataAcq: Amplifier Digital Potentiometer Timed Out.

6012-  DataAcq: Log Gain Digital Potentiometer Timed Out.

6013-  DataAcq: Log Reference D/A Converter Timed Out.

6030- Plumbing: Servo D/A Converter Timed Out.

6031- Plumbing: Stirrer D/A Converter Timed Out.

6032- Plumbing: A System Reset has occurred.

6050- Flow Control: Supply liquid reservoir is low.

Cause: An electronic malfunction has occurred.

Action: Contact your Micromeritics Service representative.

Cause: An electronic malfunction has occurred.

Action: Contact your Micromeritics Service representative.

Cause: Your supply bottle is almost empty.

Action: Refill the supply bottle with electrolyte.
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6051-  Flow Control: Differential pressure out of range for zero. Actual: (number) 
mmHg Allowed: (number) mmHg

6052-  Flow Control: Home detected out of range at (number) of steps, maximum 
allowed (number) of steps.

6053- Flow Control: Waste liquid reservoir full. It must be emptied before continuing.

6054- Flow Control: Waste liquid full sensor not present. It must be installed before 
continuing.

6055- Flow Control: Waste liquid reservoir overflowed. It must be emptied before 
continuing.

Cause: The pressure transducer is operating out of specification.

Action: Contact your Micromeritics Service representative.

Cause: The volumetric pump is operating out of specification.

Action: Contact your Micromeritics Service representative.

Cause: The waste bottle is almost full of expended electrolyte.

Action: Empty the waste bottle and reattach it to the analyzer before beginning 
another operation.

Cause: The sensor for the waste container is not properly installed.

Action: Insert the sensor cable and ensure that it is fully seated into the con-
nector. If you continue to get this message, contact your Micromeritics 
Service representatives.

Cause: Liquid has gotten into the tubing from the waste bottle to the vacuum 
pump. Further operation could damage the vacuum pump.

Action: Contact your Micromeritics Service representative.
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6056- Flow Control: Waste liquid overflow sensor not present. It must be installed 
before continuing.

6058- Flow Control: Differential pressure out of range. Actual: (number) mmHg 
Expected: (number) mmHg

6059- Flow Control: Volumetric pump home position found at (number) steps.

6060- Flow Control: Volumetric pump home position not found at (number) steps.

6061- Flow Control: Volumetric pump position (number) steps exceeds maximum 
position (number) steps.

6062- Flow Control: Volumetric pump movement stopped. Move was (number) steps 
at (number) steps/second, direction (number), stopped after (number) seconds.

6063- Flow Control: Volumetric pump movement timed out. Move was (number) steps 
at (number) steps/second, direction (number), stopped after (number) seconds.

6064- Flow Control: Flow operation superseded. Old operation code: (number)  New 
operation code: (number)

Cause: The overflow sensor is not properly installed.

Action: Contact your Micromeritics Service representative.

Cause: The differential pressure system is unable to set the required pressure.

Action: Verify that the waste bottle top is tightly screwed onto the bottle, and 
that the two vacuum lines are securely attached to the fittings on the 
waste bottle top and to the fittings on the side panel of the instrument.

Verify that an orifice tube is securely attached to the orifice tube port, 
and that the orifice is immersed in a beaker of electrolyte.

Restart the operation; if the message persists, contact your Micromer-
itics Service representative.

Cause: The volumetric pump has malfunctioned.

Action: Contact your Micromeritics Service representative.

Cause: A new flow operation was started before the previous operation had 
completed. The previous operation will not be completed.

Action: None required.
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6080- Data Collection: Measured current out of range. Actual: (number) mA  Min: 
(number) mA  Max: (number) mA

6081- Data Collection: Test pulse amplitude out of range. Measured: (number) mA 
Set: (number) mA

6082- Data Collection: Test pulse frequency out of range. Measured: (number) Hz Set: 
(number) Hz

6083- Data Collection: Test pulse width out of range. Measured: (number) microsec-
onds Set: (number) microseconds

6084- Data Collection: Preamp signal out of range. Actual: (number) V  Min: (number) 
V  Max: (number) V

6085- Data Collection: Amplifier signal out of range. Actual: (number) V  Min: (num-
ber) V  Max: (number) V

6086- Data Collection: Log range out of range. Measured: (number) to (number) Set: 
(number) to (number)

6087- Data Collection: Low threshold out of range. Measured: (number) V Set: (num-
ber) V

6088- Data Collection: Failed to automatically clear blockage. The blockage must be 
cleared manually before continuing.

6089- Data Collection: Orifice Conductivity too low. Minimum = (number) S/m, Actual 
= (number) S/m. Orifice Resistance = (number) k ohms.

Cause: An electronic malfunction has occurred.

Action: Contact your Micromeritics Service representative.

Cause: The orifice could not be cleared automatically.

Action: Manually clear the orifice; refer to Clearing Blockages, page 9-11.

Cause A: The orifice may be blocked.

Action A: Select Unit [n] > Clear Blockages. If this fails, manually clear the 
blockage; refer to Clearing Blockages, page 9-11.

Cause B: The orifice tube and internal tubing are not filled with electrolyte, 
therefore electrical contact is not being made.

Action B: Verify that the supply bottle has sufficient electrolyte, then select Unit 
[n] > Flush to flush the orifice tube and internal tubing with electro-
lyte.
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6092- Data Collection: Particle detection rate of (number) particle per second is 
excessive. Data collection is cancelled.

Cause C: The electrolyte conductivity is too low for the size orifice in use.

Action C: Use an electrolyte with higher conductivity; for example, a solution 
with a higher concentration of salt.

Cause A: The doors to the sample compartment are open.

Action A: Securely close the doors to the sample compartment. The doors act as  
shields to prevent outside electronic noise sources from interfering 
with data collection.

Cause B: The orifice is blocked. 

Action B: Select Unit [n] > Clear Blockages. If this fails, manually clear the 
blockage; refer to Clearing Blockages, page 9-11.

Cause C: The signal settings are inappropriate for this orifice tube and electro-
lyte and, therefore, causing electronic noise.

Action C: Click Optimize Settings on the Sample Analysis dialog to automati-
cally determine signal settings that will minimize electronic noise.

Cause D: The particle concentration is too high.

Action D: Reduce the particle concentration by at least a factor of 2, and repeat 
the analysis.
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6093- Data Collection: Cannot measure Orifice Conductivity; Conductivity may be too 
high. Maximum Conductivity = (number), minimum Orifice Resistance = 
(number) 

Cause A: The orifice may be blocked.

Action A: Select Unit [n] > Clear Blockages. If this fails, manually clear the 
blockage; refer to Clearing Blockages, page 9-11

Cause B: The orifice tube and internal tubing are not filled with electrolyte, 
therefore electrical contact is not being made.

Action B: Verify that the supply bottle has sufficient electrolyte, then select Unit 
[n] > Flush to flush the orifice tube and internal tubing with electro-
lyte.

Cause C: The electrolyte conductivity is too high for the size orifice in use.

Action C: Use an electrolyte of lower conductivity; for example, a solution with a 
lower concentration of salt.
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6100 Series

6100- Unable to establish the TCP connection with the instrument.

6101- Configured serial number does not match instrument.

6102-  The instrument (S/N) is not calibrated.

Cause: A communications problem between the computer and the analyzer 
has occurred.

Action A: Check the cable connection between the computer and the analyzer.

Action B: Select Unit [n] > Unit configuration and verify that the TCP/IP con-
figuration for the computer and the analyzer are correct.

Action C: Exit the Elzone application, and turn off the analyzer. Then turn on the 
analyzer and restart the application. If the problem persists, contact 
your local Micromeritics representative.

Cause: The instrument serial number specified for this unit during installation 
does not match the serial number recorded in the attached instrument. 

Action: Attach the correct instrument, or run the Setup program and install the 
calibration files for the correct instrument serial number. The instru-
ment serial number is located on the back panel of the analyzer.

Cause: You attempted to begin an analysis, but the instrument is not fully cal-
ibrated.

Action A: Exit the analysis program and turn off the analyzer. Turn the analyzer 
back on and restart the analysis program. Select Unit > Unit config-
uration to verify that calibrations are installed (calibration items will 
contain dates). If no information displays for the calibration items, go 
to Action B. 

Action B: Run the setup application and reinstall the calibration files. Refer to 
Reinstalling Calibration Files, page 4-19. 
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6110- An automatic analysis mode is enabled. The sample defaults may not be edited 
while this mode is active.

6111- Orifice tube not calibrated with this instrument. Do you want to proceed with 
analyses anyway?

6112- Backgrounds require full resolution data storage. Do you want to select full 
resolution data storage?

6113- Volumetric flow rate is unavailable. Do you want to use differential flow rate 
instead?

Cause: One of the automatic analysis modes is active. Sample defaults cannot 
be edited while this mode is active.

Action: End all automatic analysis modes on all attached units and try again.

Cause: You selected an orifice tube that has not been calibrated to this instru-
ment.

Action A: Stop the analysis and calibrate the orifice tube.

Action B: Choose a calibration tube that has been calibrated.

Action C: Continue with the analysis, then calibrate the orifice tube after the anal-
ysis. For the sample file used with the analysis, select Data Setup on 
the Collected Data dialog and update the calibration. 

Cause: You attempted to run a background with a file that does not have Full-
resolution selected for the data format.

Action: Full-resolution data are required for a background. Click Yes to have 
the software automatically select this option. Click No to stop the back-
ground analysis.

Cause: You attempted to begin an analysis using a file in which Volumetric 
Flow Rate was selected as the Flow Control but you do not have the 
optional volumetric pump installed.

Action: Click Yes to have the software automatically select the Differential 
Flow Rate option. Select No to stop the analysis and edit the current 
file or choose another one. 
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6114- You chose to use the most recent background but no background is available. 
Choose Yes to proceed without background data.

6115- Background subtraction is selected but no background data is specified. Select 
a data file from the Data Setup dialog if you wish to subtract a background.

6116- Selected orifice tube or liquid is different from last used on this unit. Do you 
want to change the orifice tube or liquid before continuing with the analysis?.

6117- Please raise the beaker stand and press OK to continue, or Cancel.

Cause: You selected Use most recent background on the Data Setup dialog 
(from the Analysis Conditions dialog) but a background has not been 
performed on this instrument for the selected orifice tube and liquid. 

Action: Click Yes to proceed without a background. Then run a background 
after the analysis. Open the sample file and click Data Setup on the 
Collected Data dialog.  From the Data Setup dialog, click Browse and 
choose the background file.

Click No to stop the analysis so that you can run a background, then 
restart the analysis.

Cause: You requested background subtraction but you did not select a back-
ground file.

Action: Click Data Setup, then click Browse to choose a background file, or 
select the Use most recent background option.

Cause: You selected to use an orifice tube or a liquid that is not the same as 
used in the previous analysis (or calibration).

Action: Click Yes to change the orifice tube or liquid. Click No to continue 
with the operation; this is assuming that you have already changed the 
tube or liquid.

Cause: You attempted to start an analysis with the sample stand in the lowered 
position.

Action: Raise the sample stand, then click OK to continue the analysis.
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6118- The entered Minimum Particle Size (number) cannot be measured using the 
calibration selected in Data Setup. A new calibration spanning the desired size 
range is recommended.

6119- The entered Minimum Particle Size (number) requires a log range of (number): 
1 using the calibration selected in Data Setup. A new calibration spanning the 
desired size range is recommended.

6120- Unable to read the calibration file (file name).

6121- Unable to write the calibration file (file name).

Cause: You selected an orifice tube that has not been calibrated to cover the 
specified diameter range.

Action A: Enter a size range that will accommodate the selected orifice tube.

Action B: Recalibrate the orifice tube using reference samples that will cover the 
desired range.

Cause: The particle size range for the current calibration is not consistent with 
the collected data range.

Action A: Perform a calibration using the same range as specified in the message. 
Then click Data Setup on the collected data dialog and update the cal-
ibration.

Action B: Use the existing calibration, in which case interpolation will be used to 
span the collected data range.

Cause: The calibration file selected for loading is not valid or cannot be read.

Action: Confirm the media containing the alleged calibration file has no prob-
lems.

Cause: An unexpected error has occurred.

Action: Contact your Micromeritics service representative.
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6130- The calculation could not be performed.

6131- The peak height has not been initialized, and so cannot be used in the fit.

6132- Calibration failed: No SRM selected.

Cause: You requested a calculated peak height on the orifice tube calibration 
review screen and the number of reference materials is greater than the 
number of peaks (see Message 6136).

Action A: Select the peak height manually.

Action B: Make sure the correct sample is in the system, the correct SRM’s are 
selected, and the proper analysis conditions (for the current sample) are 
selected; then try again.

Cause: You requested that a peak be included in the fit but the peak height had 
not been assigned.

Action A: Select and assign the peak height manually.

Action B: Make sure the correct sample is in the system, the correct SRM’s are 
selected, and the proper analysis conditions (for the current sample) are 
selected; then try again.

Cause: No SRMs were selected on the Orifice Tube calibration review screen.

Action: Select one or more SRMs to be included.
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6133- Calibration failed: Fit tolerances exceeded.

6134- Calibration failed: Error in fit too large.

6136- The automatic calibration could not be performed because the number of ref-
erence materials is greater than the number of peaks. All reference materials 
have been removed from the fit.

6151- This sample file was analyzed on a different instrument. Do you want to pro-
ceed anyway?

6161- The sample already contains eight tests and cannot be used for an analysis.

6162- File (file name) cannot be analyzed. It is currently being edited.

Cause: The calibration could not be completed because the line of best fit  (ori-
fice tube calibration review screen) is too far from the measured value.

Action: Make sure the correct sample is in the system, the correct SRMs are 
selected in the Reference Material list, and the proper analysis condi-
tions are specified for this sample.

Cause: You attempted to perform an analysis using a file that has been used for 
an analysis with a different instrument.

Action: Click Yes to continue with the analysis; however, data will be less 
accurate than if the analysis was performed on the same instrument as 
the first analysis. Click No and choose a file containing an orifice that 
was calibrated on the current instrument.

Cause: You selected Start/Continue after a test completed but the current file 
already contains eight tests. 

Action: Delete some of the tests from the file or choose a different file; you can 
only perform eight tests with a file.

Cause: You selected a file that was still open in an editing window for anal-
ysis.

Action: Finish the changes to the sample file, then save and close the editing 
window.
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6163- The current test is complete. Please save or clear the data before starting a 
new test or change Ending Conditions to collect more data.

6165- Please save or clear collected data before starting this operation.

6167- The newly measured conductivity value (number) differs from previous value 
(number)

The first stage of data collection evaluates the conductivity and compares it to 
the previously recorded value for the current orifice tube and the electrolyte 
and the values differ by more than 2%.

Cause: You attempted to begin another test but data for the current test has not 
been saved or cleared.

Action: Clear the data, save the data, or change the ending conditions.

Cause: You attempted to perform an operation but you have collected data that 
has not been saved or cleared.

Action: Save or clear the data before proceeding with the operation.

Cause A: The orifice tube may be blocked.

Action A: Select Unit [n] > Clear Blockages. If this fails, manually clear the 
blockage; refer to Clearing Blockages, page 9-11.

Cause B: Incorrect analysis liquid or improperly prepared liquid.

Action B: Ensure that the correct liquid is in the Supply container, and that it has 
been properly prepared.

Cause C: Air bubbles are in the tubing.

Action C: Select Unit [n] > Flush System to flush electrolyte through the sys-
tem.
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6180- Cannot read the background file (file name).

6181- The background file (file  name) was not analyzed with the same liquid as this 
file.

6182- There is no full-resolution data in the background file (file name).

6183- The orifice ID for (name) does not match the current tube’s ID (name).

6184- The orifice diameter for (file name) (number) does not match the current tube’s 
diameter (number).

Cause The selected background file is not present or cannot be opened.

Action A: Ensure that the path name is correct.

Action B: Check directory permissions.

Action C: Make sure you have sufficient space on your disk.

Cause: You selected a background that has a different liquid from the one in 
the current file. 

Action: Choose a background that was performed used the same electrolyte as 
the current file.

Cause: You selected a background that does not contain full-resolution data.

Action: Choose a different background file. Do not delete full-resolution data 
from background files.

Cause: You selected Calibration copied from sample (file name) and you 
chose a file for an orifice tube other than the one you are using for the 
current analysis.

Action: Choose a file that contains calibration information for the current tube.
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6185- The calibrations could not be updated. The instrument used for the analysis
(s/n) is not in operation.

6186- Cannot copy calibration from this file. Orifice Tube ID (name) and diameter 
(number) must match the current settings.

6187- Cannot open the data file (file name) for reading.

6188- Cannot create a new test in (file name).

6189- Cannot add a test to (file name)

Cause: You attempted to update calibration information but the instrument 
used in the calibration is not the current instrument.

Action: Update the calibration information using the instrument on which the 
calibration was performed.

Cause: You selected a file that contains calibration parameters for an orifice 
tube other than the current one.  

Action: Choose a file containing calibration information for the current orifice 
tube.

Cause: You attempted to open a data file but were unsuccessful.

Action A: Check directory permissions.

Action B: Make sure the disk is not full.

Cause: An unexpected error occurred.

Action: Contact your Micromeritics Service representative.

Cause: You have saved the maximum number of 8 tests for this file.

Action: Delete unwanted tests, or create a new file.
539-42820-01 (Rev A) - Sep 2017                                               A-37 



Elzone II 5390 6100 Series
6190- There is no calibration for the orifice (name) on this instrument.

6191- New minimum particle size range greater than maximum range. Old settings 
restored.

Cause: You attempted to update calibration information for an orifice tube that 
has not been calibrated on this instrument.

Action: Calibrate the orifice tube, then update the calibration using the Data 
Setup push button on the Collected Data dialog.

Cause: You entered a minimum size value that was greater than the maximum 
value.

Action: The minimum value must be less than the maximum value; reenter the 
minimum size.
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6200 Series

6200- The file (file name) does not have background data.

6201- The file (file name) does not have full-resolution data.

6202- Graph is not available. The orifice tube was not calibrated.

6203- No data available in file (file name) for reporting.

6204- The file (file name) does not have pulse length data.

Cause: You selected a background report for a file that contains no background 
data.

Action: Click Data Setup on the Collected Data dialog and select a back-
ground file.

Cause: You selected a pulse length or pulse length vs. particle size report for a 
file that does not contain full-resolution data. This information either 
was not collected or has been deleted.

Action: Before analysis, select Full resolution data on the Data Setup dialog 
(from the Analysis Conditions dialog). Do not delete full-resolution 
data if you wish to produce these type of reports.

Cause: You requested an orifice tube calibration report for an orifice tube that 
has not been calibrated.

Action: Calibrate the orifice tube, then request the report again.

Cause: You requested a report for a file that does not contain collected data.

Action: Use the file in an analysis before requesting reports.

Cause: You requested a pulse length report for a file that contains entered data. 

Action: Choose a report containing full-resolution data; pulse length reports are 
only available for this type of data.
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6205- The file (file name) does not have pulse length vs. particle size data.

6210-  Data sets must be ordered from finest to coarsest.

6211-  Not enough overlap between data sets.

6212-  Channels with no counts were found in the blend range.

6213-  The blend range could not be determined.

Cause: You requested a pulse length vs. particle size report for a file that does 
not contain the required data. You may not have collected this data or 
you may have deleted it.

Action: Before analysis, select Pulse length vs. particle size data on the Data 
Setup dialog (from the Analysis Conditions dialog). Do not delete full-
resolution data if you wish to produce these type of reports.

Cause: You attempted to blend data, but the data sets have not been placed in 
order.

Action: Reselect the files, placing the file with the finest data in field #1.

Cause: The particle size ranges of at least one adjacent pair of data sets do  not 
overlap by at least 10 points.

Action: Choose an additional data set to cover the intermediate sizes.

Cause: You attempted to blend data; however, at least one of the data files does 
not contain size classes in the size range where blending is to be done.

Action: Collect more data or choose an additional data set to cover the blending 
range.

Cause: The slopes of the distributions in the blending range are not compara-
ble for at least one pair of data sets.

Action: Collect more data or choose an additional data set to cover the blending 
range.
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6214-  The noise level or curvature in the blending range is too high.

6230- The reference material ID (name), Lot (number) is already in the list.

6231- Please select at least one reference material.

6232- No more than ten reference materials can be selected.

6233- The reference material is outside valid range for selected orifice tube. Do you 
want to add the reference material to global list only?

Cause: The data in the blending range are not comparable due to excessive 
scatter or high curvature for at least one pair of data sets.

Action: Collect more data or choose an additional data set to cover the blending 
range.

Cause: You attempted to add a reference material that already exists in the list.

Action: Change the identification of the material you are adding so that it does 
not conflict with the one in the list.

Cause: You attempted to start an orifice tube calibration, but no reference 
materials have been selected.

Action: Select the appropriate reference material(s) and try again.

Cause: You attempted to start an orifice tube calibration with more than 10 ref-
erence materials selected.

Action: Select the appropriate reference materials, but no more than 10.

Cause: You attempted to add a reference material that is outside of the range 
for the orifice tube selected for this calibration.

Action: Click Yes to add the reference material to the list. Click No to edit the 
reference material parameters.
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6235- The reference material is out of range of the orifice tube and cannot be used in 
the calibration.

6240- The input file (file name) has too many data points. Only the first (number) lines 
will be converted.

6241- The input file (file name) does not have enough data points. At least two size-
value pairs must be present.

6242- Converting data failed. Check the contents of the input file (file name).

6243- A negative particle size was found in the input file (file name).

Cause: You selected a reference material that is too large or too small for the 
selected orifice tube.

Action: Select the appropriate-sized reference material(s) or orifice tube and 
try again.

Cause: The number of size classes in reduced data is limited to 300; you  
attempted to convert a file containing more than this number. 

Action: Reduce the number of data points in the file.

Cause: Reduced data must have at least four size classes; you attempted to 
convert a file containing fewer than this number.

Action: Increase the number of data points in the file.

Cause: You attempted to convert an ASCII file but the format is incorrect.

Action: Properly format the ASCII file before converting; refer to Convert, 
page 5-53 for the proper format.

Cause: You attempted to convert an ASCII file but one of the particle sizes 
read from the input file is less than zero.

Action: Correct the particle sizes in the input file, then convert the file.
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6244- A negative incremental distribution value was found in the input file (file name).

6245- An inappropriate cumulative distribution value was found in the input file (file 
name).

6246- The particle sizes in the file (file name) are not evenly spaced on a linear or log-
arithmic scale.

6247- Particle sizes must be strictly increasing.

6248- File (file name) has an unrecognized type.

Cause: You attempted to convert an ASCII file, but one of the incremental dis-
tribution values in the input file is less than zero.

Action: Correct the distribution values in the input file, then convert the file.

Cause: You attempted to convert an ASCII file, but an increasing cumulative 
coarser, or decreasing cumulative finer distribution value was read 
from the input file.

Action: Ensure that the correct type of cumulative data was specified on the 
conversion dialog box. Correct any inappropriate data point in the 
input file, then convert the file.

Cause: The particle sizes in the input file are irregularly spaced.

Action: Choose regularly spaced particle sizes on either a linear or logarithmic 
basis.

Cause: You attempted to convert an ASCII file, but a particle size was read 
that is less than the previous size.

Action: Edit the input file so that the data points are in ascending order by par-
ticle size, then convert the file.

Cause: The input file does not nave the expected format.

Action: Correct the format of the input file.
539-42820-01 (Rev A) - Sep 2017                                               A-43 



Elzone II 5390 6200 Series
6260- Full-resolution data cannot be exported because the file (file name) does not 
have full-resolution data.

6272- The value of the distribution at the extrapolation point must be less than the 
peak value. The extrapolation calculation was not performed.

6273- The value of the distribution at the extrapolation point must be non-zero. The 
extrapolation calculation was not performed.

Cause: You attempted to export full-resolution data using a file that does not 
contain full-resolution data.

Action: Choose Reduced Data as the Export Type in the export dialog.

Cause: You specified extrapolation and peak points in that the value of the dis-
tribution is higher at the extrapolation point that at the peak point.

Action: Enter (or select from the graph) an extrapolation point and/or a peak 
point so that the extrapolation value is lower than the peak value.

Cause: You specified an extrapolation point where the distribution is zero (0).

Action: Specify (or select from the graph) an extrapolation point with non-zero 
distribution.
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B.  DATA REDUCTION

Peak Statistics

Four types of statistics are available for reporting:

• Weighted
• Geometric
• Harmonic
• Arithmetic

The following distributions can be reported for Weighted, Geometric, and Harmonic:

• Volume
• Area
• Number
• Mass

The following statistics can be reported for Arithmetic:

• Length
• Surface area
• Volume

Calculations for these statistics use equations 1 through 6. Use the information provided in 
Tables B-1 through B-3 to produce the equation for the desired statistic. An example is given 
at the end of this section.

(1)

(2)

(3)

(4)

xf

f di F i
F i

-----------------------------=

f

f di  xf– 
2

 F i

F i
-----------------------------------------------=

x f
 1–

xf =

 f
 1– f =
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(5)

(6)

where 

di = average particle diameter for size class i
F,i = value of frequency distribution in size class i (number, area, volume, or mass)
xf = mean of transformed size

Table B-1. Statistic Types and Distributions

Table B-2.  Arithmetic Statistics

Statistic f(x)
(function)

f  –1(x)
(inverse function)

Distribution 

Weighted x x Volume v

Geometric log10x 10x Area a

Harmonic 1/x 1/x Number n

Mass m

Statistic f(x)
(function)

f  –1(x)
(inverse function



Length x x n

Surface Area x2 x1/2 n

Volume x3 x1/3 n

s

f di  xf–

f
---------------------
 
 
 

3

 F i

F i
-----------------------------------------------=

k

f di  xf–

f
---------------------
 
 
 

4

 F i

F i
-----------------------------------------------    3  –=
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Table B-3. Statistics

Example

This example provides the calculations for Harmonic Number Mean.

Substituting equation (8) into equation (3),    =  

Using equations (1) and (7),     

Thus, the Harmonic Number Mean,     

Statistic Formula

Mean x

Standard deviation 

Coefficient of variation x/

Standard deviation of transformed size f

Skewness s

Kurtosis (coefficient of excess) k

+ [n]  size f –1 (xf + nf

– [n]  size f –1 (xf – nf

Variance 2

Harmonic: from Table B-1
(7)

(8)

Number (Distribution): from Table B-1  = n

F,i  Fn,i = incremental number
                    distribution

Mean (Statistic):  from Table B-3 x

f x  1
x
---=

f
 1–

x  1
x
---=

x f
 1–

xf =
1
xf
----

xf

f di Fn i
Fn i

----------------------------   

Fn i

di

---------
Fn i

-----------------==

x
Fn i

Fn i

di

---------

-----------------=
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Mass Balance

True and Measured Concentration

The true concentration is calculated from user input. The mass concentration and dilution 
factor are entered on the Sample Information dialog and the sample density on the Materials 
Properties dialog. 

The measured concentration is the total particle volume measured by the instrument, divided 
by the volume of suspension analyzed:

where

Ni = number of particles measured in size channel i
Vi = volume of a particle in size channel i

Kd by Mass Integration

For mass integration, reference material-derived calibration slope and offset are not used. The 
default calibration factor of the orifice tube is used so that the resulting Kd value is not 
dependent on orifice tube calibration by reference materials. 

where

i = volume of a particle in size channel i calculated using default calibration for 

the orifice tube

True Concentration
Mass Concentration

Sample Density Dilution Factor
-------------------------------------------------------------------------------------------=

Measured Concentration
Ni Vi

Suspension Volume
---------------------------------------------------=

Kv
True Concentration

Measured Default Concentration
------------------------------------------------------------------------------------------=

Kd

6Kv


--------- 
 

1
3
---

=

Measured Default Concentration
NiVdefi

Suspension Volume
---------------------------------------------------=

Vdefi
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Fraction of Sample Measured

The Fraction of Sample is selected on the Summary report.

Fraction Sample Measured
Measured Concentration

True Concentration
-------------------------------------------------------------------=
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Specification/Reference Quantities

Out of Spec

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample 
distribution

CoarseSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Coarse Specification distribution interpolated if the bins are of different size. This is always 
the average of all tests in the named sample file.

FineSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
FineSpecification distribution interpolated if the bins are of different size. This is always the 
average of all the tests in the named sample file.

If {SampCumFracCoarseri-1 > CoarseSpecCumFracCoarseri-1}

   OutSpecFracCoarseri = SampCumFracCoarseri-1 - CoarseSpecCumFrac

   Coarseri-1

If {SampCumFracCoarseri-1 < FineSpecCumFracCoarseri-1}

   OutspecFracCoarseri = SampCumFracCoarser - FineSpecCumFrac

   Coarseri-1

or,

OutSpecFracFineri = -OutSpecFracCoarseri-1

OutSpecFracRetaini = OutSpecFracCoarseri-1

OutSpecFracPassi = OutSpecFracCoarseri-1
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Difference from Reference

SampCumFraci = cumulative fraction coarser/finer/passed/retained for class i from sample 
distribution

RefSpecCumFraci = cumulative fraction coarser/finer/passed/retained for class i from 
Reference Specification distribution interpolated if the bins are of different size. This is always 
the average of all the tests in the named sample file.

DiffRefCoarseri = SampCumFraci - RefCumFraci

or,

DiffRefFineri = DiffRefCoarseri-1

DiffRefRetaini = DiffRefCoarseri-1

DiffRefPassi = DiffRefCoarseri-1

Maximum Out of Spec

MaxOutSpecFrac = maximum (abs value (OutSpecFraci))

Pass/Fail by Specification

If MaxOutSpecFrac = 0, PassFail = Passed by Specification

Otherwise, PassFail = FAILED by Specification
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SPC Report Variables

Regression Chart

The line of best for the Regression Chart is calculated by the usual least squares method1. If 
there is only a single point, or all N points have the same x-value, there can be no line of best 
fit in the standard form.

The coefficient of correlation for this line also is calculated in the usual way2.

1.  BASIC Scientific Subroutines Vol. 11, Ruckdeschel, F. R., BYTE Publications, McGraw Hill, p 16.

2.  Mathematical Handbook for Scientists and Engineers, Korn, G.A. and Korn, T.M.,  McGraw Hill, Sec. 18.4 
(1968).

XAve
xi

N
----------=

YAve
yi

N
----------=

Slope
 xi  XAve–  yi  YAve 

 xi XAve 2–
-------------------------------------------------------------=

YIntercept YAve Slope XAve–=

x

 xi XAve 2–
N

--------------------------------------=

y

 yi YAve 2–
N

-------------------------------------=

Cov (x,y) 
 xi XAve  yi YAve ––

N
-----------------------------------------------------------------=

CorrelationCoef
Cov x y 
xy

------------------------=
B-8                                                   539-42820-01 (Rev A) - Sep 2017



Appendix B Elzone II 5390
 Control Chart

Mean
yi

N
----------=

StdDev
 yi Mean 2–

N 1–
---------------------------------------=

CoefVar
StdDev
Mean

-------------------=

PlusNSig Mean n STdDev+=

MinusNSig Mean n StdDev–=
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Log Probability Data

Log probability data are a transformation of cumulative mass finer data as a means of 
determining how well cumulative and differential mass data represent statistical log  normal 
distributions. Since cumulative mass finer data are essentially data indicating the probabilities 
of finding particles of mass finer at given diameters, log normal probability data are a fit of the 
cumulative mass data to the defined, symmetrical probabilities tabulated for a log normal 
distribution. 

The log probability table used is a subset of 99 points, ranging from (-2.88, 0.2%) to (0.0, 
50.0%) to (+2.88, 99.8%), from a standard normal distribution table (see Table B-1. Log 
Probability Interpolation on the next page). The x-axis and y-axis data which are plotted on a 
log probability graph are calculated as follows:

1. X-axis boundaries are determined by the spline interpolation at 0.2% and 99.8% from 
cumulative mass finer vs. log diameter. This gives Xprob_beg and Xprob_end, 
respectively.

2. For each of the number of points collected,

If Diameter value is between Xprob_beg and Xprob_end and

if CumMassFiner value is between 0.2% and 99.8%, then

Xprob value = Diameter value

Yprob value = Spline interpolation at CumMassFiner values of the x  vs. y log probability 
table values
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Log Probability Interpolation Table

X (%)    Y X (%)    Y  X (%)   Y

 0.20 -2.88 33.00 -0.44 68.08 0.47

 0.99 -2.33 34.83 -0.39 69.15 0.50

 2.02 -2.05 35.94 -0.36 69.85 0.52

 3.01 -1.88 37.07 -0.33 70.88 0.55

 4.01 -1.75 37.83 -0.31 71.90 0.58

 4.95 -1.65 38.97 -0.28 72.91 0.61

 5.94 -1.56 40.13 -0.25 73.89 0.64

 6.94 -1.48 40.90 -0.23 74.86 0.67

 7.93 -1.41 42.07 -0.20 76.11 0.71

 9.01 -1.34 42.86 -0.18 77.04 0.74

10.03 -1.28 44.04 -0.15 77.94 0.77

10.93 -1.23 44.83 -0.13 79.10 0.81

11.90 -1.18 46.02 -0.10 79.95 0.84

12.92 -1.13 46.81 -0.08 81.06 0.88

14.01 -1.08 48.01 -0.05 82.12 0.92

14.92 -1.04 48.80 -0.03 82.89 0.95

16.11 -0.99 50.00 0.00 83.89 0.99

17.11 -0.95 51.20 0.03 85.08 1.04

17.88 -0.92 51.99 0.05 85.99 1.08

18.94 -0.88 53.19 0.08 87.08 1.13

20.05 -0.84 53.98 0.10 88.10 1.18

20.90 -0.81 55.17 0.13 89.07 1.23

22.06 -0.77 55.96 0.15 89.97 1.28

22.96 -0.74 57.14 0.18 90.99 1.34

23.89 0.71 57.93 0.20 92.07 1.41

25.14 -0.67 59.10 0.23 93.06 1.48

26.11 -0.64 59.87 0.25 94.06 1.56

27.09 -0.61 61.03 0.28 95.05 1.65

28.10 -0.58 62.17 0.31 95.99 1.75

29.12 -0.55 62.93 0.33 96.99 1.88

30.15 -0.52 64.06 0.36 97.98 2.05

30.85 -0.50 65.17 0.39 99.01 2.33

31.92 -0.47 67.00 0.44 99.80 2.88
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C.  FORMAT OF EXPORTED DATA

This appendix gives the format for sample files exported in ASCII text. All character 
strings are delimited with quotation marks; columns are separated with a comma and 
white space.

The following types of data can be exported:

• Reduced data
• Full-resolution data

Reduced Data

Information Conveyed Form

File identification quoted string
Material identification quoted string
Material density floating point
Liquid identification quoted string
Liquid viscosity floating point

Particle Size Data
Number of tests, including average if selected (following 
reported for each test)

integer

Test: [n]     (n = 1, 2, ..... , Average) quoted string
Date and time quoted strings
Current floating point*
Gain floating point*
Orifice Kd floating point*
Ending condition integer

0 = total count
1 = modal count
2 = volume
3 = time

floating point*

Mean particle size floating point
Median particle size floating point
Modal particle size floating point
Number of size class boundaries (following reported for each) integer

Particle size floating point
Value (number, surface area, volume or mass) in class floating point

*Reported for average test only if the values for all tests are the 
 same; otherwise the string “Settings Vary” is displayed.

Pulse Length Data
Number of tests (following reported for each test) integer

Test: [n] quoted string
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Full-Resolution Data

Date and time quoted strings
Number of length class boundaries (following reported for each) integer

Particle length floating point
Number of particles in class integer

Information Conveyed Form

File identification quoted string
Material identification quoted string
Material density floating point
Liquid identification quoted string
Liquid viscosity floating point

Particle Size Data
Number of tests (following reported for each test) integer

Test: [n] quoted string
Date and time quoted strings
Current floating point
Gain floating point
Conductivity floating point
Linear instrument calibration coefficients 3 floating points
Number of logarithmic calibration points (following reported
for each point)

integer

Measured voltage floating point
Normalized voltage floating point

Orifice Kd value floating point
Number of calibration coefficients (following reported
for each coefficient)

integer

Order integer
Coefficient floating point

Number of channels (following reported for each channel) integer
Particle size floating point
Number of particles in channel integer

Pulse Length Data
Number of tests (following reported for each test) integer

Test: [n] quoted string
Date and time quoted strings
Flow rate floating point
Orifice diameter floating point
Effective orifice length floating point
Number of channels (following reported for each channel) integer

Particle size floating point
Number of particles in channel integer
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Particle Shape Data

Number of tests (following reported for each test) integer
Test: [n] quoted string
Date and time quoted strings
Number of size classes integer
Number of length classes (following reported for each 
combination of length and size class)

integer

Particle length floating point
Particle size floating point
Number of particles in class integer
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Appendix D Elzone II 5390 
D.  ELECTROLYTES

This appendix contains a discussion on electrolytes and how to prepare them for analysis.

Overview

The Elzone II 5390 analyzes samples based on the electrical sensing zone method. This 
method requires an electrolyte with suitable electrical conductivity and with physico-
chemical neutrality toward the sample particles; i.e. it must not cause them to dissolve, 
react, agglomerate, disintegrate, shrink, or swell. There are extensive listings of materials 
vs. electrolytes, but consulting one* is usually unnecessary since virtually all materials 
have more than one satisfactory electrolyte. 

The practical range for electrolyte conductivity is from 4 to 100 m-mho/cm which corre-
sponds to approximately 0.2 to 5% NaCl by weight in water. Tubes with smaller orifices 
require a higher conductivity than those with large orifices. For example, a tube with a 30-
micrometer orifice optimally requires an electrolyte conductivity of about 45 m-mho/cm, 
corresponding to 2.25% NaCl in water, while a conductivity of 9 m-mho/cm, correspond-
ing to 0.45% NaCl in water, is adequate for a tube with a 300-micrometer orifice.

When a material is found to be slightly soluble in an electrolyte, an appropriate procedure 
is to (1) saturate the electrolyte with particles of the material, (2) filter the electrolyte and 
remove undissolved particles, and (3) use the filtered electrolyte and new particles for size 
analysis. Micromeritics has a unit called the ElectroPrep which has been specifically 
designed for filtering electrolyte.

Types of Electrolytes

Electrolytes are conveniently classified into these groups: aqueous, organic, and modified 
organic.

Aqueous

Aqueous electrolytes are safe, economical, and easy to handle and, therefore, are the 
choice whenever possible. Their pH, wetting ability, and ion type sometimes require con-
sideration. Moderately basic solutions, like those of the alkali phosphates, generally favor 
suspension stability and provide good wetting action for most non-biological materials. 
Typically a 4% solution by weight of sodium pyrophosphate provides good dispersing and 
wetting, but sometimes sodium hexa-meta-phosphate is preferable. An acid or neutral 
electrolyte is required when a material undergoes some dissolution and instability at pH 
values well above eight. A wetting agent or dispersant is required when an acid condition 
does not give a satisfactory dispersion.

*ISO 13319, “Determination of Particle Size Distributions - Electrical Sensing Zone Method” (2000).
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Wetting and dispersion are highly variable matters associated with the physical chemistry 
of particle surfaces that can range from tens of square centimeters to hundreds of square 
meters per gram. Nevertheless, only a few drops of a liquid dispersant or a few grains of a 
solid one are needed. The dispersant preferably should be added directly to the sample and 
the sample then added to the electrolyte. Ordinary household or laboratory detergents very 
frequently are satisfactory. As a further source, however, Table D-1 lists commercial deter-
gents and some specific materials for which they have been found valuable.

When the particles are already in some effective electrolyte such as sea water, plating 
solution, beer, crystallizer liquor, or when the particles are biological cells requiring iso-
tonic salinity (physiologically “normal” saline) to avoid swelling, shrinkage, or other dam-
age, the choices become limited. In the first case, it probably will be necessary to dilute 
with particle-free water. In the second case, the demand from hematology laboratories has 
resulted in the ready availability of isotonic saline from laboratory supply houses. Formu-
lations vary slightly, but all include mono- and di-basic phosphate buffered to pH 7.4 with 
an osmolality of 335-345 m-osmos. Some are filtered down to 3 micrometers and others to 
1 micrometer.

Organic

Organic electrolytes are needed for water-soluble materials (including most salts and sug-
ars), many esters and foodstuffs, and for other materials already suspended in media that 
are immiscible with water. For these, polar organic liquids having dielectric constants of 
10 or more, with readily ionized compounds such as lithium chloride, ammonium thiocya-
nate, or ammonium perchlorate, form a useful group of electrolytes. Very useful organic 
media include alcohols and ketones having from one to four carbon atoms. Amides and 
esters are good for some samples. Often, when some other water-immiscible media is 
involved, a polar liquid alone will not form a single liquid phase or the material may be 
somewhat soluble in it. In these cases, chlorinated hydrocarbons, tetrahydrofuran, and ali-
phatic and aromatic hydrocarbons may be used for the suppression of particle solubility. 
Be sure to handle organics carefully and in a well-ventilated area. 

Adequate ventilation and handling precautions must be observed when working 
with organic media.
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Modified Organic

The dispersant Niaproof 4 (See Table D-1), undiluted, is an acceptable electrolyte for 
especially difficult materials such as Teflon®, chocolates, paints, liquid toners, and com-
plex hydraulic and lubricating oils. However, after particles are dispersed in it, they then 
frequently can be mixed in other liquids, including sometimes, plain water, and analyzed. 
The dispersant apparently clings to the particles allowing sufficient time for a good analy-
sis. 

Table D-1. Special Dispersants and Primary Applications

Niaproof 4 is a strong irritant. Wear rubber gloves and goggles when handling this 
product and ensure that adequate ventilation is present.

Dispersant Manufacturer Application Class

Triton X-100 Rohm and Haas
Philadelphia, Pa

General purpose, often first to be tried for an 
unknown

Non-ionic

Niaproof 4 Niacet Corporation
Niagara Falls, NY

Quite effective for materials of (-) charge, e.g., 
polyfluorocarbons. Irritant.

Anionic

Lomar PW Diamond Shamrock
Dallas, TX

Carbon, coal, coke, charcoal Anionic

Sulframin Purex Company 
Chicago, IL

Carbides, polymers, oil shale, stearates Anionic

Daxad 23 W.R. Grace 
Lexington, MA

Metals and metal oxides Anionic

Variquat 
(50-MC) 

Sherex Chemical
Dublin, OH

Quite effective for materials of (+) charge, e.g., 
cationic exchange resin 

Cationic

Tween 20 ICI Americas, Inc.
Wilminton, DE 

Polystyrene and similar polymers Non-ionic

For additional information, see McCutchen’s Emulsifiers and Detergents, McCutchen Publishing 
Company, Glen Rock, NJ
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Preparation of Electrolyte Solutions

Choosing the composition of and preparing an electrolyte for frequently used materials are 
relatively straightforward, while for unknowns it most likely will involve some trial and 
error. Most often satisfactory electrolytes can be prepared from distilled water or anhy-
drous organic liquids using technical grade salts. Electrolytes must be filtered so that they 
are virtually free of particles for best results, or at least free of particles above the thresh-
old intended to be used in an analysis. 

Filter cartridges of the high area type provide the best filtration and the easiest handling. 
Only a small liquid head and no pumping or pressurizing is required. Filtering rates of 100 
mL/min can be achieved with 0.2-micrometer (sterile) filters and greater rates for larger 
pore filters. One filter can process many hundreds of liters. Some users prefer to process 
only enough electrolyte for one day's operation to avoid contamination problems. This 
electrolyte should be held at the same temperature as the area of the analytical instrument 
and its container should remain sealed except when actually being poured from. 

Only testing for stability with an actual sample of the material in question can prove ade-
quacy. If dissolving, crystallizing, or agglomeration occurs over time, a different composi-
tion obviously is required. Small changes indicative of dissolving usually can be corrected 
by pre-saturating the electrolyte.

The instructions given below are for one type of filtering devices available. The one in 
your lab may be of a different design and, therefore, will function differently. The impor-
tant thing to remember is that you must use a 0.2-m (or lower) filter. 

1. Remove the upper container and rinse with a small amount of electrolyte.

Upper container

Filter section

Lower container
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2. Clean the lower container:

a. Rinse the lower container with a small amount of electrolyte, then replace the 
upper container.

b. Pour electrolyte into the upper container until it is approximately one-half full; 
allow the electrolyte to filter through to the lower container.

c. Remove the upper container.

d. Swish the electrolyte around in the lower container, then discard the electrolyte.

e. Replace the upper container.

f. Repeat steps b through e two more times.

3. Fill the upper container with electrolyte; allow it to filter through into the lower 
container.

4. Remove the upper container, then pour the electrolyte into the supply bottle.

5. Repeat steps 3 and 4 until the supply bottle is filled.

Be sure to read about the ElectroPrep in the next section. The ElectroPrep automates the 
filtering process, providing a continuous supply of electrolyte. It is the recommended fil-
tering device for the Elzone analyzer. 

ElectroPrep

The ElectroPrep is designed to recirculate electrolyte through a filter cartridge that retains 
particles greater than 0.1 to 0.2 micrometers in diameter, and is the recommended filtering 
system for the Elzone analyzer. The electrolyte is contained in a reservoir, providing a 
supply of clean electrolyte at all times. 

For electrolytes in which sample particles readily disperse (e.g., alumina in saline water) 
without having to add a dispersing agent, the waste liquid can simply be poured back into 
the reservoir and used again and again. In typical usage under this circumstance, one prep-
aration of electrolyte will last several months before the filter cartridge has to be replaced. 
This is also true with saturated electrolytes.

Waste liquid cannot be recycled when the sample material requires a special dispersing 
agent because placing it back into the electrolyte would change the electrolyte composi-
tion. The ElectroPrep is still useful in these situations by affording a ready source of clean 
electrolyte to fill instrument sample beakers and supply containers. The ElectroPrep can 
be used with aqueous or organic electrolytes by selecting the appropriate cartridge. Refer 
to Ordering Information, page 10-1 for information on ordering the ElectroPrep, or con-
tact your local sales representative.
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E.  THEORY OF OPERATION

The Elzone II 5390 is based on the electrical sensing zone method — also known as the 
Coulter principle. The sample material is prepared and placed into a beaker containing 
electrolytic liquid of high electrical conductance in which the particles are suspended. The 
suspension is caused to move through an orifice (electrical sensing zone) separating a pos-
itive and negative electrode between which a current and a corresponding difference of 
potential are established. Almost all of the applied voltage is dropped along the interior of 
the orifice as a result of its extremely small cross-section as compared to that of the bulk 
liquid on either side of the orifice.

As a particle passes through the orifice with the carrier liquid, it displaces some of the con-
ducting fluid. This generates an electrical signal that is proportional in amplitude to the 
change in electrical conductivity through the orifice channel; the less-conductive particle 
displaces its own volume of conductive liquid and causes an increase in the electrical 
resistance of the orifice channel. The electrical signal produced, therefore, is proportional 
to the volume of the particle. The length of the pulse is related to the shape of the particle 
in that particles of a given mass and composition but with one or two significantly differ-
ing dimensions may take longer to transit the orifice passage than an otherwise identical 
particle having all three dimensions equal. Obviously, a sphere will produce the shortest 
possible pulse while rod-shaped particles can maximally extend the duration of the pulse. 
Some complications exist in interpretation of this pulse width data because particles trav-
eling close to the orifice walls are embedded in slower moving liquid than those in the 
center of the orifice. Those slower moving particles near the walls produce longer electri-
cal pulses than those in the center even if all the particles involved are identical.

The descriptive equation for the change in orifice resistance caused by a particle in the ori-
fice is:

where:

R = change in resistance caused by the particle in the orifice
 = electrolyte resistivity
V  = volume of the particle
A = orifice area normal to the axis
 = effective resistivity of the particle
a = cross-sectional area of the particle normal to the orifice axis

Note that the orifice channel length does not appear in the equation. The effect of longer 
orifices is two-fold:

1. The pulse width of the signal increases and improves the ability to detect and measure 
the particle, and
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2. At a given concentration, a longer channel length increases the probability that more 
than one particle (coincidence) will be in the orifice at the same time, thus producing 
an erroneous signal. The probability of coincidence can be reduced to its original 
value by diluting particle concentration, but this results in longer analysis times. The 
additional analysis time is proportional to the amount of dilution, and both are 
proportional to the amount that the orifice length was increased.

These contrary effects are commonly encountered in information theory applications 
where one must make trade-offs between speed, precision, accuracy, and error rate.

Particles arrive at the entrance of the orifice in a random manner at a rate that depends 
upon their concentration. Therefore, measuring the maximum number of particles per unit 
of time by increasing the sample concentration, the more likely it is that two or more 
closely spaced particles will merge to create a combined pulse. This pulse falsely indicates 
a single particle of volume exceeding that of either particle alone. This combination may 
indicate a particle volume that exceeds that of any particle that is actually present in the 
sample. The general effect of such combined signals is to spread the particle size spectrum 
upward toward larger sizes and to under-represent the amount of particle volume present 
at the lower sizes.

In addition to these fully merged coincidence events, there also exists a partial coincidence 
or near coincidence. Partial coincidence creates signals that can be mistaken for elongated 
particles or which may be too difficult to interpret. Near coincidence signals are those 
which involve a second pulse which occurs while the signal processing circuit has not yet 
completed the processing of a slightly earlier pulse. The system typically does not detect 
pulses which follow another pulse too closely. The coincidence correction feature in the 
Elzone application enables you to compensate for the effects of full, partial, and near 
coincidences.
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F.  CONCENTRATION ANALYSES

Concentration analyses are performed when you need to determine the concentration of 
particles within your sample.

Standard Analysis

Creating the Sample File

These instructions are given for the Advanced format.

1. Select File > Open > Sample Information; the Open Sample Information dialog is 
displayed.

2. Click OK, then Yes to create the file.

3. On the Sample Information dialog:

a. Enter an appropriate description in the Sample field.

b. Ensure that Automatically collected is selected as the type of data.

c. Enter the dilution factor for the sample you are analyzing. Refer to Preparing 
the Sample on the next page for determining this value.

d. Enter information in any other fields as desired (Operator, Submitter, etc.).

4. Click the Analysis Conditions tab, then:

a. Click the down arrow to the right of the Orifice Tube field and choose the orifice 
tube you plan to use.

b. Select Specify Diameter range; enter a range in the Minimum and Maximum 
fields. 

c. Click Flow Control to display the Flow Control dialog. Select Volumetric Flow 
Rate and enter the appropriate flow rate for the orifice tube being used. (Refer to 
Table 3-1. Particle Concentration Guidelines, page 3-35 for guidelines.) Click 
OK to return to the Analysis Conditions dialog.

You must have the volumetric pump installed to perform concentration analyses.
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d. Click Data Setup; select or enter the following:

Full-resolution as the Data Format
Logarithmic in Diameter
Class range typically for concentration analyses is the same range as specified for 
diameter range

e. Select Volume as the ending condition and enter the volume of electrolyte for the 
analysis in the adjacent field; 4 mL is the maximum amount allowed. Smaller 
orifice sizes use less than 1 mL because there is a greater chance of blockages 
occurring.

f. Enter appropriate values for other fields (size range, stirrer speed, etc.).

5. Click the Material Properties tab; select the sample material and the electrolyte 
being used.

6. Click the Report Options tab; select (precede with a check mark):

Inc. Number/mL% vs. Diameter Graph
Summary; click Edit and ensure that Total Number and Volume-Specific Number 
are selected.

7. Click Save, then Close.

Preparing the Sample

Your sample concentration should be at or below the amount specified in Table 3-1. 
Particle Concentration Guidelines, page 3-35 for the orifice tube you are using. 

1. Measure a volume of sample and place it into the sample beaker. Record the volume 
as SV (in mL).

2. Measure a volume of electrolyte. Record the volume of EV (in mL).

3. Calculate the dilution factor using the following formula:

Example: Use a 150-mL beaker filled with 120 mL electrolyte. Use a sample volume 
of 2 mL.

If you entered a dilution factor in the file you created, you can edit this value when 
you begin the analysis or after the analysis.

DF
SV  EV+

SV
------------------------=

DF
 2  120+

2
--------------------- 

122
2

---------  61 ===
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Performing the Analysis

1. Install an appropriate orifice tube onto the sample port (refer to Choosing and 
Installing an Orifice Tube, page 3-28).

2. Ensure that the appropriate electrolyte is connected to the Supply port.

3. Clean the outside of the orifice tube, stirrer, and electrode with filtered electrolyte.

a. Fill a squeeze bottle with clean, filtered electrolyte or water.

b. Place (or hold) a beaker under the glassware. Use the squeeze bottle to 
thoroughly rinse each piece of glassware; then remove the beaker.

4. Place the analysis beaker containing your prepared sample on the sample stand; 
position the electrode next to the orifice tube so that it will be submerged in the 
beaker. 

5. Raise the sample stand.

6. Select Unit [n] > Fill System to fill the orifice tube.

7. Adjust and focus the camera if needed (if using the camera).

8. Select Unit [n] > Sample Analysis to display the analysis screen. Click Browse and 
choose the sample file you created. Edit the dilution factor to show the value obtained 
when preparing your sample.

9. Click Next to start the analysis.

10. After the analysis is finished, save the background data.

Squeeze Bottle

Be sure the stirrer does not strike the bottom or sides of the beaker when raising 
the sample stand. The stirrer will not operate if it comes in contact with the 
beaker.
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Background-Subtraction Analysis

Occasionally, the ratio between contaminates in the electrolyte and particles in a sample 
can be low and, therefore, difficult to tell the difference between the two. When 
performing an analysis, the desired ratio between sample particles and contamination 
(sometimes called signal-to-noise ratio) in the electrolyte is approximately 99:1 in 1 mL 
of electrolyte. In other words, for every 99 sample particles, there should be no more than 
1 particle of contamination in the electrolyte.

When the signal-to-noise ratio drops below an unacceptable level, a procedure can be 
performed to remove the presence of contaminates in the electrolyte from the analysis 
data. 

Creating the Sample File

1. Select File > Open > Sample Information; the Open Sample Information dialog is 
displayed.

2. Click OK, then Yes to create the file.

3. On the Sample Information dialog:

a. Enter an appropriate description in the Sample field.

b. Select Background as the type of data.

c. Enter a dilution factor of 1.00.

d. Enter information in any other fields as desired (Operator, Submitter, etc.).

4. Click the Analysis Conditions tab, then:

a. Click the down arrow to the right of the Orifice Tube field and choose the orifice 
tube you plan to use.

b. Select Specify Diameter range, then enter a range in the Minimum and 
Maximum fields. 

c. Click Flow Control to display the Flow Control dialog. Select Volumetric Flow 
Rate and enter the appropriate flow rate for the orifice tube being used. (Refer to 
Table 3-1. Particle Concentration Guidelines, page 3-35 for guidelines.) Click 
OK to return to the Analysis Conditions dialog.

d. Click Data Setup; select or enter the following:

Full-resolution as the Data Format
Logarithmic in Diameter
Class range typically for concentration analyses is the same range as specified for 
diameter range
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e. Enter appropriate values for other fields (size range, stirrer speed, etc.).

5. Click the Material Properties tab; select the electrolyte being used. The sample 
material selected is irrelevant since only the electrolyte is being used for the 
background. However, many Elzone users make an entry in the Sample Material list 
relevant to the background. For example, you may wish to use “Background 
particles”. This is more relevant on the Background report.

6. Click the Report Options tab; select (precede with a check mark):

Inc. Number/mL% vs. Diameter Graph
Summary; click Edit and ensure that Total Number and Volume-Specific Number 
are selected.

7. Click Save, then Close.

Performing the Background Analysis

1. Install the orifice tube onto the sample port (refer to Choosing and Installing an 
Orifice Tube, page 3-28).

2. Ensure that the appropriate electrolyte is connected to the Supply port.

3. Clean the outside of orifice tube, stirrer, and electrode with filtered electrolyte.

a. Fill a squeeze bottle with clean, filtered electrolyte or water.

b. Place (or hold) a beaker under the glassware. Use the squeeze bottle to 
thoroughly rinse each piece of glassware, then remove the beaker.

4. Fill the analysis beaker with electrolyte (no sample) and place it on the sample stand; 
position the electrode next to the orifice tube so that it will be submerged in the 
beaker. 

Squeeze bottle
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5. Raise the sample stand.

6. Select Unit [n] > Fill System to fill the orifice tube.

7. Adjust and focus the camera if needed (if using the camera).

8. Select Unit [n] > Sample Analysis to display the analysis screen. Click Browse and 
choose the sample file you created.

9. After the analysis is finished, save the background data.

Performing the Sample Analysis

Now that you have established a background, you can perform your sample analysis and 
have the background subtracted from the analysis.

1. Create a sample file for the sample analysis:

a. Select File > Open > Sample Information; the Open Sample Information dialog 
is displayed.

b. Click OK, then Yes to create the file.

c. Click Replace All and select the file you used for the background analysis.

d. Change the type of data to Automatically collected.

e. Click the Analysis Conditions tab. Click Data Setup and select Use most recent 
background. Then click OK to return to the Analysis Conditions dialog.

f. Click Save, then Close.

2. Perform steps 3 through 10 in Performing the Analysis, page F-3.

 

Be sure the stirrer does not strike the bottom or sides of the beaker when raising 
the sample stand. The stirrer will not operate if it comes in contact with the 
beaker.
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G.  CAMERA OPTION

This appendix contains installation and operating instructions for the camera used with the 
Elzone II analyzer. 

The camera option kit includes the following:

• Camera assembly
• Light assembly
• USB cable

Description

The camera is installed on the front panel of the Elzone II analyzer, enabling you to:

• view particle activity in the orifice
• detect blockages in the orifice
• check the orifice jewel for cracking
• check the orifice for particle build-up

The camera software contains many features for manipulating images; however, this 
appendix provides information only on the ones directly related to the Elzone application. 
Refer to the help system in the camera software for assistance on other features.

Camera 
assembly
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Installation

This section will explain how to install the:

• camera assembly
• light assembly
• camera software

Camera Assembly

Install the camera assembly as follows:

1. Using a flat-head screwdriver (or your fingers), unscrew the four captive screws; then 
remove the plate from the left front panel.

2. Insert the cord of the camera assembly into the opening. Ensure that the focusing 
knobs of the assembly are facing outward. The cord should be secured with a twist tie 
making it easier to place inside the compartment. Be sure at least 12 to 14 inches (30 
to 36 cm) are free from the twist tie.

If your Elzone was ordered with a camera option installed, advance to Light 
Assembly and continue with installation of the light assembly.

Captive screws 
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3. With a Phillips-head screwdriver, secure the assembly into position using the four 
captive screws on the assembly.

4. Using a Phillips-head screwdriver, unscrew the retaining screws on the rear panel; 
then remove the panel. 

Tighten these 
screws securely.

Remove these screws, 
then remove the panel.
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5. Locate the camera assembly cord you inserted earlier. Plug the cord into its USB 
connector. The guide should be facing upward and the connector slot downward.

6. Replace the rear panel, then connect the USB cable to the connector labeled Camera 
USB on the rear panel of the analyzer. Do not plug the other end of the USB cable 
into the computer until instructed to do so (during installation of the camera 
software).

USB connector

USB guide

Slot for connector

Camera USB 
port
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Light Assembly

1. Remove the external electrode and the stirrer for easy access to the connector for the 
orifice light cable.

2. Connect the orifice light cable to the connector inside the top panel of the sample 
compartment.

3. Using a Phillips-head screwdriver, remove the mounting screw on the back panel of 
the sample compartment. 

4. Insert the screw through the retaining clip, then back into the hole on the back panel 
of the sample compartment; tighten with a Phillips-head screwdriver. 

Orifice Light Cable 
Connector

Retaining Clip
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Camera Software

1. If the camera software was not installed with the Elzone software, insert the Elzone 
installation CD and browse to the Camera folder then launch the camera Setup 
program.

2. Follow the instructions displayed on the screen to install the software. After the 
software installation is complete, your computer will restart. Do not remove the 
camera software CD from the CD drive.

3. After your computer restarts, a window instructing you to insert the camera cable 
(from the analyzer) into the computer is displayed.

4. Insert the cable as instructed, then remove the camera software CD and store in a 
secure location.

Be sure to close all programs before installing the camera software. Your 
computer will restart automatically after software installation.
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Operation

This section will explain how to:

• start and use the software
• adjust the orifice light
• focus the image

Before starting the camera software, perform the following steps:

1. Reinstall the external electrode and the stirrer.

2. Install an orifice tube on the sample port of the analyzer. Use a tube with the largest 
orifice size you have available. A larger orifice is easier to focus and view on the 
screen.

3. Place a beaker of electrolyte on the sample stand; raise the stand.

4. Select Unit > Fill System to fill the orifice tube with electrolyte.

Now you are ready to start the camera software.

Starting the Camera Software

• Click the camera icon (AMCap) installed in the Windows Start menu or double click the 
application file installed in the Windows folder (typically this is C:\WIn-
dows\AMCap.exe). 

• If multiple Elzone cameras are installed, select the preferred camera from the Devices 
menu.

• To capture video, select a location to store the captured video file using File > Set Cap-
ture File... then start the capture using Capture > Start Capture and click OK in the 
Ready to Capture window. When the capture is complete, go to Capture > Stop Cap-
ture.

• Zoom, brightness, and contrast can be set in Options > Video Capture Filter > Prop-
erties.
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Adjusting the Orifice Light

Be sure the sample stand is raised (as instructed earlier at the beginning of the Operation 
section) and the camera software is operating.

1. Close the right door of the sample compartment (the one containing the reflector).

2. While observing the image on the screen, adjust the orifice light cable so that the light 
shines onto the middle of the reflector on the sample compartment door.

An image should display in the QuickCapture window of the camera software. If an 
image does not display, you will be able to adjust it to display when you are focusing 
the image (next section).
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Focusing the Image

Follow these guidelines to obtain a clear image of the orifice on the computer screen:

• Make sure the orifice is aligned with the camera lens.

• Be sure the orifice tube is not too close to the beaker. There should be 
approximately 1/2 to 1 inch (12.7 to 25.4 mm) between the orifice tube and the 
inside of the beaker.

• Position the orifice light approximately an inch (25.4 mm) away from the reflector 
so that it shines into the middle of the reflector. 

• Use the focusing ring and horizontal and vertical knobs to adjust the image 
(described below)

Allow 1/2 to 1 inch 
between orifice 
tube and beaker

Align orifice 
with lens

Position 
light to 
shine in 
the mid-
dle of the 
reflector
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1. Turn the focal ring fully clockwise (to the right), then slowly turn it counterclockwise 
(to the left) until a clear image displays on the computer screen.

2. After you obtain a clear image, use the knobs on the left side of the camera to adjust 
the position of the image. The knob on the top adjusts the image right to left. The 
lower knob adjusts the image up and down. 

You can also use the zoom and pan controls in the camera software for adjusting the 
position.

Focal Ring

Adjusts the image 
right to left.

Adjusts the image 
up and down.

You may also need to adjust the position of the orifice light to obtain the best 
results.
G-10                                                    539-42820-01 (Rev A) - Sep 2017



Elzone II 5390 Appendix I
H.  OPTIMUM PERFORMANCE FOR STRAY PARTICLE 
COUNT AND NOISE

Some Elzone users have applications which require minimum stray or particle counts, or 
are prone to their appearance. These unexpected pulses, counted as particles, can result 
from:

• particle contamination in the sample or electrolyte

• electrical noise that simulates particle passage pulses

• vibration or acoustic waves that produce electrical signals which simulate particle 
pulses in the same manner as a microphone 

Removal or minimization of these sources of stray particle pulses mean improved 
performance.

Using the guidelines provided in this appendix and appropriate cleaning procedures, reli-
able particle size analyses can be obtained with low-conductivity, high-viscosity 
electrolytes, small orifice tubes, and other noise-sensitive operating conditions.

Contamination

If the source is contamination in the sample or electrolyte, additional cleaning or filtering 
of the electrolyte is required. Most “stray” particles detected during background or sam-
ple analyses, especially those of a size greater than 3 or 4% of the orifice diameter, are 
usually the result of true particle contamination. Be sure that the orifice tube, stirrer pad-
dle or hydropulser tube, and electrode are completely clean and free of particles.

Electrical Noise

Electrical noise usually results from sources external to the Elzone. There are numerous 
noise filters and electrical isolation circuits that, when operating properly, suppress inter-
nal sources of electrical noise. External sources may be in the form of radio frequency 
fields, such as those from fluorescent lights, radio stations, or power-switching transients. 
The doors that enclose the Elzone sample compartment contain a wire mesh shield that 
stops almost all external radio frequency noise when closed, which should always be the 
case during analysis. The input power supply also contains electrical filters that remove 
normal power-line noise. Power sources to which high current or inductive devices, such 
as heaters or large AC motors, are connected should not be used to power the Elzone. 
Unusually noisy circuits such as this may degrade analysis results.
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Vibration and Acoustic Noise

Vibration and acoustic noise produce electrical signals much like those produced by a 
microphone. This usually results from the combination of a small orifice in the sample 
tube and a viscous electrolyte solution. As the size of the orifice decreases, the voltage 
drop across the orifice during operation increases. The higher the voltage, the more sus-
ceptible the system is to microphonic pulses. These pulses may be due to vibrations 
transmitted into the beaker of electrolyte through the hardware of the instrument, created 
by the vacuum pump, cooling fan, stirrer, or transformed from air-borne acoustic waves. 

In addition, as the conductivity of the electrolyte decreases, the voltage drop across the 
orifice increases, again resulting in greater susceptibility to vibration and acoustic stimuli. 
Other operational factors that increase the sensitivity to these vibration sources are 
increased viscosity or a very slow flow of the electrolyte through the orifice.

Improved Performance

The Elzone includes several features which help to control the occurrence of stray parti-
cle counts.

Software

The Elzone software contains certain analysis parameters that can be selected to help 
minimize background counts. 

Optimize Settings

Generally, the current should be set as high as possible. The amplifier gain settings should 
be chosen to cover the desired particle size range. If the current is set too high, the elec-
trolyte may heat in the orifice enough to form air or vapor bubbles, which are detected as 
particles. If the gain is set too high (to compensate for too low of a current choice), noise 
inherent to the electronics is amplified and also detected as particles.This noise results 
from Brownian motion of the ions in the electrolyte.
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An option to optimize instrument settings to your electrolyte (current/gain settings) has 
been included in the software and is located on the second view of the Analysis dialog. 
Refer to Optimizing Instrument Settings, page 3-33 for step-by-step instructions.

After you optimize the settings, run a background to verify that the settings are accept-
able. If the “particle” count is too high, click Instrument Setup to adjust the current/gain. 
Remember the guidelines given earlier when making the adjustment. 

Click this push button 
to have the software 
optimize current/gain 
settings automatically.

Adjust the values in these fields 
to further optimize instrument 
settings.

Deselect this option not to have 
the values in these fields adjust 
automatically.
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Pump/Fan Off During Data Collection

The vacuum pump used to drive the electrolyte flow and the fan used to cool the elec-
tronics of the Elzone produce internal vibrations which may be detected when using low-
conductivity electrolytes of high viscosity with small orifice tubes. These two compo-
nents can be programmed to be turned off automatically during data collection (if needed) 
to remove these internal vibration sources. This option can be selected on the Flow Con-
trol dialog which can be accessed in the sample file (analysis conditions) or on the second 
view of the Analysis dialog using the Instrument Setup push button.

The pump and fan can also be turned on and off using the instrument schematic. Refer to 
Enable Manual Control, page 6-36 for additional information.

Stirrers

The Elzone accessories include two stirrer paddles. The larger one can be used at slower 
stirrer speeds to reduce vibrations of the electrolyte that may produce unwanted signals in 
low-conductivity, high-viscosity electrolyte systems used with small orifice tubes. Setting 
the stirrer so that the liquid is lifted (“up” direction), the larger stirrer paddle can still lift 
most samples at a lower speed setting than is needed when using the smaller paddle.

The Elzone software enables you to set the stirrer speed and direction. This option is 
located on the Analysis Conditions dialog as well as the first view of the Sample analysis 
dialog. Stirrer speed has a range of 0 to 10; with 1 being the lowest speed (0 turns the stir-
rer off). 

Select this option to turn the 
pump and fan off while data 
are collected.
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Location

The Elzone uses vibration-absorbing feet to reduce the effects of vibrations in the lab 
bench, but whenever working with noise-sensitive applications, extra effort should be 
taken to reduce the vibrations in the vicinity of the Elzone. For example, a sieve shaker 
may sit on the same bench with the Elzone. If so, do not use the shaker while analyzing 
samples with the Elzone.

Try to choose a location for the Elzone that is away from heavy floor traffic; for example, 
do not use a location close to loading docks or elevators where large equipment is being 
moved. 

Place the Elzone on a stable, vibration-resistant bench and, if possible, on a bench by 
itself where it cannot pick up vibrations from other laboratory equipment. Also, do not 
lean on or shake the bench during an analysis.

Cleanliness

Cleanliness of system components is of utmost importance. Remember the following:

• Use electrolyte that has been thoroughly filtered with an appropriate filtering 
device.

• Always wear latex gloves when handling or cleaning orifice tubes. 

• After cleaning the orifice tube, install it immediately on the elzone analyzer to 
prevent air-borne particles from accumulating on its surface.

• Clean the orifice tube again after it has been installed.

• Place a lint-free cover on prepared samples until ready for analysis; this prevents 
air-borne particles from falling into the sample. 

See these sections in your operator’s manual for guidelines and information on maintain-
ing clean components:

• Preparation of Electrolyte Solutions, page D-4
• Cleaning Orifice Tubes, page 9-9
• Cleaning the System, page 9-6
• Preparing and Loading Your Sample, page 3-35
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INDEX

Symbols
$ symbol, 3-3, 8-7

A
Add Log Entry, 5-7, 5-40
Add Orifice Tube dialog, 5-14
Adding

electrolytes to list, 5-24
orifice tubes to list, 5-14
sample materials to list, 5-24
second analyzer, 4-9

Advanced format, 8-3
default sample information file, 8-6
sample defaults, 3-2
Sample information file, 5-5

Air
bubbles, 9-1
filter, 2-5
valve, 6-38

All file status, 2-11
Analysis

concentration, F-1
method, E-1
noise-sensitive applications, H-1
performing, 3-38
preparation, 3-28
Quick Start method, 6-14
Sample Analysis method, 6-3
selecting number to perform, 6-5

Analysis Conditions dialog, 5-13
Analysis conditions file, 5-13

creating, 3-7
defaults, 8-9
listing statistics, 2-7, 3-41, 5-49
opening, 2-7
printing contents, 3-40, 5-48

Analysis program
current version, 2-15
description, 1-6
exiting, 2-7, 5-58
installing upgrade, 4-8
installing, 4-1
menu structure, 2-14
uninstalling, 4-20
using, 2-6

Analyzer
adding another, 4-9

changing ethernet connection, 4-17
moving from one computer to another, 4-11
operating in manual control mode, 6-36
removing from computer, 4-16
weight and dimensions, 1-8

Analyzing file status, 2-11
Aqueous electrolyte, D-1
ASCII text, saving reports, 7-25
Asterisk

background list, 6-31
orifice tube field, 5-14

Autoscale, 5-31
graph shortcut menu, 7-28
in Control Chart reports, 7-16
selecting options, 7-12

Average command, 5-57
Axis

coordinates, viewing, 7-32
cross-hair, 7-32
inverting, 8-12
properties, editing, 7-30

Axis Properties dialog, 7-30

B
Background, 5-10

analysis, 3-17
file status, 2-11
full-resolution data, 5-21
list, editing, 6-31
overlay, 5-37
report, 5-37
saving, 6-5, 6-16
subtract, 5-20

Background List command, 6-31
Background Report Options dialog, 5-37
Backgrounds List dialog, 6-31
Bar code field, 5-6

editing label, 8-7, 8-8
omitting, 8-7

Basic format, 8-4
sample defaults, 3-4, 8-9
Sample information file, 5-8

Binned data, 5-20, 5-21
Blend command, 5-55
Blend data, 1-6
Blend Sample Files dialog, 5-55
Blockage

checking for, 5-18
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clearing, 6-22
clearing manually, 9-11
preventing, 9-5

Board ID dialog, 6-48

C
Calculations

Control Chart report, B-9
Difference from Reference report, B-7
Log probability data, B-10
Out of Spec report, B-6
peak statistics, B-1
Regression report, B-8

Calibrate
orifice tube, 6-23

Calibration command, 6-49
Calibration files, reinstalling, 4-19
Calibration report, 5-40

example, 7-41
Calibration Type dialog, 5-19
Camera, 2-2, G-1

focusing, G-9
installing, G-2
ordering, 10-1
orifice light, installing, G-5
software features, G-7
software, installing, G-6
USB connection, 2-5

Cascade windows, 2-7, 2-15
Cautions, defined, 1-3
Change Orifice Tube or Liquid command, 6-19
Change Orifice Tube or Liquid dialog, 6-19
Check box, defined, 2-9
Check Orifice Tube and Liquid command, 8-14
Cleaning, H-5

orifice tubes, 9-9
sample area, 9-6
system, 9-6

Clear Blockage dialog, 6-22
Clear Blockages command, 6-22
Close All command, 5-47
Close command, 5-47
Close Reports command, 7-6
Coefficient of correlation calculation, B-8
Coefficient of variation, 7-18
Coincidence, 3-35, E-2

correction, 5-20
Collected data, 5-42
Collected Data dialog, 5-42
Columns, report, editing, 7-27
Combined report, 5-41

example, 7-34
Combined Report Options dialog, 5-41

Comments window, 5-7
Complete file status, 2-11
Computer requirements, 1-9
Concentration analysis, F-1
Concentration guidelines, 3-35
Conductivity, D-1

measure, 5-16, 6-10
Conductivity report, 6-46
Conductivity Report Settings dialog, 6-46
Confidence interval, 7-18
Contamination, H-1
Control Chart command, 7-15
Control Chart Graph Options dialog, 7-16
Control Chart Options dialog, 7-15
Control Chart report, 7-15

calculations, B-9
defining the Y-axis, 7-16
recalculating archived results, 7-17
selecting statistics, 7-18

Control Chart Sample Selection dialog, 7-17
Control Chart Summary Statistics dialog, 7-18
Controls, indicators, and connectors

front panel, 2-1
rear panel, 2-5
side panel, 2-4

Convert command, 5-53
Converting sample files, 3-43
Cross-hair

removing from graph, 7-32
Curve Properties dialog, 7-29
Curve thickness, changing, 7-25

D
Data

averaging from multiple files, 5-57
averaging/adding, 5-57
blending, 1-6, 5-55
choosing type, 5-6
collected, 5-42
converting, 5-53
entered, 5-45
exporting, 3-42, 5-51
format, 5-21
full resolution, 5-21
full-resolution, exported format, C-2
plotting type, 5-30
pulse length/particle size data, storing, 5-21
reduced, 5-21
reduced, exported format, C-1
selecting display options, 8-12
smoothing, 5-21

Data entry field, 2-8
viewing valid ranges for, 2-9
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Data Setup dialog, 5-18
collected data, 5-43

Date Range push button, 2-10
Default Style dialog, 7-25
Defaults

Advanced sample information file, 8-6
Basic sample information file, 8-9
file name extensions, 2-13
for sample information files, 3-1, 8-6
parameter files, 8-6
report fonts, 7-25
Restricted sample information file, 8-6
sieve sizes, 8-14

Diagnostics command, 6-33
Dialog boxes, using, 2-8
Dielectric constant, D-2
Difference from Reference report, 5-26

calculations, B-7
selecting, 5-30

Differential flow rate, 5-17
Differential pressure, 5-17
Dilution factor, 5-7, 5-10
Directory

navigating to a different, 2-11
orifice tube calibration, 6-30
parameter files, 8-15

Dispersants, D-2
table of, D-3

Dispersion
window, 5-24

Distribution, choosing type, 5-20
Drain and fill, 6-20
Drain System command, 6-22
Drain System dialog, 6-22
Drop-down list, defined, 2-9

E
Edit Pulse Height dialog, 6-28
Editing reports, 5-29
Electrical requirements, 1-8
Electrical sensing zone method, E-1
Electrode, 1-5

connections, choosing, 5-16
connector, 2-2

Electrolyte, 1-8, D-1
adding/deleting from list, 5-24, 6-26
aqueous, D-1
changing, 3-31, 6-19
checking before analysis, 8-14
conductivity, D-1
device for recirculating, 1-7, D-5
high background count, 9-2
modified organic, D-3

organic, D-2
preparation, D-4
soluble material, D-1
supply connection, 2-4
types of, D-1
water-soluble material, D-2

ElectroPrep, 1-7, D-5
Enable Manual Control command, 6-36
Ending conditions, 5-21
Entered

file status, 2-11
Entered Data dialog, 5-45
Environmental requirements, 1-8
Error Messages, A-1

2200 Series, A-1
2400 Series, A-1
2500 Series, A-11
4200 Series, A-18
6100 Series, A-29
6200 Series, A-39

Ethernet
switch, connecting, 4-9

Ethernet connector, 2-5
Exit command, 5-58
Exiting the analysis program, 5-58
Export command, 5-51
Export Settings dialog, 6-7
Exporting sample file, 3-42
Extrapolation, 5-21

after analysis, 5-44

F
Fan, turning off during data collection, 5-18
File

destination, 5-49, 5-50
exporting, 3-42, 5-51
opening, 2-7
selecting, 2-9
statistics, 3-41, 5-49
status, 2-11
See also Sample information file

File menu, 5-1
Average command, 5-57
Blend command, 5-55
Close All command, 5-47
Close command, 5-47
Convert command, 5-53
description, 5-1
Exit command, 5-58
Export command, 5-51
List command, 5-49
Open command, 5-3
Print command, 5-48
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Save All command, 5-46
Save As command, 5-46
Save command, 5-46

File names, 5-3
default extensions, 2-13
default sequence, 8-6, 8-9

Fill System command, 6-21
Fill System dialog, 6-21
Fill valve, 6-38
Finish Analysis dialog, 6-12

orifice tube calibration, 6-27
Flow Control dialog, 5-17
Flow dialog, 6-40
Flow rate, 3-35, 5-17
Flush, 6-20
Flush System command, 6-21
Flush System dialog, 6-21
Format

data, choosing for sample file, 5-21
exported data, C-1

From Graph
analysis dialog, 6-10
calibration dialog, 6-29
collected data dialog, 5-44

Front panel, description, 2-1
Full-resolution data, 5-21

exporting, 3-42, 5-51, 6-7
format of exported, C-2

Function keys
See Shortcut keys

Fuse
ordering replacement, 10-2

Fuse requirements, 1-8

G
Goodness of fit, 6-28
Graph

grid lines, 8-13
Graph Grid Lines command, 8-13
Graph Grid Lines dialog, 8-13
Graph Overlay Samples dialog, 5-27
Graphic, displaying in report header, 5-26
Graphs

copying as metafiles, 7-31
copying graphical data as text, 7-31
editing legend, 7-30
example, 7-37
overlays, 3-45
report options, 5-30
selecting grid line type, 7-30
shortcut menu, 7-28

Grid lines 8-13
Grid lines, 7-30

H
Help menu, 2-15
Histogram, 5-30, 7-25

properties, 7-29
Hydropulser, 2-2

cleaning, 9-16
installing, 9-13
ordering, 10-1

I
Incremental Number Percent vs. Diameter Graph, 

example, 7-37
Incremental Volume Percent vs. Diameter report, 

example, 7-38
Indicators, 2-1
Information bar, 2-9
Instrument log

displaying, 6-44
printing a report, 6-44
selecting information to display, 6-44

Instrument schematic, 6-36
component shortcut menu, 6-37
description of components on, 6-37
displaying, 6-42

Instrument Setup dialog, 6-9

K
Kd values, orifice tubes, 5-19

L
Legend Properties dialog, 7-30
Light, camera, G-5
Liquid

changing, 3-31
See also  Electrolytes

List command, 5-49
Log

See Instrument log
Log Probability Data, B-10
Log Probability Interpolation Table, B-11
Log Probability report, 5-34
Log Report Settings dialog, 6-44

M
Main Menu bar, 2-14
Maintenance, 9-1

cleaning sample area, 9-6
orifice jewel, 9-4
orifice tubes, 9-9
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schedule, 9-4
Manual

See  Operator’s manual
Manual control

enabling, 6-36
selecting components, 6-36
shortcut menus, 6-37

Mass concentration, 5-7
Material Properties dialog, 5-23
Material properties file, 5-23

creating, 3-9
defaults, 8-9
listing statistics, 2-7, 3-41, 5-49
opening, 2-7
printing contents, 3-40, 5-48

Measure conductivity, 6-10
before each test, 5-16

Menu
shortcut, 2-6
structure, 2-14

Messages
See  Error Messages

Metafile, copying graph as, 7-31
Modal count, 5-22
Move Steps dialog, 6-38
Moving an analyzer to another computer, 4-11

N
Near coincidence, E-2
No Analysis file status, 2-11
Noise-sensitive applications, H-1
Notes, defined, 1-3
Number of tests, 5-10

O
Online manual

accessing, 2-7
Open command, 5-3
Open Report command, 7-6
Operator field, 5-5

editing label, 8-7
omitting, 8-7

Operator’s manual
conventions, 1-3
See also  Online manual

Optimize settings, 6-9
Option Presentation command, 8-3
Options menu, 8-1

Check Orifice Tube and Liquid command, 8-14
description, 8-1
Graph Grid Lines command, 8-13
Option Presentation command, 8-3

Parameter Files Directory command, 8-15
Sample Defaults command, 8-6
Service Test Mode command, 8-15
Units command, 8-12

Options report, 5-40
example, 7-43

Ordering information, 10-1
Organic electrolyte, D-2

modified, D-3
Orifice

cracking, 9-5
jewel, 1-6, 9-4
light, 2-2, G-5
light, adjusting, G-8
preventing blockages, 9-5

Orifice tube, 1-6, D-1
adding and deleting from list, 5-14
calibrating, 6-23
calibration report, 5-40
changing, 6-19
checking before analysis, 8-14
choosing, 3-28
cleaning, 9-9
clearing blockages, 6-22
installing on sample port, 3-28
Kd values, 5-19
on instrument schematic, 6-39
storing, 9-4

Orifice Tube Calibration command, 6-23, 7-7
Out of Specification report, 5-27

calculations, B-6
selecting, 5-30

Overflow sensor, 6-41
Overlay Settings dialog, 5-31
Overlays

background, 5-37
for all tests in same file, 3-50, 5-31
for multiple samples, 3-45, 5-31
generating, 3-45
selecting files for, 5-27
two graphs in same file, 3-48, 5-31
with other instrument data, 3-11

P
Parameter files, 3-6

Analysis conditions, 3-7, 5-13
creating, 3-6
default values, 3-2
defaults, 8-9
directory, 8-15
Material properties, 3-9, 5-23
opening, 5-3
printing contents, 3-40, 5-48
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Report options, 3-11, 5-25
saving, 5-46
saving as a different name, 5-46

Parameter Files Directory command, 8-15
Parameters, user, 8-8
Particle

concentration guidelines, 3-35
count/noise, H-1
diameter range for analysis, 5-14
flow rate, 3-35

Particle size distribution graph, 7-19
Parts, ordering, 10-1
Password

restricted format, 8-5
service tests, 8-15

Peak
valley depth, 5-28

Peaks, Summary report, 5-36
Performance, optimum, H-1
Polynomial fit, 6-30
Pop-up menu

See Menu
Power indicator, 2-2
Presentation formats, 5-4
Pressure reading, instrument schematic, 6-40
Pressure transducer, zero, 6-32
Preventive Maintenance schedule, 9-4
Print command, 5-48
Print dialog, 7-23
Printing

file contents, 5-48
file statistics, 5-49
instrument log report, 6-44
reports, 7-23
to a File, 5-49, 5-50

PSD History command, 7-19
PSD History Options dialog, 7-19
PSD History report, 7-19
PSD History Sample Selection dialog, 7-19
Pulse height, 6-28
Pulse Length report, 5-39

full-resolution data, 5-21
Pulse Length Report Options dialog, 5-39
Pulse Length vs. Particle Size report, 5-38

example, 7-39
Pulse Length vs. Particle Size Report Options dialog, 

5-38
Pump

on instrument schematic, 6-42
operating in manual control mode, 6-36
turning off during data collection, 5-18
vacuum, 6-39
volumetric, 1-7

Push button, defined, 2-8

Q
Quick Start Mode dialog, 6-14
QuickStart Analysis command, 6-14

R
Radio button, defined, 2-8
Raising the sample stand, 2-3
Ranges, viewing for selected field, 2-9
Redraw, 7-32
Reduced data, 5-21

format of exported, C-1
Reference material

adding to list, 6-25
Reference Material dialog, 6-25
Reference quantities, B-6
Reference Sample dialog, 5-26
Reflector, for camera light, 2-1
Regression report, 7-11

calculations, B-8
recalculaing SPC values, 7-14
selecting X- and Y-Axes variables, 7-12

Regression Report command, 7-11
Regression Report Options dialog, 7-11
Regression Report Sample Selection dialog, 7-12
Removing an analyzer, 4-16
Replace All push button, 5-7, 6-4
Replace push button, 5-23
Report button, 7-14
Report options

graphs, 5-30
tabular, 5-32

Report Options dialog, 5-25
Report options file, 5-25

creating, 3-11
defaults, 8-9
listing statistics, 2-7, 3-41, 5-49
opening, 2-7
printing contents, 3-40, 5-48

Reports
Background, 5-37
calibration, 5-40
closing, 7-6
closing all, 2-7
columns, editing, 7-27
Combined, 5-41
Control Chart, 7-15
copying graphical data as a metafile, 7-31
copying graphical data as text, 7-31
displayed on computer screen, 7-22
editing, 5-29
editing legends, 7-30
editing title, 7-31
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examples, 7-33
exporting automatically after analysis, 6-7
generating automatically after analysis, 6-6
header, 7-21
Log probability, 5-34
opening, 7-6, 7-23
printing, 7-23
PSD History, 7-19
Pulse Length, 5-39
Pulse Length vs. Particle Size, 5-38
Regression, 7-11
Sample Log, 5-40
saving, 7-24
saving in other formats, 7-25
selecting, 2-12, 5-29, 7-5
selecting fonts, 7-25
shortcut menus, 7-27
showing company logo in title, 5-26
showing title on, 5-26
starting, 2-7, 7-3
Statistical Process Control (SPC), 7-8
Summary, 5-34
tabular, 5-32
tool bar, 7-23
types available, 5-29
viewing axis coordinates, 7-32
zooming in and out, 7-31

Reports menu, 7-1
Close Reports command, 7-6
Control Chart command, 7-15
description, 7-1
Open report command, 7-6
PSD History command, 7-19
Regression Report command, 7-11
SPC Report Options command, 7-8
Start Report command, 7-3

Reports Setting dialog, 6-6
Restricted format, 8-5

sample defaults, 8-9
Sample information file, 5-12

Rinse, 5-16
Rinse command, 6-20
Rinse dialog, 6-20
Rinse, types of, 5-11
Rosin Rammler report, 5-33

S
Sample

analyzing a series, 6-14
area, cleaning, 9-6
dispersant, D-2
dispersion, 3-35
material, adding/deleting from list, 5-24

preparation, 3-35
stand, raising and lowering, 2-3
valve, 6-39

Sample Analysis command, 6-3
Sample Analysis dialog box, 6-3
Sample Defaults command, 8-6
Sample Defaults dialog

Advanced format, 8-6
Basic format, 8-9

Sample file number, including in description, 3-3
Sample information file, 3-13, 5-4

Advanced format, 5-5, 8-3
Basic format, 5-8, 8-4
converting, 3-43
creating in Advanced format, 3-13
creating in Basic or Restricted format, 3-15
default identification, 8-7
default values, 3-1
defaults, Advanced format, 8-6
defaults, Basic format, 3-4
defaults, restricted format, 8-6
exporting, 3-42, 5-51
labels, editing, 8-7
listing statistics, 2-7, 3-41, 5-49
opening, 2-7, 5-3
presentation formats, 5-4
printing contents, 3-40, 5-48
Restricted format, 5-12, 8-5
saving, 5-46
saving as a different name, 5-46
selecting, 2-9
sequence number, 8-6
status, 5-3
status types, 2-11
See also File

Sample information file dialog
Advanced format, 5-5
Basic format, 5-8
Restricted format, 5-12

Sample Log report, 5-40
entries, 5-7
example, 7-44

Sample SPC Options dialog, 7-9
Sample stand, raising and lowering, 2-3
Save All command, 5-46
Save As command, 5-46
Save as Default button, 7-18
Save command, 5-46
Schematic

See Instrument Schematic
Select Dates dialog, 2-10
Selected Reports dialog, 7-5
Selecting reports, 5-29
Sensors, 6-41
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Sequence number, 8-6
Service Test command, 6-49
Service Test Mode command, 8-3, 8-15
Service tests, performing, 8-15
Servo valve, 6-40
Set Target dialog, 6-40
Setup program

adding an analyzer, 4-9
moving an analyzer to another computer, 4-11
reinstalling analysis program, 4-8
reinstalling calibration files, 4-19
removing an analyzer from the computer, 4-16
uninstalling software, 4-20
using for other functions, 4-6

Shortcut keys, 2-6
for Select Dates dialog, 2-10
list of, 2-7

Shortcut menu, 2-6
accessing, 2-7
for graphs, 7-28
for tabular reports, 7-27
instrument schematic, 6-37

Show Instrument Log command, 6-44
Show Instrument Schematic command, 6-42
Show report title, 5-26
Show Status command, 6-43
Side panel, description, 2-4
Sieve sizes, specifying defaults, 8-14
Sieve Table dialog, 8-14
Signal Settings dialog, 5-14
Signal-to-noise ratio, F-4
Size axis, inverting, 8-12
Size classes, 5-20
Smoothing, 5-21
Software

camera, installing, G-6
installing upgrade, 4-8
uninstalling, 4-20
using, 2-6
using for other functions, 4-6
version, 2-15, 6-47

Sparkle display, 6-8
SPC Analysis Conditions Options dialog, 7-9
SPC Calculations dialog, 7-8
SPC Percentile Options dialog, 7-10
SPC report, 7-8

calculations, B-8
user parameters, 5-6, 8-8

SPC Report Options command, 7-8
SPC Size Options dialog, 7-10
Specification Samples dialog, 5-27
Specifications, system, 1-8
Spreadsheet format

saving reports in, 7-25

Standard Class Size Table, 5-32
Standard Sieve Table, 5-32
Start Orifice Tube Report dialog, 7-7
Start Report command, 7-3
Start Report dialog, 7-3
Status drop-down list, 2-11, 5-3
Status types, list of, 2-11
Status window, showing, 6-43
Stirrer

direction, 5-10
manual control of, 6-39
options, 2-2
speed, specifying, 5-10

Stirrer Speed dialog, 6-39
Stray particle count and noise, H-1
Submitter field, 5-5

editing label, 8-7
omitting, 8-7

Summary Peaks dialog, 5-36
Summary Percentiles dialog, 5-35
Summary report, 5-34
Summary Report Options dialog, 5-34
Summary Sizes dialog, 5-35
Summary Statistics button, 7-18
Supply inlet, 2-4
System

description, 1-5
draining, 6-22
filling with liquid, 6-21
flushing, 6-21, 9-6
repeatability/reproducibility, 1-8
rinsing, 6-20
specifications, 1-8

T
Tables, editing, 5-32
Tabular reports

copy as text, 7-28
editing options, 5-32
example, 7-35
shortcut menu, 7-27

Temperature, environment, 1-8
Test, number to perform, 5-10
Text, copy graph data as, 7-31
Theory of operation, E-1
Tile windows, 2-7, 2-15
Title Properties dialog, 7-31
Tool Bar, report window, 7-23
Troubleshooting, 9-1

air bubbles sticking to orifice tube, 9-1
bubbles in orifice tube, 9-1
high background count on electrolyte, 9-2
incorrect sizes, 9-1
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no liquid flowing with valves open, 9-1
Truncate table at distribution limits, 5-33
Type of data, specifying, 5-6

U
Unit configuration

displaying, 6-47
Unit Configuration command, 6-47
Unit Configuration dialog, 6-47
Unit IP Setup dialog, 6-48
Unit menu, 6-1

Background List command, 6-31
Calibration command, 6-49
Change Orifice Tube or Liquid command, 6-19
Clear Blockages command, 6-22
description, 6-1
Diagnostics, 6-33
Drain System command, 6-22
Enable Manual Control command, 6-36
Fill System command, 6-21
Flush System command, 6-21
Orifice Tube Calibration command, 6-23, 7-7
QuickStart Analysis command, 6-14
Rinse command, 6-20
Sample Analysis command, 6-3
Service Test command, 6-49
Show Instrument Log command, 6-44
Show Instrument Schematic command, 6-42
Show Status command, 6-43
Unit Configuration command, 6-47
Zero Pressure Scale command, 6-32

Units command, 8-12
Units Selections dialog, 8-12
Units, selecting, 8-12
User parameters, 5-6

specifying, 8-8

V
Vacuum

pump, 6-39
tubing, 2-4

Valve
air, 6-38
appearance when closed, 6-38
appearance when open, 6-38
colors, 6-36
fill, 6-38
on instrument schematic, 6-42
operating in manual control mode, 6-36
sample, 6-39
servo, 6-40

Version, software, 2-15, 6-47

View drop-down list, 6-4
Voltage selector, 2-5
Volumetric flow rate, 5-17
Volumetric pump, 1-7

on instrument schematic, 6-37
ordering, 10-1

W
Warnings, defined, 1-3
Waste

sensor, 2-4, 6-41
supply connection, 2-4

Windows menu, 2-15

Z
Zero Pressure Scale command, 6-32
Zero Pressure Scale dialog, 6-32
Zoom feature, 7-31
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